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Hands on Test Drive

When you complete this manual, you will have experienced

firsthand an introduction to the capabilities of SolidWorks®
Simulation products, including:

m  SolidWorks® Simulation

m  SolidWorks® Simulation Professional
m  SolidWorks® Flow Simulation

®  SolidWorks® Motion



Hands on Test Drive SolidWorks Simulation



SolidWorks Simulation Hands on Test Drive

Introduction

The SolidWorks® Simulation Hands-on Test Drive provides you with an

understanding of the capabilities and benefits of using SolidWorks® Simulation
analysis software to perform powerful analysis from your desktop. Only
SolidWorks Simulation validation tools provide seamless integration with

SolidWorks® 3D CAD software, with the benefit of the easy-to-use Windows®
user interface.

Learn how you can use SolidWorks Simulations to perform stress analysis on your
design; SolidWorks® Simulation Professional to perform stress, thermal,
optimization, and fatigue analysis; SolidWorks® Motion to perform motion

simulations; and SolidWorks® Flow Simulation to perform fluid-flow analysis on
your designs.

Introduction 1
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The SeaBotix LBV150

During this hands-on session, you will analyze some of the parts and assemblies
that are components of the SeaBotix LBV 150 assembly shown below.

SeaBotix, Inc. designed, manufactured, and introduced the first lightweight, low-
cost, fully production submersible, remotely operated vehicle, the Little Benthic
Vehicle. Bringing this breakthrough product to a wider market required modern
3D design and analysis tools, so product developers could shorten design cycles,
validate cutting-edge technologies, and employ organic shapes and surfaces.

The company selected SolidWorks mechanical design software for the Little
Benthic Vehicle project because of its ease of use, ability to model organic shapes
and surfaces, SolidWorks® eDrawings® communication capabilities, and seamless
integration with SolidWorks® Simulation analysis software.

The SeaBotix assembly can be remotely operated for use at depths of up to 1,500

meters. Weighing less than 25 pounds, the SeaBotix assembly represents a
breakthrough in tethered submersible design.

Bent Bar

MiniGra’/

Assembly

SeaBotix
LBV150

You will have a chance to experience firsthand the ease of using SolidWorks®
Simulation analysis software on the following items:

1. SeaBotix LBV150 assembly

2. Housing assembly
3. MiniGrab assembly
4. EndCap part

5. 3 Finger Jaw part

2 The SeaBotix LBV150
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Today, you will use the SolidWorks Simulation family of products:

m  SolidWorks® Simulation - The static analysis application that determines the
stresses on the Housing assembly and the EndCap part.

B SolidWorks® Simulation Professional - The static, thermal, drop test, and
optimization analysis application that validate the design of the Housing
assembly, EndCap part, and the 3 Finger Jaw part.

m  SolidWorks® Motion - The ridge body motion analysis application that
simulates the mechanical operation of the motorized MiniGrab assembly and
the physical forces it generates.

m  SolidWorks® Flow Simulation - The fluid flow analysis application that
provides insight into the SeaBotix LBV 150 assembly related to fluid flow and
forces on the immersed model.

The SeaBotix LBV150 3
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Notes:

4 Notes:
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User Interface

The first thing that you notice about the SolidWorks® user interface is that it looks
like Microsoft® Windows®. That is because it is Windows!

The SolidWorks 2012 (UI) is designed to make maximum use of the Graphics
area space. Displayed toolbars and commands are kept to a minimum.
Communicate with SolidWorks through the drop-down menus, Context document
sensitive toolbars, Consolidated toolbars, or the CommandManager tabs.

Menu Bar Toolbar

The Menu Bar toolbar contains a set of the most frequently used tool buttons. The
available tools are: New - Creates a new document, Open - Opens an
existing document, Save - Saves an active document, Print 2| - Prints an
active document, Undo - Reverses the last action, Select E - Selects sketch
entities, faces, edges and so on, Rebuild - Rebuilds the active part, assembly,
or drawing, File Properties - Shows the summary information of the active

document, Options - Changes system options, document properties, and Add-
Ins for SolidWorks.

| sormworks B [ - (- bl - BE]

Menu Bar Menu

Note:

Click the SolidWorks name in the Menu Bar toolbar to display the default Menu
Bar menu. SolidWorks provides a context-sensitive menu structure. The menu
tittles remain the same for all three types of documents; part, assembly, and
drawing but the menu items change depending on which type of document is
active. The display of the menu is also dependent on the work flow customization
that you have select. The default menu items for an active document are: File,
Edit, View, Insert, Tools, Window, Help, and Pin.

The Pin option displays both the Menu Bar toolbar and the Menu Bar menu.

I@SOLIDWRKS ‘ File View Tools Help -I;:ll

@Soumm ‘ File Edit View Insert Tools Window Help -I;:ll

|JJ SOLIDWORKS ~ Fle Edit View Insert Tools Window Help & I O-2- H-=- | B 5 2 v|

User Interface 5
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Drop-down menu I ConteXt TOOIbar Wﬂl Insert Tools Simulation  Windof % [ | |% | $. |9.| »
Communicate with SolidWorks O | Redraw Crri+R v :
either thought the Drop-down i d %gtslef::::m<Dera”'t>‘D'sD'a
menu or the Pop-up Context IE:‘S:!:'V : §J- nnr]i@@p a1

odify = Mal—
tOOIbar' The Drop'dOWn menu Lights and Cameras L4 E o o s
from the Menu Bar tqolbar or the e N
Menu Bar menu provides access | (&) planes Shift+p 1, on| | Section view
to various commands. [ﬁ| Live Section Planes Comment

Parent/Child. ..

When you select, (click or right- 5T | Properties...
click) items in the Graphics area GoTou..
or FeatureManager, Context
toolbars appear and provide
access to frequently performed
actions for that context.

Keyboard Shortcuts
Some menu items indicate a keyboard shortcut like this: | e | Recraw QR

SolidWorks conforms to standard Windows conventions for shortcuts such as
Ctri+O for File, Open; Ctrl+S for File, Save; Ctrl+X for Cut; Ctrl+C for Copy;
and so on. In addition, you can customize SolidWorks by creating your own

shortcuts.

FeatureManager Design Tree

The FeatureManager® design tree is a unique part of the
SolidWorks software that employs patented SolidWorks
technology to visually display all of the features in a
part, assembly, or drawing.

As features are created, they are added to the
FeatureManager. As a result, the FeatureManager
represents the chronological sequence of modeling
operations. The FeatureManager also allows access to
editing the features and objects that it contains. The Part
FeatureManager consist of four default tabs:

FeatureManager , PropertyManager ,
ConfigurationManager , DimXpertManager
and DisplayManager .

N ETEITE
o _

% Partl {Default<<Default>_Displd
il Sensars

+ LA Annotations
3= Material <not specified:>
4 Front Plane
% Top Plane
%> Right Plane
I.. Crigin

User Interface
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SolidWorks Simulation CommandManager Tab

Note:

Note:

The SolidWorks Simulation CommandManager enables you to quickly create a
Simulation Study. Click the SolidWorks Simulation tab in the CommandManager
to create a new study. Studies are organized in tabs and are displayed in the
bottom section of the Graphics area.

Create a New Study using

mSOLlDNDRKS i File Edit View Insert Tools Smulation Window Help (&

the New Study tool or Q Des
. . . i . res  External Connections I sults
right-click on the Motion E’Jsﬁr ooty e e hder | s Deformed Conpare U lt
Study tab, click Create @, | Study Advisor uate | Dimxpert [ Office Products | Simulatiob
New Simulation Study. | A Newswdy [
Duplicate
Rename

Create New Motion Study
Create New Simulation Study
Create New Design Study

Murerom - s

SolidWorks Premium 2012 x64 Edition **

To activate SolidWorks =T

B =& LEV_ASSY.SLDASM *
Simulation, click the Options drop-down arrow Ev[%ptions

from the Menu bar toolbar. Click Add-Ins. The Add- p%ded B
Ins dialog box is displayed. Check the SolidWorks =2 put s, &

Simulation box. Click OK from the Add-Ins dialog %gz:smz:’z b
box. The Simulation tab is displayed in the Solidorks Toolbox

tsn Solidworks Toolbow Browser
CommandManager, []3? Solidworks Utities

Mouse Buttons

The left, middle, and right mouse buttons have specific uses in SolidWorks.

m Left - Selects objects such as geometry, menu buttons, and objects in the
FeatureManager design tree.

m Middle - Holding the middle mouse button as you drag the mouse rotates the
view. Holding the Shift key down while you use the middle mouse button
zooms the view. Using the Ctrl key scrolls or pans the view.

m Right - Activates context-sensitive pop-up menus. The contents of the menu
differ depending on what object the cursor is over. These right-mouse button
menus give you shortcuts to frequently used commands.

User Interface 7
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System Feedback
s

System feedback is provided by a symbol attached = \I%"_‘ D;’*“ &
to the cursor arrow indicating what you are ¥ace + dge--Dunension-- Vertexy|
selecting or what the system is expecting you to
select. As the cursor floats across the model,
feedback comes in the form of symbols riding
next to the cursor arrow.

Getting SolidWorks Help

HelD_|$9[D'L:§'H'GE'

SolidWorks has a comprehensive Home help Page 12" soliaworic Help
function that is design to assist the new and / SolidWorks Tutorials

. . . . 5 API Help Topics
experience user. It provides information on What’s Toolbax Help
New, SolidWorks Glossary, New Release notes, and Search 8
more. Release Notes

What's New (2

Click Help, SolidWorks Help | 2| from the Menu Quick Tips

. B . Introducing SolidWorks (pdf)
bar menu to view the comprehensive SolidWorks o

i Moving from 2D to 3D
online Home help Page. oving from 2D to

Use SolidWorks Web Help

Note: Check Use SolidWorks Web Help for internet Check for Updates...
access. Activate Licenses...

Transfer Licenses...

Show Licenses...

About SolidWorks...

Customize Menu

8 User Interface
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Getting SolidWorks
Simulation Help

Click Study Advisor,

Study Advisor

from the Simulation tab
in the
CommandManager with

Hands on Test Drive

Study Aﬁﬂv Fixtures
Advisor Material Advisor

= of 18

73

External Connections Run
Loads...

Advisor

& .
Results Eoitrae
Advisor Results

Q Study Advisor

tch | Evaluate | Office Produds*Simulaﬁon

Q Mew Study
Study Properties

=

an active study to obtain the Simulation Advisor.

The Simulation Advisor is a tool to help the user to determine how to create the
proper study. It is broken into the following categories: Study, Bodies and
Material, Interactions, Mesh and Run, and Results.

The Simulation Advisor walks you through by asking basic questions to lead to
the correct action. By default, when you click on a tool in the Simulation

CommandManager, it launches the relevant advisor. Deactivate the Simulation
Advisor in the Simulation Options section.

The Simulation Advisor

tab is displayed in

the Task Pane.

Note:

User Interface

=mLRBRUEE

« Simulation Advisor

Welcome to SolidWorks
Simulation Advisor

The Simulation Advisar helps
yau determine the proper study
type.

For basic static studies of
partz and assemblies, the
Advisor provides information
and drives the interface to
guide you through the
simulation process.

The Simulation Advisor does
not support other types of
studies in this release. It also
does not provide access to
some features used in static
studies. To access full
functionality, use the
Commandhianager, right-
maouse clicks on tree folders
and features, ar menus.

Click here for online training on
Solichorks Simulation Courses.

P nien

Do not show me this
again.

¥

Lo [ [ O | [

& Simulation Advisor [

1 Study

To help you create the proper
study, select one of the
following:

| am concerned about
excessive deformation or
stresses

| am concerned about the
a effect of Inadfunload

cycles.

I am concerned about
@ sudden collapse under

compression.

lam concerned about

excessive shaking

@ | am concerned about
temperatures
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SolidWorks Tutorials and

- . . | - -Bl- 2 -9 - S T
SolidWorks Simulation [p) 2|0 - B ®- 9 8 5 &
. 2 | SolidWorks Help
TUtorIaIs SolidWorks Tutorials l
. . | SelidWorks Simulation Help Topics
The Sodeorks Tutorials TR .
provide step-by-step Search ¥ | Validation '
leSSOHS Wlth Sample ﬁles Release Motes Customize Menu
COVGI‘ll’lg SOlldworkS e | & Solid¥orks Resources 9
termlpology, COl’lCCptS, | Getting Started a
functions, features, and = DYiEwparet :
many Add-Ins. Work or £l (¥ Open a Document
view the lesson tutorials to = :M -
Wihat's Mew
2 [

leam and Strengthen your -@'Imroducing Solichvorks |
Skllls . ,g 'J,) General Information |

Click Help, SolidWorks
Tutorials or click
SolidWorks Simulation,
Tutorials from the Menu
Bar menu. View the results.

E?, SolidWorks Tutorials
=

Show Back  Print

= &

Show Back  Print

SolidWorks Tutorials SolidWorks Simulation

Online Tutorials

b b These tutorials present SolidyWaorks
The Tutorlals are dlsplayed functionality in an example-hased
b t learning format. Read the Conventions -SrvniL‘lt\aastisnu:fsuggisn;igtliic;:u:r\:uer)ljasﬁme
I y informatian. :
y Ca ego * baszed learmning format. Read the

Conventions infarmation

Ifyou are new to the Solidwarks

software, familiarize yourself with the

Note: You can also access the ol GettngSarted i or Sh R i oA
1 1 1 8 lation Professi | and ab
SolidWorks Tutorials, click Sollorks urbisiecaze oo SEEE‘EIE?T.@T%%&E V{gﬁgg?jﬁm e
the SOdeOI‘kS Resources ‘GL:}SQ,,EIS rarkhesoarpleledinany Simulation Premium
tab from the Task Pane
and click Tutorials. View Tuc:ut--r-i--n-s by |
. . ategory -
the available tutorials. e e ' static kil
Started Models
Note: Use the What's N Cr T i o e
ote: s€ ine at’'s New = ermal Professional
. :ﬂv:;:::g with Design Analysis (Professional)
Examples to VleW Whats All SolidWorks Tutorials (Set 1) Diop Test,and
. . Pressure Vessel |Linear Dynamics
new n SOlldWOI‘kS 2012 All SolidWorks Tutorials (Set 2) R’Eﬁuifgﬂ ol (Premium)
Design Studies

Tutorials by
Focus/industry

CSWP/CSWA Consumer
Preparation Product Design

Machine Design |Mold Design

tWhm's New Examples ==

10 User Interface
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SolidWorks Simulation

SolidWorks® Simulation is a design analysis application fully integrated with
SolidWorks. It provides a one-screen solution for stress analysis and also enables
you to solve large problems quickly using your personal computer. In this section
of SolidWorks Simulation, you will address the following:

SolidWorks Simulation User Interface

The integration between SolidWorks Simulation and SolidWorks
Creating Design Studies

Understanding the Analysis Steps

Assigning Materials

Applying Fixtures and Loads

Meshing the Model

Running the Analysis

Viewing the Results

Time: 55 - 60 minutes

User Interface 11
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SolidWorks and SolidWorks Simulation

SolidWorks Simulation allows you to test a design and run

multiple analysis iterations without ever leaving SolidWorks. @E‘I’—;SS" Defals
| Sensors

SolidWorks Simulation utilizes the SolidWorks FeatureManager |# ﬁ z:::t”as:::'
tab, PropertyManager | ET | tab, ConfigurationManager

tab, and the DisplayManager tab, the CommandManager,
Motion Study tabs, Material Library, etc. and many of the same mouse and
keyboard commands.

Anyone who can design a model in SolidWorks can analyze it without having to
learn a new user interface. SolidWorks Simulation utilizes the power of
SolidWorks configurations to test multiple designs. Plus, since SolidWorks
Simulation uses native SolidWorks geometry, design changes made in one
application are automatically updated in the other.

Regardless of the industry application, from aerospace to medical, SolidWorks
Simulation provides significant product quality benefits, enabling engineers and
designers to go beyond hand calculations and verify proof of concept for their
designs.

Study A ‘_I" Fixtures External Connections Run | Results .
Advisor PPY  Advisor Loads...  Advisor Advisor Pl
Material Results

Assembly | Layout | Sketch | Evaluate | Office Products | Simulation

Wilall »lml_Model Motion Siudy - Default i Study 1
SolidWorks Premium 2012 x4 Edition k

Material 3

el 4| | Properties | Tables & Curves | Appearance || CrossHatch | Custom | Application Data | F € %

1023 Carbon Stesl Shest (55) Material properties

Al e ) Miaterias n the default lbrary can not be edited. You must first capy the material to

$= 7286 Iron Bass Supsralloy a custom library to edt i,

151 1010 ke, hot rolied bar

1SI 1015 Steel, Cold Dravn (55) $

ST 1020 S1-Hfm~2 (Pa) |

51 1020 Steel, Cold Rolled =

51 1035 Steel (55) =

3 AISL 1045 Steel, coid drann [

51304 z

5T 316 Arnealed Stainless Steel Bar (55

51 316 Stainless Steel Sheet (55)

= AISI 321 Annealed Stainless Stesl (55) T

3= AISI 347 Amnealed Stainless Steel (35) |
= AISI 4130 Steel, annealed ot B65C

|Linear Elastic Isctropic v

15T 4130 Steel, normalized at 5700 BiEedy calie Lok
L 200000000000 N2
51 4340 Steel, amnealed
Porssons Fetio
D e e Sheer Morulus 77000000000 N2
= AISL Type 316L stainless steel B e ka3
= AISE Type A2 Tool Steel Tensie Strength 420507000 N2
Alloy Stez! Compressive Strength in X N2
\Viekd Strength 35000 N2
Thermal Expansion Cosficert 0000015 &€
Thermal Conductivty a7 Wi
Specific Hest 420 )
= Material Damping Ratia iy
3= Cast Carbon Steel {sH)
$= Cast Stainless Steel &
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Analyze the Housing

For your first analysis, explore the design
validation of the Housing components in the
SeaBotix LBV150 assembly using
SolidWorks Simulation.

The Housing was simplified for today’s class
due to limited time. The Housing consists of
two EndCaps and a View Port. The support
tube, camera, and other components have
been removed.

Your design goal in this section is to obtain a
Factor of Safety (FOS) greater than one. You
will first perform a static analysis on the
Housing assembly containing the EndCaps
without structural ribs as illustrated.

You will then perform a second static
analysis on the Housing assembly containing
the EndCaps with the addition of structural
ribs as illustrated in hopes that the addition
of the structural ribs will obtain your design EndCap
goal of an FOS greater than one. with Ribs

You will then compare the two studies side-
by-side for a final design comparison.

Analyze the Housing 13
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Starting a SolidWorks Session

1 Start a SolidWorks Session.
m  Click the Start menu.

SolidWorks Simulation

® Click All Programs, SolidWorks 2012, SolidWorks 2012.

Note: You can quickly start a SolidWorks 2012 session by double-clicking the
left mouse button on the desktop shortcut, if there is a shortcut icon on

the system desktop.

2 Open the SeaBotix LBV150
Assembly.

m  Click Open from the
Menu bar toolbar.

®  Double-click LBV_ASSY
from the
SeaBotix\SolidWorks
Simulation folder. A
simplified sub-assembly is
displayed in the Graphics
area. View the
FeatureManager.

Note: The FeatureManager design tree
on the left side of the SolidWorks
window provides an outline view
of the active part, assembly, or
drawing. This makes it easy to
see how the model or assembly
was constructed or to examine the
various sheets and views in a
drawing.

14
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SolidWarksSimul.

» SolidWorks Simulation »

Hew folder

Date modified Type

8/21/2011909 AM _ File folder
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% Recent Pl
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=] Pict
B vid
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Meode: [F] De net load hidden
components
[F] Use Speedpak
Display States: | <Defauit>_PhotoWar v
References...
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3 Select the Simulation_Original_Design
Configuration.

m Click the ConfigurationManager tab. The
various configurations are displayed.

B Double-click the Simulation_Original_Design
configuration. The Housing assembly (No Ribs) is
displayed in the Graphics area.

4 Activate SolidWorks Simulation.

m  Click the Options drop-down arrow
as illustrated from the Menu bar toolbar.

m  Click Add-Ins. The Add-Ins dialog box
is displayed.

B Check the SolidWorks Simulation box.

®  Click OK from the Add-Ins dialog box.

Note: Displayed Add-Ins may vary per system

setup.

Analyze the Housing

SolidWorks Simulation

fi

5

= ¥ LBv_AssY Configuration(s) (D)
|F® Default [ LBY_a35Y ]
— —} 'Ifﬁ Simulation_Criginal_Desigr

' El - 4— SeaBotix LBY 150 *

E Cptions
Customize. ..

Dn——
Add-Ins...

Add-Ins

Active Add-ns

|startup |

=l SolidWorks Premium Add-ins

]
]

[T] & Circuitwworks

[ &8 Featureworks

oo

[ ScanTo3D

D-:Qf; SolidWorks Design Checker

[7] & solidworks Mation

[7]1E solidworks Routing

SolidWorks Simulation

olidWorks Toolbox

] E’ SolidWorks Toolbox Browser

[T salidworks Utiities

PhotoView 360

SolidWorks Workgroup PDM 2011
SolidWorks Workgroup PDM 2012

[T Tolanalyst
=l SolidWorks Add-ins

@

]
o
]
]

Autotrace

SolidWorks Flow Simulation 2012
SolidWorks Part Reviewer
SolidWorks XPS Driver

F OK Cancel

OooOo| ODooooooooa@@
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A Simulation tab is added to the CommandManager and a Simulation button is
added to the Menu bar menu.

msaumlﬁle Edt View Insert Took Smuafgg Window Help Q\Dv@’vv..@'mﬁlx
. - b 18 | ] :__/j M_ll s . [E¥ Design Insight
Study R Fixtures External Connections Run | Results K
Advisor | AP advisor Loads...  Advisor ihpee D=l e “Z LS b 2
Material Result  Results
Assembly | Layout | Sketch | Evaluate | Office Products | Simulatia| & 52
=
@ h bt 6 _
QAN ME- @ 60-@ 8-

FB Default [ LBY_ASSY ]
T2 Simulation_Original_Desit

play S s (linked)
Simulation_Original_Design_| 1
o <Simulation_Original_Design

| emm—— C

Link Display States to Configurations

Under Defined  Editing Assembly MMGs - [3]

5 Set Default Options in SolidWorks Simulation. — P Srieten ] vineon b ]
m  Click the Simulation button from the Menu bar 2 'Studv-‘l- .
menu. | osdsiFictire >

m  Click Options from the drop-down menu. The = M——
System Options - General dialog box is displayed. Comtices .
Mesh L4

G|

Plot Results 12
List Resulks L4
Result Tools 4

Fatigue L4

Import Motion Loads. ..

_.b Opkians ..

Analyze the Housing



SolidWorks Simulation

SolidWorks Simulation

B Click the Defaults Options tab. View the
. . . Unit system
Dgfault Options - Unit dialog box. & e
m  Click the Units folder. | English (IPS]
. . () Metric [G
m  Click the SI (MKS) Unit system box. M)
m  Seclect mm for Length/Displacement. Sl I
. Length/Displacement: mm hd
m  Seclect Kelvin for Temperature. i
. emperature:; 2V .
m  Select rad/sec for Angular velocity. .
A Angular velocity:
m  Select NNmm*2(MP) for Pressure/Stress. —
Set Results Folder. T Systom Options | Defauk Optrs
] Cllck the Results Units Default zokver
folder. Load|Fixture ’ %ﬁutomatic
. . Mesh Direct
| ] Clle the Automat'c Results €— IRGEbee
. = Plat O FFEPls
box in the Default S AL
SOlVGI‘ Section (= Default Plots Fiesults folder
: = Q"Static Study Results (& Solidw!orks document foldsr
Set Number Format. [Py Piott
R &PlotZ [ Under sub folder
®  Click the Color Chart [ © User defined
folder.
®  Click Floating for Number format. View your options.
B Click OK from the Default Options - Plot Color Chart dialog box.
Default Options - Plot - Color Chart = |
[ System Opicna| Defaul Dt |
- Units [] Display color charts
- Load/Fixture (/| Display plot details
Mesh Position
Results ® Predefined positions
& Plot User defined
_— DeABIOE Horizontal from left: &0 %
=@ Static Study Results vaicalhomton: |20 2%
[P Plotl i
aprotz p d::‘xide
Dapioz ® Momal
@Y Frequency/Buckling Study Results Thin
= @ Thermal Study Results I ——
o Rapron Scientitc
@@ Drop Test Study Results & Flaatin
"'&Elﬂﬂ ’ /'?lgen:arj
ABaplon2 Mo of decinal places: 3 =
---EPIDE MNo. of d | pl :[3 =
= & Fatigue Study Results [¥] Use 1000 separator (]
Parion
Dy Pio2 Color options
R Optimization Study Results Defaul -
---QCNSnnnearsmdyR:su\ts ‘ . I
Dy Plott Mo of chart colors: |12 5 [ Fip
---Epma
~{& Plot3 5
Report [F] Sipecity color for values above yield for vonttises plot [
——9 1] ] l Cancel | l Help..
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Create a Static Analysis Stud =TT
natly y B
Create a Static study today. Static studies calculate __ Study
displacements, reaction forces, strains, stresses, and ¥ X 4=
factor of safety distribution. [Message A
. i Stua. stresses, |

Factor of safety calculations are based on common fd;i'iﬁcﬁ?f:fféfﬁns and
failure criteria. s
The first default Study name is Study 1. — =
SolidWorks Simulation offers six different results | Lot |
options. They are: [Type A
m  Stress @' =
m  Displacement R
] Strain |§I Euckling
m  Deformation (@8] themal
m Factory of Safety (@8] orop Test
®  Design Insight @ Faue

. . . . . |£| onlinear
Static studies can help you avoid failure due to high = "
stresses. A factor of safety less than one indicates likely “%_' Sl
material failure. Large factors of safety in a continuous L"’_‘!' DEas e o |
region indicate that you can probably remove some [optians Al
material from this region. [use 20 Smplfication. |

Note: The 2D Simplification option creates a 2D simplification
study to simplify certain 3D models by simulating them
in 2D and saving analysis time. Available analysis types
include plane stress, plane strain, extruded and
axisymmetric.

18 Create a Static Analysis Study
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Creating a Static Analysis

Study
1

Note:

Note:

SolidWorks Simulation

@SO”DWDRKS . File Edit View Insert Tools Simulaton Windo
C t Stati 5% ixch ternal tions Run | Result
rea e a a Ic _y A ¥ F‘IX.LIII'ETc EX_EI'H& CCII‘TIT.E..C D.ITS un .E.SFI S. e Com|
Analysis Study Advisor Iv]apterial Advisor Loads... Advisor Advisor DRF:‘sultd Red
. . . QbStudyAdvisor etch | Evaluate | Office Products ywSimulation
] Cllgk Simulation el /* [
tab in the
CommandManager.
®  Click the Study Advisor drop-down arrow as
illustrated. -
®  Click New Study . The Study PropertyManager is ¥ % 4=
displayed. Study 1 is the default name for the first o= =
study. Accept the default Study name. View the ' Tl
various available Study types. o glgns;ffvtighflgear
. . rmaterial
m  Click the Static button for Type. L
| Name 3
. i Study 1 |
Type A
— | satic
@tatichauency
|£I Buckling
Display the Study.

m  Click OK from the Study PropertyManager.

Study 1 (-Simulation_Original Design-) is
displayed. View the default folders.

Return to the FeatureManager.
m  Click the FeatureManager tab.

A green check mark on a Study folder indicates
that material is assigned.

If needed, return to the FeatureManager.

Create a Static Analysis Study

7 ;
LBY_ASSY (Simulation_Original #

Ble

:g] Sensors
# @ Design Binder
[+ il Annokations
\<§\ Front
& Top
%> Right
I.. Qrigin
& (-) Support Tube<1> (COS
W, (F) FLOAT4s <1
= {Q (F) Wiews Part, Acrylic 150m. %

o ~
fstudy 1 {-Simulation_Criginal _Desig

# [[5) CH End Cap - 300m STED-1

- [[Z) CH End Cap - 300m STED-1

;..S‘ Wiew Port, Acrylic 150m-1
= ﬁ; Connections

[+ & Component Contacks

g:f Fixtures

&_j External Loads

@ Mesh
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Assigning Materials in SolidWorks

Simulation

You can apply a material to a part, and create or
edit a material with the SolidWorks Simulation

Material dialog box.

The Properties tab in the Material dialog box
allows you to define a material source, material
model, and material properties. You can define
constant or temperature-dependent properties.

Defining materials in SolidWorks Simulation

SolidWorks Simulation

B% Parts

Q* Study 1 (-Simulation_Original_De

Big]CH End Cap -
oM

— notahoredf.

300m STBD

i= Apply/Edit Material...

| Tre'ﬁ@gelected bodies as beams]|
Exclude from Analysis

Make Rigid

Q

Study
Advisor

-
Fixtures External
Advisor Loads...

Apply
Material

Assembly | Layout | Sketch | E|

does not update the material assigned to the

model in SolidWorks.

Define and apply material to the two EndCaps in the Housing assembly in the next

section.

Material

et

4

-5 SolidWorks Materials

-2 steel

--#= 1023 Carbon Steel Sheet (S5)
--#= 201 Annealed Stainless Steel (55)
.= A286 Iron Base Superalloy

.3 AISI 1010 Steel, hot rolled bar
.35 AISI 1015 Steel, Cold Drawn (S5)

--3= AIS1020 Steel, Cold Rolled

..§= AISI 1035 Steel (55)

8= AISI 1045 Steel, cold drawn

3= a1s1 304

.35 AISI 316 Annealed Stairless Steel Bar (S
.3 AISI 316 Stainless Steel Sheet (S5)

.35 AISI 321 Annealed Stairless Steel (55)
.3 AISI 347 Annealed Stairless Steel (55)

.35 AISI 4130 Steel, annealed at 865C
8= AISI 4130 Steel, normalized at 870C
8= AISI 4340 Steel, annealed
.3 AISI 4340 Steel, normalized
.32 AISI Type 316L stainless steel
.3 AISI Type A2 Tool Steel
8= Alloy Steel
3= Alloy steel (55)
3= ASTM A36 Steel
8= Cast Alloy Steel
8= Cast Carbon Steel
3= Cast Stainless Steel
8= Chrome Stainless Steel
e & .

1 ]

m

Properties | Tables &Curvesl Appearance I CrossHatch I Custom I Application Data I | ol

Material properties

Materials in the default library can not be edited. You must first copy the material to

a custom library to editit.

[Linear Elastic Isotropic

il

[st-n/m~2 a)

|

Steel

AISI 1020

Max von Mises Stress

Defined
Property Value Unitz. -
Elastic Modulus 2e+011 Nim"2 i
Poissons Ratio 0.29 NIA
Shear T.7e+010 | Nm"2
Density 7900 ka/m*3
Tensile Strength 420507000 | N/m™2 £
Compressive Strength in X Nim"2
Yield Strength 351571000 | Nfm"2
Thermal E Coefficient | 1.5e-005 1K
Thermal C 47 Wim-K) B
Specific Heat 420 Ji(kg-K)
Material Namninn Ratin NiA i
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Selecting parts and Applying Material in
SolidWorks Simulation

1

Note:

Select the two EndCaps.

Expand the Parts folder.

Click the first CH EndCap part.
Hold the Ctrl key down.

Click the second CH EndCap part.
Release the Ctrl key.

Click Apply Material from the

Simulation tab in the CommandManager.

The Material dialog box is displayed.

Assign Material.

Expand the Steel folder.

Click AISI 1020. View the available
material properties and information.
Click Apply.

Click Close from the Material dialog
box. View the results in the Study tree.

A green check mark on the Parts folder
indicates that material is assigned to the
parts.

Assigning Materials in SolidWorks Simulation

SolidWorks Simulation

f Study 1 (-Simulation_Original_Dd
C %Parts

CH End 1y
[ view Part, Acrylic 150m-1]
T2 Connections
gCDmponent Contacts
Fixtures
(] External Loads
Eal Mesh

Q = o B

tudy ‘= Fixtures External
Apply

5
A?Maherial Advisor Loads...

A1 1020

SolidWorks Materials -
Steel
-3 1023 Carbon Steel Sheet (55)
.= 201 Annealed Stainless Steel (35)
35 A286 Tron Base Superalloy
§= AISI 1010 Steel, hot rolled bar
-3 AISI 1015 Steel, Cold Drawn (55)

.. §= AI51 1020 Steel, Cold Rolled
§= AIs1 1035 Steel (55)
-.§= AISI 1045 Steel, cold drawn

m

35 ATSI 316 Annealed Stainless Steel Bar (S5
§E AISI 316 Stainless Steel Sheet (55)
&E AISI 321 Annealed Stainless Steel (55)
4= AISI 347 Annealed Stainless Steel (55)
.. §= AIST 4130 Steel, annealed at 8650
§= AIST 4130 Steel, normalized at 870C
&E AISI 4340 Steel, annealed
3= AISI 4340 Steel, normalized
.. 4= AISI Type 316l stainless steel
§= AISI Type A2 Tool Steel
&E Alloy Steel
3= Alloy Steel (55)
8= ASTM 436 Steel
§= cast Alloy Steel
--3= Cast Carbon Steel
.§= cast stainless Steel
..4= Chrome Stainless Steel

111 +

Study 1 {-Simulation_Original_Design-|
» Parts

[ cH End Cap - 300m STED-no ¢
[ cH End Cap - 300m STED-no ¢
[ view Port, Acrvlic 150m-1 ([
= ﬁ; Connections
[+ & Component Contacks

g:\s Fixtures

;] External Loads

% Mesh

21



SolidWorks Simulation SolidWorks Simulation

Applying Fixtures
A component that is not fixed will
travel indefinitely in the direction
of the applied load as arigid body.
Fixtures and loads define the
environment of the model.

b3
3

A rigid body contains six degrees
of freedom, three rotational and
three translational. You apply
restraints to remove degrees of

freedom. Standard (Fixed Geometry) 4 || || Standard (Fixed Geometry) ¥
Each load or fixture condition is @ i Adyanced A
represented by an icon in the @:' FRIBERE @.' e
Study, | ﬁ] Fixed Hinge |g| Cireular Symmetry

im| |@ | Use Reference Geometry

In this section, address an On

. . =l |
cylindrical face fixture. W o

|E | On Cylindrical Faces

| Advanced ¥ | |6_J On Spherical Faces
Symbol Settings A @
s o)
i~ =
Show preview
Symbol Settings n
s o)
i~ 12
Show preview B

22 Applying Fixtures
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Applying a Fixture

= | = | 18 OB W

1 Apply a Fixture. s | oy TS| PO e | e
: - - Material
m  Click the Fixtures Advisor drop- e S

down arrow from the Simulation tab :lz’““emb"’ s e jee b maias
3 Fixed Geometry 4—_
in the CommandManager. Rollr/Sider

® Click Fixed Geometry. The Fixture

Fixed Hinge

@ LBY_ASSY (SII‘nL

PropertyManager is displayed. The (2] sensors

Elastic Support

Advanced Fixtures

£ Desion Rinde

Fixed Geometry option is selected by
default. Fix the model to simulate
how the two EndCaps are mounted to
the Housing.
2 Select the Faces to be Fixed. =
. . . Standard (Fized Geometry) &
m  Click the cylindrical face of [

h . | Fixed Geometry
F e right EndCap as. |

illustrated. Face<1> is

displayed in the Standard |l Feste -

(Fixed Geometry) box. N faeecioGehiind o
m  Click the cylindrical face of

the left EndCap as

illustrated.

3 Set Fixture Type.
® Expand the Advanced dialog box. r%‘rmdﬂ"
m  Click the On Cylindrical Faces box. The o e

Translations dialog box is displayed. (@) cireer symmetry

|®| Use Reference Geometry

|[" J| On Flat Faces
| L‘\I\ On Cylindrical Faces
|k )| on Spherical Faces

) WFacei=@crendc }
Fare<1>@CH End C

£

Symbol Settings

Applying Fixtures 23
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4 Select Units and Displacement

Components.

m  Select mm from the Unit
drop-down menu.
m  Click the Circumferential

box.

m  Click the Axial [# | box. View
the results in the Graphics

arca.

5 Apply the Fixture.
m  Click OK from the Fixture

SolidWorks Simulation

T A
H (m -
([0 i
(] rad
s oL

On Cylindrical Faces: ||
Circumterential (rady; [0 |
Azl Cmm): o]

Symbol Settings

«

PropertyManager. An icon named On
Cylindrical Faces-1 is displayed in the

Fixtures folder.

Note: Press the f key to fit the model to the Graphics

arca.

24

——> - Ej On Cylindrical Faces-1 {:variable:)

il J
@ LBY_ASSY (Simulation_Original_Design #
3] sensors
@ Design Binder
rf, E Annokations
\<§\ Front -
2 Top
% might
I.. Crigin
8, () support Tube<1> (COSMOS)
8 (P FLOAT4s<1>
B (F) View Port, Acrylic 150m <13 -3 1%
Ad i | 3
b
Q*Study 1 {-Simulation_Criginal_Design-)
r}j--% Parts
[[¥j cH End Cap - 300m STED-no tab-re
[ cH End Cap - 300m STBD-no tab-re
[ view Part, Acrylic 150m-1 (-[5w]ac
= ﬁ; Connections
g Component Conkacks
= g:f Fizkures

E External Loads

- Q Mesh
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Applying Loads
Loads are forces and pressures applied to
faces, edges, and vertices of the model.
In SolidWorks Simulation you can apply
uniform and variable force and pressure,
torque, bearing loads, and body forces
such as gravity and centrifugal force.

B You will apply a Pressure load to the
Housing. The Pressure load will
simulate approximately 3,400 feet of
seawater.

Note: You will use English (IPS) units in this
section. Each 33.3 ft. of seawater is
approximately equivalent to 1 ATM or

« X 42

14.7 PSIL R
®  Apply the Normal to selected face — -
option for Pressure Type. —1 P @ tormal to selected face
m Select all exposed faces of the O Use reference geometry
Housing to apply a pressure load to i}
simulate the seawater depth
pressure.
Pressure Yalue A
T

[Creverse direction

[IMonuniform Distribution 2

AL ]

Equation coefficients

Symbol Settings ]

)
I —

Show preview

Applying Loads 25
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Applying a Pressure Load ¢ W U G B

1 Apply aPressure Load.  [ui 55 cpmi 7 1| |0
m  Click the External Loads | - e - i (Tree 50
drop_down arrow from the put I Sk i External Loads Advisar
. . . Force Type Py
Simulation tab in the B |Torque
e %ormal to selected Face
CommandManager' = remine & se reference geometry
m Click Pressure . The @
Pressure
PropertyManager is
displayed. The Type tab is
selected by default.

m  Click the Normal to
selected face box.

2 Select the Faces to Apply the

Load.

m Rotate the model with the
middle mouse button as
illustrated.

B Click the front EndCap as
illustrated. Face<1> is displayed
in the Faces for Pressure box.

B Zoom in on the front
EndCap as illustrated.

m  Click the other three
faces of the front
EndCap. Face<2>,
Face<3>, and Face<4>
are displayed in the Faces
for Pressure box.

Note: Ifyou select an incorrect face,
right-click inside the Faces for
Pressure box and click Delete
if deleting a single face or
click Clear Selections if you )
want to clear all entries.

Type ]

(%) Mormal ko selected Face

O Use reference geometry

Face<5=@VYiew Port, + A
Face<4>=@CHEnd Cap
Face<3=@CH End Cap
Fare <2 >@CH End Ca
[ —
rlear Selections

Note: Face ID’s in list may vary. o
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Note:

Select the View Port Face.

Press the f key to fit the model to
the Graphics area.
Rotate the model with the middle

mouse button as illustrated.

Click the View Port face. Face<5>

is displayed in the Faces for
Pressure box. Note the icon
feedback symbol for a face and
displayed feature information.

Do not select an inside face.

Select the Faces to
Apply the Load.

Zoom in on the
back EndCap

face as illustrated.

Rotate the model
with the middle
mouse button to
select the other
four faces of the
back EndCap.
Click the four
faces of the back
EndCap as
illustrated. Nine
faces are
displayed in the
Faces for
Pressure box.

Applying Loads

Pressure Yalue (Nim 27

[Pressure walue (Minm*2 (MPad 1]

SolidWorks Simulation
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5 Set the Pressure Value.
m  Select psi from the Units drop-down menu.
m  Enter 1500 in the Pressure Value box.

6 Apply the Pressure.

B Click OK from the Pressure
PropertyManager. SolidWorks Simulation applies

1500 PSI pressure and creates an icon named
Pressure-1 in the External Loads folder as
illustrated.
7 Fit the model to the Graphics area.
B Press the f key. View the model in the Graphics
area.

Note: If you change units after typing a value, SolidWorks
Simulation converts the value to the new units.

28
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| Type ] "

(%) Mormal to selected Face

O Use reference geometry

@ iFace<5>@\n‘iew Port, & |
| Face<4=@CHERd C: |
|Fare<3»@CHERd C: |
|Face<2=@CHERd C: = |
| =@CH End Caa

@ LBY_ASSY (Simulation_Original #
@I Sensars

= @ Design Binder

] il Annotations
\<§\ Front =
& Top

&y Right
I.. Crigin
'@; (-} Support Tube <1 = (COS
58 (F) FLOAT4s=1 =

- T8y (F) view Part, Acrylic 150m- v

=+

&l I &
T
Q*Study 1 {-Simulation_Original _Desi
= % Parts

& [ CH End Cap - 300m STED-r
i [ CH End Cap - 300m STED-r
5 [ view Part, Acrylic 150m-1 {
= ﬁ; Conneckions
| & Component Contacks
= g:fFixtures
B On Cylindrical Faces-1 {iva
= @ External Loads

P LLL Pressure-1 {:1500 psit)

% Mesh
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Creating a Mesh and Running the Analysis

Creating a Mesh is a very crucial step in design analysis. Meshing is basically
splitting the geometry into small, simply shaped pieces called finite elements. The
automatic mesher in SolidWorks Simulation generates a mesh based on a global
element size, tolerance, and local mesh control specifications. Mesh control lets
you specify different sizes of elements for components, faces, edges, and vertices.

SolidWorks Simulation estimates a global element size for the model taking into
consideration its volume, surface area, and other geometric details. The size of the
generated mesh (number of nodes and elements) depends on the geometry and
dimensions of the model, element size, mesh tolerance, mesh control, and contact
specifications.

Meshing generates 3D tetrahedral solid elements, and 2D triangular shell
elements or 1D beam elements. After the mesh is created, you can run the
analysis. SolidWorks Simulation solves a series of equations based on known
material properties, restraints, and loads. The Static solutions provide information
on displacement, stress, and strain.

Before Meshing After Meshing

Creating a Mesh and Running the Analysis 29
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Creating a Compatible Mesh

1

Note:

30

Create a Compatible Mesh.

m  Expand the Component Contact folder from
the Study tree.

m Right-click Global Contact (-Bonded-).

m  Click Edit Definition. The Component Contact
PropertyManager is displayed. View your
options.

®  Click Compatible mesh from the Options box.

Accept the default settings.

m  Click OK from the Component Contact
PropertyManager. In the next section, start the
Meshing process.

You can also right-click Study 1
and click Properties to set mesh
compatibility. Check the
Improve accuracy for
contacting surfaces with
incompatible mesh box.

Static

Gap/Contact
[ Inciude global friction

implified bonding contact

Bty | (Siglepaaraeat o
= %Parts @ | Bun

o mCH E Update All Components
= [Fore Export...
[+ Wiew
HE m | Trend Tracker
= ?; Connecti
£ &Com[ | Delete
= g:\ﬁ Fixtures
[j onQ Details...
= & External Properties...
Ll Pres:
% Mesh | Define Function Curves,

SolidWorks Simulation

T’Study 1 {-Simulation_Criginal_Desigr
= %Parts
i [[¥j CH End Cap - 300m STED-nC
i [¥j cH End Cap - 300m STED-nC
e [ view Port, Acrylic 150m-1 (]

= T3 Connections
= & Component Conkacks
A T
= g:f Fixtures Suppress
B on & —— 5 petton]
= ,g External Lo - b=
L Pressu | Deléte
% Mesh

Copy

¢ ® =

| Message A

Select the componentsfbodies to

define a Bonded contact. Mate:

Selecting the top level assembly will

apply a Bonded contack ko all
components,

| Contact Type

O Mo Penetration

(&) Bonded{No clearance)
3 Allow Penetration

»

; Components E3

[] Glabal Contact

| Options |
F (&) Compatible mesh

() Incompatible mesh

[ 1gniore clearance for suface contact

| Options | Adaptive | Flow/Thermel Effects | Remark|
Friction cosfficient: |0.05

%mpmve accuracy for no penetration contacting sufaces [glower)
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Creating a Mesh

1 Create a Mesh.
m  Click the Run drop-down arrow from the
Simulation tab in the CommandManager.

m  Click Create Mesh . The Mesh
PropertyManager is displayed suggesting
Global Size and Tolerance values.

2 Review the Meshing Options.
m  Expand the Mesh Parameters box. View the
available options.
m  Click the Standard mesh box.
m  Expand the Advanced box. View the available
advanced options for additional control.

Creating a Mesh and Running the Analysis

SolidWorks Simulation

73 B & g
Connections | Run | Results c
Advisor Advisor it
Results

Fvaluate | Off & | Run /]
=

Run Design Scenarios

& Create Mesh 4—

Run Al Studies

S s@me |

« R

» |

| Mesh Density

B J

Coarse Fine

|“|Mesh Parameters % |
/@ Standard mesh
(@]

Curvature based mesh
E| | mm

A [ 113798256 v %]

A [ o0sssssizar v 4|
ML e

|:| Autamatic transition

| Advanced _»

Jacobian points

|4 points v |
[Cloraft Quality Mesh
[ automatic krials for solid

0 Remesh Failed parts with
incompatible mesh

13 |

| DOptions
0 Save settings without
meshing

[CIrun {solve) the analysis
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3 Start the Mesh Process.
B Click OK from the Mesh

PropertyManager. Meshing starts and the
Mesh Progress window appears. After
meshing is completed, SolidWorks
Simulation displays the meshed model. A

green check mark is applied next to

the Mesh folder in the Study.

Note: Right-click Mesh. Click Hide
Mesh/Show Mesh to toggle the
visibility of the mesh.

Note: Right-click Fixtures. Click Hide

All/Show All to toggle the visibility
of the loads and fixtures.

4 Run the Analysis.

m  Click Run . from the Simulation tab in
the CommandManager. Three default plots

are created.

32
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= g Fixtures = T2 Connections J
B On Cylindrical Faces-1 {iva & Component Conkacks jl
= [ External Loads o f T 1
LU Pressure-1 (:1500 psis) Ej o & | advisor...
ngxter
@,,j Simplify Model For Meshing = Wip Fixed Geometry, ..
| ;
& Create Mesh, .. % T RollerfSlider. ..
Mesh and Run Fixed Hinge. ..
Elastic Support. ..
Failure Diagnostics. ., T
__ Bekals. Grounded Balt...
fact 5 |
B8] | apply Mesh Contral... Advanced Fixtures,,
Create Mesh Plot...
Create Mew Folder
@ List Selected .
A robe I
- Shitsw All
Hide Mesh
Hide %l Contral Symbols Copy
Show All Contral Symbols
Copy
48 2 B B
External Connections Run | Results .
Loads...  Advisor Advisor Rc

sich | Evaluate A Office Products | Simulation

= g:fFixtures
B On Cylindrical Faces-1 (v
(= é] External Loads
LU Pressure-1 (31500 psi:)
% Mesh
= Q Results
o
@l Displacement] {-Res disp-)
&E Strainl {-Equivalent-)
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Viewing the Results

After a successful run of a Static analysis, SolidWorks ¥ Study 1 (-Simulation_Original_Desi
Simulation creates three default plots: Stress,
Displacement, and Strain. @ [P cH End Cap - 300m STED-r

Note:

The results are utilized with your design criteria to ._] 73 Connections
answer the following questions:

m  Will the model fail? d &=
®  How will the model deform? L Pressure-1 (11500 psin)
m  Can you reduce material or change material without & gz:i,ts

affecting performance? B fotress1 Cyvondises)|

Results may vary depending on mesh type, and system

setup.

=] % Parts
@ [FcHEnd cap - 300m 5TBD

5 [ iew Part, Acrylic 150m-1 {
i & Component Contacts

lj 2 g:f Fixtures
: 8 On Cylindrical Faces-1 {iva

: ﬁl Displacement (-Res disp-)
he Strain (-Equivalent-)

|

@saumxs jj Fle Edt View Insert Tooks Smuaton \Window Help & l W
= = 18 72 B 5 B Design Insight
Study A;;y Fixtures External Connections Run | Results e compare B Plot Toolks " 2
Advisor Material Advisor Loads...  Advisor Advisor B e
Assembly [ Layout | Sketch | Evaluate | Office Praducts | Simulation | [ vimMizes (2
vEEe »| oserane: oG 5 B (B F- 60 @ M- B s
. =  Study name: Study 1
_w Plat type: Static nodal stress Stresst 492 538 @
; % (f) CH End Cap - 300m STB »| Deformation scale: 496218
B () ML304-B<1> L 447841 |l
&, () MI 303-R<1 =
1l I | = 3 . 403143 E
L E
T~ )
(T ) | 358,445 2
Q*Study1(-Simu|ati0n_0rigina|_| & e
: B 313748
EI% Parts 4 @
-l CH End Cap - 300m STE| ¢ J80.052
(=18 CH End Cap - 300m STE
[ View Part, Acrylic 150mm 224.354
E—]ﬁ; Connections = i7oesT
Bg Component Contacts
o ,51 Global Contact (-Bo . . 134.960
Bg:f Fixtures v an.262
Ej On Cylindrical Faces-11(
(] External Loads 45565
i Al i i
LU Pressure-1 (1500 psiz) g,
..... Mesh
b %
2-{tal Results =| Flsometric
Tiot
| SelidWorks Premium 2012 x64 Edition Under Defined  Editing Assembly MMGS «  [3]
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View the Results

1

Note:

34

Hide all symbols.

m  Click the drop-down menu from the Hide/
Show items tool in the Heads-up toolbar

as illustrated.

m  Click the View Simulation Symbol icon to

hide all symbols.

View the von Mises Stresses.

®  Double-click Stress1 (-von Mises-). The
Stress Plot PropertyManager is displayed. Plot
units if needed can be modified from the

PropertyManager.

m  Click OK from the Stress Plot

PropertyManager.

SolidWorks Simulation

-
i
ﬁ.
»
ey

d
/

B~b (@t

&)= @)+

Yiew Simulation Symbol
Control the wisibility of symbols that
represent loads, restraints, and
connectors in simulations,

The von Mises stress indicates the internal forces in a body when subjected to
external loads for ductile materials. Most engineering materials are ductile.

Model name: LBY_ASSY
Study name: Study 1

Deformation scale: 4.9562

Plat type: Static nodal stress Stresst

won Mises (himm*2 (MPa))
537.235
492538
| 447 841
. 403143
_ 355.446
33749
269.052
224354
179657

. 134.860

90.262
45565
0.368
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Note: To view the stress plot in a different unit system, right-
click the active plot icon. Click Edit Definition. Set
units. Click OK from the Stress Plot PropertyManager.

3 Display a Section View using the Top Plane.

Click the SolidWorks FeatureManager [®] tab.
Click Top to select Top Plane as illustrated.
Click the Plot Tools drop-down arrow from the
Simulation tab in the CommandManager.

Click the Section Clipping tool as illustrated.
The Section PropertyManager is displayed. Top is
displayed in the Reference entity box.

Check the Show section plane box.

Un-check the Show contour on the uncut portion
of the model box. View the default settings.

Viewing the Results

SolidWorks Simulation

Mesh

= E] Results
&l C Hide
iy

3 Edit Definition. ..

D Animate. ..

pERe] -
§ - Y
d‘minal_[ ~
ﬂ Sensars

[ @ Design Binder

l'+ @ Annokations

\<§\ Front

\<§\ Top 4_

%> Right

I.. Crigin

8 (=) Suppart Tube=1 3 (COSM =

L[ R ) Tt

] E Design Insight
JCompare [@g Plot Tools
Results |

% Section Clipping

bn @ﬂ Isa Clipping

/ Probe

:g | List Selected

@ Save As

B> | Animate

W R

ISEEn ——
B @ O

@| Top

& 0.0000mm

m 0.00deg

u 0.00deg

}\‘ 40.60283303mm -

k3

»

1

4+ 4

| [[] section 2

&«

»

| options

@
—E Show section plane
[~ Plot on section anly

— Show contour on the uncut
.—' portion of the model

[] Explode after dipping
|g| Reset

35



SolidWorks Simulation

Note:

Note:
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m  Click OK from the
Section PropertyManager.

B Rotate the model as
llustrated with the middle
mouse button to view the
results.

Deformation is magnified for
improved visibility. The
deformation can be displayed at
any scale.

Use the Zoom to Area tool
located in the Heads-up View
toolbar to Zoom in on a section
of the model.

Display an Isometric view.

Click Isometric view from the Heads-up
View toolbar.

Probe the Model.

B Zoom in on the front EndCap.

m  Click the Plot Tools drop-
down arrow from the
Simulation tab in the
CommandManager.

m  Click Probe . The Probe
Result PropertyManager is
displayed.

SolidWorks Simulation

QEAasm@E @ - @ -8

Zoom ko Area
Zooms to the area you select with a
bounding box.

QAT HE P - @8-
B [Q® ©
BDE B
i &
EEma%

Iso Clipping

Probe 4—

List Selected

Save As

Anirmate
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m Click five points from front to back as illustrated.

— Report Options
m  Click the Plot button from the Report Options M) @!\' 12
box. View the results.

»

Plot

Note: Results will vary
depending on the selected
location of the points.

X V 7 Location: 54557e 016,104 mm
value [206.295 _Wimm™2 (MFPa) |

6 Review the Plot.
m Review the plot.
This is an excellent

1 Study name: Study 1
Wa}./ t(,) CXF:lInll'lC the Plot type: Static nodal stress Stress1
variation 1n stress

% Probe Result

File Options Help

across the 400007 - e srResEREy — —
geometry of your : : : : :
part. g 300.00
7 Close the Probe g
Results dialog box. < 20000
B Close the Probe $
Results dialog box. i

8 Close the Probe

Result 5 : : . ; ;
PropertyManager. ' #0 #1 # # #4
m Click OK from oesten
the Probe Result —+— von Mises (N/mm™2 (MPal)
PropertyManager.

0.0
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9 Deactivate the Section Plot.

Click the Plot Tools drop-
down arrow from the
Simulation tab in the
CommandManager.

Click the Section Clipping

tool. The Section
PropertyManager is
displayed.

Click the Clipping on/off

button from the Options
box as illustrated.

Click OK from the
Section PropertyManager.

10 Fit the model to the Graphics
area.

Press the f key. View the
results in the Graphics area.

11 View the Displacement
Plot.

38

Double-click
Displacement1 (-Res
disp-) in the Results
folder. View the plot.

SolidWorks Simulation

Design Insight
E gn Insig
Compare E Plot Tools R
Resuits T [k
@3 Section Clipping
hion | @' Iso Clipping

/ Probe

E List Selected

ﬁ Save As

B Animate

Options
@5

Show section plane

»

Naaaf

[¥]Plat on section onky
Show contour on
[the uncut: portion of

the miodel

Explode after
t clipping

7=

|Clipping on | aff

L 44781

L 403143
355,446
3749
289.052
224.354
179.657

L 134850
90262
45565
0.558

won Mises (Ninm*2 (MPa))
537235

432,538

\

URES (mm)
4.430
I 4.081
. 3692

. 3323

2.954

2585
2216
1.847

1475
1.109
0.740
0.3m

0.ooz2
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12 Animate the Displacement Plot. —
®  Click the Plot Tools drop-down arrow from the Comparel Plat Tools [%
. . . Results
Simulation tab in the CommandManager. % Sect'T” Clpping
bn Is0 Clipping
m  Click Animate . The Animation Z i
PropertyManager is displayed. View the animation é ;::::Cte
in the Graphics area. — P> | animate
13 Stop the Animation. % Animatio
m  Click Stop [&] v %
14 Save the Animation. e (e 2
m  Check the Save as AVI file box as illustrated. i L3
m  Click the Browse button. Accept the default - =
location. mh J 50
m  Click Save from the Save As dialog box.
m  Click OK from the Animation Save as AVI file -
PropertyManager.
CiDocuments and Settir
[ wiew with Media player

15 Calculate the Factor of Safety.

m  Right-click the Results folder. i"iﬁe,;nisﬁa:f(:lm o l

m  Click the Define Factor Of Safety Plot ﬁMesh
tool. The Factor of Safety / o= s & o
PropertyManager is displayed. &eﬁ ___S_°"’er Hessages...

m  Select the first CH End Cap component as BN iR G
illustrated from the drop-down menu. 5 o f_:;;s:c::tent o

m  Sclect Max von Mises Stress from the
drop-down menu as Criterion. Note your

. .. o R ) ©
options for Criterion.
Message ¥
Step 1 of 3 ]

CH Erd Cap - 300m 5TED-no K7

CH End Cap - 300m STED-no tab-rewf-1-Cut-Extrudel
h CH End Cap -|@0m STED-no bab-revf-5-Cut-Extrude ]
The View Pork, Acrylic ISDm 1-5plit LineS

Step 1 of 3 ]
CHEnd Cap - 300m STED-no %

E? Automatic _bv

The [Max von Mises Stress k

Max Shear Stress (Tresca
Mohr-Coulomb Stress

[Maz Mormal Stress
Jautomatic

Mohr- Coulomb used for brlttle
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B  Click Next to continue to step 2. TS Factor of Safety 7
Accept the defaults. ¥ X @ @
m  Click Next to continue to step 3. [adacsage =
m  Click the Areas below factor of safety Step 10f 3 A
box. | cH End Cap - 300m 5TBD-n0 v |
m  Click OK from the Factor of Safety ® Waix e 8
PropertyManager. View the model in the Fvonttises ‘
Graphics area. & Lim
® Rotate the model with the middle mouse [Property %]
button. The area in blue has a FOS above T
1. The area in red has a FOS below 1.
Step 3 of 3 A
(") Factor of safety distribution
@[g)eas below factor of safety
1
Bafety result

Based on the maximum von
Mises stress criterion:
Factor of safety:

D.654408

m Right-click Factor of Safety1 as

= [E]Results
illustrated from the Results folder. R stresst (voniises:)
m  Click Chart Options. The Chart Options EelEEE::fe::::il\,;::f_f'sp')

1 1 F t rs r t 1 ........... P
PropertyManager is displayed. &yw e
Edit Definition, ..

% Section Clipping. ..

@ tings. ..
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®  Check the Show min annotation box. Accept the
defaults settings. View the results in the Graphics

lf:har_t_ Options

v %
area.
Display Options A
m  Click OK| ¥ | from the Chart Options K, §how min amation
PropertyManager. View the results. shewmax emetaten

Show plot details

B Rotate the model with the middle mouse button. 7] how legend

View the area in red. The area in red has a FOS
below 1. The area in blue has a FOS above 1.

| Show Min/Max range on
shown parts only

@ Automatic

I 0.654407918
]

Note: The minimum FOS is approximately 0.65. You did not
meet the design goal, which is to obtain a FOS greater
than one. In the next study, add structural ribs to the
EndCap to obtain the design goal.

"n 405. 10662842
() Defined:

_’n 0.654407918

"n 405. 10662842

| Pasition/Format

«

| Color Options

<

@saum l File Edit View Insert Tools Simulaton Window Help QlD T

= ﬂ:\s LE ?; % h : E Design Insight
Study A:: Fixtures External Connections Run | Results Dbt B plotTool o
Advisor PP mdvisor Loads...  Advisor g O IR RN A RS -
Material Result Results
Assembly | Layout | Sketch | Evaluate | Office Products | Simu!ation[ =
@ " |% "e] o3 Model name: LEIV;%A@%V '{Q‘S E_H @, @v [ ? &v I&v
W | Study name: Study 1

- Plat type: Factor of Safety Factor of Safetyt
..... '{Qj (-) ML304-B<1> «|  Criterion ; Max von Mizes Stress
_____ '{% (-) ML303-B<1> Red= FOS=1 =Hlue

..... ; (-) Backpinl<1> (Default)

ik

(t_*Study1(-Simulation_OriginaI_De:
EI% Parts
i CH End Cap - 300m STBD-
[ cH End Cap - 300m STBD-
B Views Part, Acrylic 150m-1
=] ;Connections

g Component Contacts

¥ Fistures

- 8 On Cylindrical Faces-1 (wva

B@ External Loads .
Py LU Pressure-1 (1500 psit)
Mesh

B{EI Results
P omd
41>

i ‘[_Model | ilotion Study-Default ] 4 Study 1
SolidWorks Premium 2012 x64 Edition Under Defined  Editing Assembly MMGS «  [3]

Y
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Creating a SolidWorks
eDrawings File

42

You can save result plots
in the SolidWorks

eDrawings® format. The
SolidWorks eDrawings
application provides a
facility for you to
animate and view your
analysis results. You can
rotate and zoom
SolidWorks eDrawings
using the eDrawings
viewer. The eDrawings
files are self-viewing,
small, and hence
convenient to send via
email.

SolidWorks Simulation

& save As

N

l ===

(LK) [ | » solidWorksSimulation Test Drive » SolidWorks Simulation » LBV ASSV-Study 1

Organize Newfolder
4 Nome
B Desktop

& Downloads

] Recent Places

G Libr
B o
ah
i) Pictures
Videos

& Homegroup

8 Computer
&L Local Disk(C)  ~

Date modified Type Size

No items match your search

g

“ Hide Folders

Save Configurations to eDrawings file &I

(@ Current configuration
() All configurations
(7 Selected configurations:

Saving additional configurations may increase
save time and file size.

OK ] [ Cancel ] I Help

Creating a SolidWorks eDrawings File
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Creating a SolidWorks eDrawings file

= {:‘Fixtures
1 Create a SolidWorks eDrawings file. | QEO“ICE““‘;”“‘ by
. . =4 xEernal Loads
m  Double-click Stress1 (-von Mises-) from the Results LUl Pressure-1 (:1500 psis}
%Mesh
folder. = [ Results

®  Click the Plot Tools drop-down arrow from the s ——
Simulation tab in the CommandManager. Eégi:::l el e

m  Click Save As . The Save As box is displayed.
B Select eDrawings Files for Save as type. Accept the
default name and location.

ﬁ( Factor of Safety1 {-Ma;

Design Insight

Plot Tools %
Section Clippin

i g
@D Iso Clipping
/ Probe
é List Selected
@ Save As
B> | Animate

m Click Save. —

QQ\ > Test Drive » SolidWorks Simulation » LBV_ASSY-Study1 <[4 ][ Seorch

Organize »  Newfolder

Ut Favorites
B Desktop

i) Pictures

B videos
& Homegroup

% Computer
&L Local Disk(C)
File name: ~

Save as type: [ <Drawings Files (*analysis.casm) -

2 Hide Folders [ concel
2 Publish a SolidWorks —
| Fil | Edit wview Insert Tools Simulation Window]

eDrawing.
® Click File, Publish to eDrawings

from the Menu bar menu. The
Save Configurations to eDrawings
file dialog box is displayed.

New... Ctrl+MN
Open... Ctrl+0
Close Ctrl+W

Make Drawing from Assembly
Make Assembly from Assembly

Save Ctrl+5
Save As...
Save All

Page Setup...

Print Preview...

Print... Ctrl+P
Print3D...

e DED SH TWO

Publish to 3DVIA.com...

Publish to eDrawings

-

Creating a SolidWorks eDrawings File 43



SolidWorks Simulation

m  Accept the default settings. Click OK from
the dialog box. If needed click Yes to the
dialog box. View the eDrawing.

m  Click Play El View the eDrawing.
m  Click Stop El

on - [LBV_ASSY.EASM]

SolidWorks Simulation

Save Configurations to

(@ Current configuration

() All configurations

(7 Selected configurations:
[Flpefault
[Fsimulation_Criginal_Design

Saving additional configurations may increase
save time and file size.

| ok

mwg;ﬁve m H%m Massml;mps

{#® File View Tools Window Help
Open Save Print..  Send Help
i 3
g A Q@ g @$
Zoom Fit Zoom Area  Zoom Rotate Pan
« m > > & B &
Previous  Stop  Next  Play [dessure Section  Stamp
I ENRB
[& Mesh  Legend  Tidle  Options
® =S LBV_as5Y
== B! Study 1
& L Stress1 (vorMises:)
Vi
el
L]
3
&
&)
« 3
Avaiiable: SoldWorks 2112 SB0 is avaiable for downiosd

—|@DRAWINGS® # @
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View the Stress1 (-von Mises-)
Plot.

m Click File, Open from the
Main menu in eDrawings.
Double-click the LBV-
ASSY-Study 1 in the saved
study folder. View the
eDrawing for the von Mises
Plot.

Click Play [>]. View the
eDrawing.

Click Stop El
Close the eDrawing and

return to SolidWorks
Simulation.

Click No. Do not save the
eDrawing.

2 SolidWorks eDrawing

SolidWorks Simulation

‘Window

Tools

Wi

ﬁ Save

Save As...

pen
. » SolidWorksSi... » SolidWorks Simulation » <[ 43 | Search SolidWorts Simulation O
Organize = Newfolder =~ 0 @&
_ ~ Neme Z Date modified Type
B Desktop i Finished 10/14/20118:22 AM ~ File folder
{14 Downloads  LBV_ASSY-Study 1 10/14/20111003 .. Filefolder

%] Recent Places

(4 Libraries
Documents
all Music
Pictures
& Videos

@ Homegroup
% Computer

&, Local Disk (C:)
s Local Disk ()

3 D Drive (EViom ™ ¢ [

(@ LBY_ASSY-Study 1-Results-Stresslanalysis_ 10/14/2011 10:03 .. _EASM File
b

m ] ’

File name: | BV_ASSY-Study 1-Results-Stressl.analy v | eDrawings Files (“.eprt, *.casm,” v

@ Move Gplode
E W~ Gier et o fitertise

7 | = 8 LBY_AS5Y-Study TResulsStress’
=] :88y CH End Cap - 300m STED-no |
a .88y CH End Cap - 300m STBD-ha |
i -y Wiew Pan, Actlic 150m-1

@ [ T — [3

@ File View Tools Window Help - |=] x|
=4 2 R @
Open Save Print..  Send Help
Q@ Q@ a g $ “ @
ZoomFit ZoomArea  Zoom Rotate Pan Shaded  Perspective Select Home  Mass Frops
< ®m B B =8 @B &4
Previous  Stop Next Play Ileasure Section Stamp
T ©

Available: SoidWorks 2012 SP0 is avaiable for download

—|@ DRAWINGS® # @
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Generating a Report

SolidWorks Simulation

The Report utility
generates an Internet-

. = - R t
ready or Microsoft® simaation | @ @ %5 @ @~ (P~ 6 - ét e

Word document

= ] E Design Insight

| Reiort |
Deformed Compare % Plot Tools - Inciitle Im3'%e for Report
Result  Results

|| Generates a Word report for the current:

analysis study,

convenient for review
by colleagues and

supervisors. The report describes all aspects of the analysis including material
properties, applied restraints and loads, and the results.

SolidWorks Simulation generates reports in HTML format and Microsoft Word

format.

Description
HOTD Report

7 i

SOLIDWORKS — Anslysed with Selidw

Simulation of
LBV_ASSY

Date: Friday, Cctober 14, 2011
= John Smith

46

MS Word Format
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Generating a Static Study
Report

1 Generate a Static Study
Report.

m  Click Report

from the Simulation
tab in the
CommandManager. If
needed, click OK to

the dialog box.

®  Enter Description:
HOTD Report.

B Check the Designer
box.

m  Enter Name.

®  Check the Company
box.

m  Enter Name.

B Check the Show
report on publish
box. Accept the
default settings.

®  Click the Apply
button.

m  Click the Publish
button.

Generating a Report

SolidWorks Simulation

5
Deformed Compare
Result  Results

E Design Insight
% Flot Tools

e Report |
= E In; Ee Imﬂ ;e for Report

Simulation 2, -‘@ &:_‘\" ffy @ ) @ - G~ %Generates a Word report for the current

Report

analysis study,

Report Options

[

Current report format:

Report sections:

0l
Assumptions
Model Information
Study Properties
LUrits

M aterial Properties
Loads and Fistures
Connectar Definitions
Cortact Informatiorn
Mesh Information
Senzor Detalls

=

3= T TO

Static Study Format

Section properties
Description:

HOTD Report

m

Header information

Designer:

John Smith

Company:
[CIuRL:

|:| Logo:

[ Address:

aBc|

["]Phone:

Report publish options
Report path:

Document name:
\E Show report on publish

DFax:

C:\Usersth\Desktop\SolidWarksSimulation Test Drive\SolidWorks [I]

LBV_ASSY-Study 1-1

ma‘-\pply | [ cancdl | [ Hep

Generating

Report

W]

(T

Generating Word Document. .,

Loads and Fixtures

Cancel

Currently writing:

47



SolidWorks Simulation

2 View the Result.

®  Microsoft Word
opens and the report
is displayed.
Review the contents
of the report. Note
Result plots are
included.

3 Close the Report.

m Close the report by
exiting Microsoft
Word and return to
SolidWorks
Simulation. The
Report folder is
displayed.

Note: Reports can be fully

48

customized to your
requirements.

SolidWorks Simulation

Description
HOTD Report

. Dete: Friday, Getober 14, 2011
N Dt John Smith
name: Study 1
lystz Seatia

Simulation of
LBV_ASSY

e
Q*Study 1 {-Simulation_Criginal_Design-)
= % Parts
H @ CHEnd Cap - 300m STED-no tab-rewvf-1 §-
= @ CH End Cap - 300m STED-no tab-revf-5 (-
[+ @View Port, Acrylic 150m-1 {-[SwW]acrylic (M
= ﬁ; Connections
[+ @ Component Conkacks
= g:\gFixtures
B On Cylindrical Faces-1 (ivariable:)
= é External Loads
L Pressure-1 (11500 psit)
% Mesh
% g] Irmages
IJ study 11
= é] Resuls
@ Stress1 {-vonMises-)
ﬁl Displacement] {-Res disp-1
&E Strainl {-Equivalent-)
@ Factor of Safetyl {-Max von Mises Stress

Generating a Report
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Analysis 2 - Static Study 2

In Study 1, the reports showed critical areas where
the factor of safety was less than one.

As a designer, you must decide how you can
increase the factor of safety.

® Do you change the material?
B Do you modify the existing model?
®  Should you re-evaluate the restraints and

loads?

In this section you will:

B Modify the EndCap in the Housing assembly.
Add ribs to the EndCaps to increase the structural
integrity of the Housing. (Due to limited time
today, you will simply Unsuppress the ribs from
the SolidWorks EndCap FeatureManager.)

Copy information from Study 1 to Study 2.
Mesh and Run the new analysis.

View the results of Study 2.

Compare Stress and FOS Plots between Study 2

and Study 1.

Analysis 2 - Static Study 2

SolidWorks Simulation

B () ML304
£ |

B 5|2 [ @] »
/? s .
H !il Annotations ol
\<§\ Front
& Top
% Right
I.. Qrigin
W8y (-1 Support Tube <1 (COSMOS)
W, (F) FLoAT4s<1 >
[+ Q‘ () Wiew Pork, Acrylic 150m<1 = -3
=8} (F) CH End Cap - 300m STED-na ta
: / Coincident6372 (CH End Cap -
=] @ Features
@l Sensars
[+ :;l Annokations
8= Material <not specified:=
\<§\ Flane1
\<§\ Flanez
\<§\ Flane3
I.. Ori

w o ool [ 13| S
<5z Fid .E{} k I
- R

&3 ;
@ cul |.:h Invert Selection

Feature (CirPattern1})
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Creating Analysis 2 - Static Study 2
Create Study 2.

1

Note:

50

SolidWorks Simulation

Right-click the Study 1 tab in the
bottom section of the Graphic area
as illustrated.

Dupﬁate
Rendthe
Delete

Yﬁ
Create New Motion Study

# Create Mew Simulation Study

Create New Design Study

Click Duplicate. The Define Study
Name dialog box is displayed.
Enter Study 2 for Study Name.
Click OK from the Define Study
Name dialog box. Study 2 is
displayed.

Study 2 is a copy of Study 1.

Modify the EndCap Part.

Click the Model tab at the bottom of the
Graphics area.

Expand CH EndCap - 300m STBD-no tab-
revf.

Right-click CirPattern1.

Click Unsuppress from the Context
toolbar. The Housing with the ribbed
EndCaps is displayed in the Graphics area.
Both instances of this part are updated.
Rotate the model with the middle mouse
button to view the unsuppressed ribs.

Return to Study 2.

Click the Study 2 tab at the bottom of the
Graphics area.

Model | Motion Study - Defa
leemivrm 2012 64 Edition

| Define Study Name

Study Mame :
Study 3

Eonfigl.%tion to uze:

I Simulation_Original_Design - I

[ Qg ]l Cancel I[ Help I

Motion Stu
12 64 Edition

Wi wiiw] | Mod
olidWorks Premiu

e % (F3 Wiew Port, Acrylic 150m<1 = -= (COSM

=¥} (F) CH End Cap - 300m STED-no tab-revF-
[+ (%] Mates in LBY_ASSY

.L«—;Jl Sensors

(4]
8= Material <not specified:>
% Planet
% Planez
% Planed

I.. Crigin —
\ (1=
[+ 65 Base-Ri @II IS
-, =
<>‘ Pl.ane? = Unsuppress
-[[§ RibsE

Invert Selection

Annotations

[+ {[|] Cuk-Ex

b |Feature (CirPattern1)
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4 Review Study 2.

m  Review Study 2. The material and Load/
Fixture information from Study 1 is copied to
Study 2. Since the geometry changed, Mesh
the model and Run the analysis again.

5 Mesh the Model.

®  Click the Run drop-down arrow
from the Simulation tab in the
CommandManager.

m  Click Create Mesh .

m  Click OK to the message,
“Remeshing will delete the results
for study: Study 2.” The Mesh
PropertyManager is displayed
suggesting Global Size and

Tolerance value.

Analysis 2 - Static Study 2

SolidWorks Simulation

? A study 2 (-Simulation_Criginal_Design-)
.+‘ % Parts
= ﬁ; Connections
(7} & Component Conkacks
(=] g:fFixtures
B On Cylindrical Faces-1 (;variable:)
(= é| External Loads
L Pressure-1 (21500 psit)
% £ Mesh
= :‘1] Report
= E] /i Resulks
@ Stressl {-vonMises-)
ﬁl Displacement] {-Res disp-1
&E Strainl {-Equivalent-)
&‘T‘ Factor of Safetyl {-Max von Mises Stress

1 E Remeshing will delete the results For study: Study 2,
L

—> o J[ comeel |

&
Run | Results Coﬂare
Advisar Results

@ Run 1
g Run Design Scenarios

& Create Mesh
Run All Studies
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6 Start the Mesh Process.
®  Check the Mesh Parameters box. View your
options.
B Check the Run (solve) the analysis box.

m Click OK from the Mesh PropertyManager.
Meshing starts and the Mesh Progress window
appears. View the results in the Graphics area.

7 View the Results Folder.
®  Expand the Results folder.

SolidWorks Simulation

R
'-Mesh Density

B J

Coarse Fine
-E].I*;Ie-sh Parameters
(%) standard mesh

=

|

(O Curvature based mesh

A [ 11.3796256¢ v =

A [ o0sssssizar v 4|
H W Ve : 3|

|:| Autamatic transition

_Advanced A
Jacobian points [4 paints v

[Cloraft Quality Mesh

[ automatic krials for solid

0 Remesh Failed parts with
incompatible mesh

-3

DOptions
0 Save settings without
meshing

I%Run (solve) the analysis

? Study 2 (-Simulation_Original_Design-J
+‘ % Parts
= ﬁ; Connections
= @ Component Contacks
# Global Contact {-Bonded-)
= g:\sFixtures
B On Cylindrical Faces-1 (;variable:)
(= );] External Loads
LU Pressure-1 (31500 psit)
% Mesh
1 [&| Report
Results|
@ Stress1 (-vonMises-)
@l Displacement] {-Res disp-)
@E Strainl {-Equivalent-)

@ Factor of Safetyl {-Max von Mises Stre

Analysis 2 - Static Study 2
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Note:

View the von Mises Stresses Plot.

m  Double-click Stress1 (-von Mises-). The von
Mises stress plot is displayed. View your
options.

m  Click OK from the Stress Plot
PropertyManager. View the results in the
Graphics area.

SolidWorks Simulation

@% Parts

= ﬁ; Connections

E| g:f Fixtures
= {g External Loads

% Mesh

? Study 2 (-Simulation_Original_Design-J
EI & Component Conkacks

%'j‘ Global Contact {-Bonded-)
i B On Cylindrical Faces-1 (;variable:)

- L Pressure-1 (:1500 psit)

Results may vary depending on mesh type, system I [ Stress1 (-vonMises-) €—
setup and system options. R ey

[+ [E Repork
[Results

he Strain (-Equivalent-)
i a‘ Factor of Safetyl {-Max von Mises Stre

msoumlﬂe Edit View Insert Tools Simulation Window Help Qll:‘]v P - = @ 22

Es iE ?; h =S E Design Insight |

Study = Fixtures External Connections Run | Results Ay
advisor | PP advisor Loads..  Advisor Advisor EEERme e N Sk fucd= ¥ 2
Material Result  Results
Assembly | Layout | Sketch | Evaluate | Office Products | Simulation | von NiEedHlimey 2P ST
Nz |%] o | Model name: LBVEASEY %5 @ (- (- 60 - @ B Ebar aso
(F ] Study name: Study 2
- Plat type: Static nodal stress Stresst 273204
=% (f) CH End Cap - 300m STE »
[%8] Mates in LBV_ASSY | 248543
S
: . s | 224.002
(W ' _ 189356
Ct;*StudyE (-Simulation_Original_De: | isin
% Parts n
ﬁ; Connections ;] 150.085
é Component Contacts
Z 125418
y:_f Fixtures
o Ej On Cylindrical Faces-1 (wva _ 100773
B@ External Loads
P ks LU Pressure-1 (1500 psiz) | 7627
iresh 51431
26835
i ftressl (-vonMises-) 5189
wDispIacementl (-Res disp- ]
E Strnind ¢ Fruiualent-) “Isometric

MMGS «  [7] 2 |
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Note:
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10

View the Factor of Safety.
B Double-click Factor of Safety1 (-Max

m Rotate the model to view the blue surface.

von Mises Stress-).

The blue area displays a FOS above 1.

The minimum FOS is now 1.04.

Compare Study 2 to Study 1.

Click Isometric view from the
Heads-up View toolbar.

Click (f) View Port in the
FeatureManager.

Hold the Ctrl key down.

Click the second CH End Cap - 300mm
component. Both components are
selected.

Release the Ctrl key.

Right-click Hide components from
the Context toolbar.

Double-click Factor of Safety1 (-Max
von Mises Stress-).

Click OK from the Factor of Safety
PropertyManager. The two components
are hidden in the Graphics area. View the
single CH End Cap.

SolidWorks Simulation

= L] External Loads

| Results

LU Pressure-1 (31500 psis)

@ Stress1 {-vonMises-)
ﬁl Displacement] {-Res disp-
&E Strainl {-Equivalent-)
ﬁ‘ Factoy, of Safety1 {-Max von Mises Stress-)

1

R >
f? s ]
@ LBY_ASSY (Simulation_Original_Design< <
!-ﬂ Sensars
[+ @ Diesign Binder
(£ lil Annokations
\<§\ Front
& Top
%> Right
I.. Crigin
8, {-) Suppert Tube <13 (COSMOS)
By (F) FLOAT4s <1 =
=] % (F) Wiew Port, Acrylic 150m<1> == {
+ %8 (F) CH End Cap - 300m STED-no tab-r:
W () ML304-Bl=
Wy () ML303Bl=
8 () Backplnt <1 > (Dafault)
& (=) Aft Floatation=1 > (Default)
&, (-) Float-Plastic Frame =3 (Default)
8 (-} Float-Plastic Frame <1 (Default)
N\?] (=) Bumper Side, Rlackic DEGE _.1_ T,
@ () umper side, ¥ B |86 19
W (-1 Handle, LBV <1 8 @
8y (- CHEnd Cap -
R Y- CH End Cap - St

I:_*;f: @@ MateGroupl D&

Hide compor

Invert Selection)

[+ 3] Report
= é] Results

@ Stress1 (-vonMises-)
w Displacement (-Res disp-}
&F Strainl (-Equivalent-)

ﬁslfj:i;or of Safety1 (-Max von Mises Stress-)
1
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m Rotate the model and view the results.

m Click Compare Results from the By Desion insight
Simulation tab in the CommandManager. The compare |y PlotTook  ~

Results

Compare Results PropertyManager is displayed. NG Report
Both Study 1 and Study 2 are checked. :

Compare Results
Lt Compares mulkiple results side-by-side.

m Click the Manually select results to view box. s
SEEe |

m  Un-check the Displacement1 and Strain1 box
under Study 1.

B Check the Stress1 and Factor of Safety1 box
under Study 1.

B Check the Stress1 and Factor of Safety1 box

« R

Options ~

o) Compare selected result
across studies

under Study 2. ek
. o Manually select results to
m Click OK from the Compare Results C&view
PropertyManager. View the Graphics area. The Stress A
. . [ bisplacement1
two Studies are displayed. ® ot
Factor of Safetyl

= Study 2
Stressl
[ bisplacement1

| Factor of Safetyl:

Use settings from this
[ plot For plats of the same
bvpe:

—_————
| Study 1::5tress1 w
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SolidWorks Simulation

ven ises (w2 ()

s

B Click the Exit Compare button
in the Compare Results dialog
box.

m  Click the Study 2 tab if
needed. Study 2 is displayed in
the Graphics area.

®  Double-click Stress1 (-
vonMises-) from the Results

folder. View the Graphics area.

®  Click the Model tab at the
bottom of the Graphics area to
return to SolidWorks and to
displayed the Assembly
FeatureManager.
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? Study 2 (-Simulation_Original_Design-
% Parts

E| ﬁ; Connections

: EI &Component Contacts

E] g:f Fixtures

o B On Cylindrical Faces-1 {;variat
E| @ External Loads

L Pressure-1 (11500 psit)

i % Mesh

{E Report

awement1 {-Res disp-)
[ straini (-Equivalent-)
: @ Factor of Safetyl {-Max von I
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Click (f) View Port in the
FeatureManager.

Hold the Ctrl key down.
Click the second CH End Cap
- 300mm component. Both
components are selected.
Release the Ctrl key.
Right-click Show

components from the
Context toolbar. The

components are displayed in
the Graphics area.

11 Return to Study 1.

Clle the Study 1 tab at the <[0T [_Model [ Motion Study - Default | &, Stugy 1 Study 2
. SolidWorks Premium 2012 x4 Edition
bottom of the Graphics area.
Study 1 is displayed.
Double-click Stress1 (-vonMises-) from the B
Results folder. View the Graphics area. © [l A\ Results
. tressl {-vonMises-
Click OK from the Stress Plot Rl Diplacemehil CRes i)
[ Straint (-Equivalent-
PropertyManager' Eg‘ Factor of Safetyl {-Max von Mises Stress-)
Click Compare Results from the S W Xeep—
Simulation tab in the CommandManager. The Deformed Compare [y PlotToos -
Compare Results PropertyManager is et RS @ eport
displayed. Simulation
Click the Manually select results to view ‘Compare Results
box. < X
Un-check the Displacement1 and Strain1 box [aptions al

under Study 1.

Check the Stress1 box and Factor of Safety1

box under Study 2.

Click OK from the Compare Results
PropertyManager. View the Graphics area. The

two Studies are displayed.

Analysis 2 - Static Study 2

SolidWorks Simulation

%8, (-) Suppart Tube <1 (COSMOS)

B, (F) FLOATs<1>

& F) View Part, Acrylic 150m < . |
-8 (F) CH End Cap - 300m STED-na tab

By (-) ML304-B<1 >

Wy () ML303Bl

W, (-) Backplnl <1 (Default)

Wy (- At Floakation=1: (Default)

& (-} Float-Plastic Frame <33 {Default]

8 (-} Float-Plastic Frame <1 {Default]

& (-} Bumper Side, Plastic BEvh=1 = (T bl

T (-} Bumper
& (-) Handle,
& (-) CHEnd

B |

+ @@ MateGroupl

Side, Plal ¥ (45 @“g S [y BF
Bv<t>| @ K
Cap - 30]

t& Invert Selection

o) Compare selected result across
studies

o) Wiews multiple resulks of current
study

(&) Manually select results to visw

Stressl ~
[ bisplacement1 i
[ straint

Factor of Safetyl

udy 2

Stressi

Displacement 1

Strainl

0 Use settings from this plot For
plots of the same bype:

| Study 1::5kress1 w
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SolidWorks Simulation

m  Click the Exit Compare button in the Compare Results dialog box. Study 1 is

displayed in the Graphics area.

Modelnae: LBY_ASSY Modelname: LBY_ASSY

Stusy nane: Sty 1
Plttype: Steic nodel stress Siress 1 Pt type: Staic noal sress Sresst

w0262
asses

z 7
R osee

=
-
| s
e
s
e

| 179657

134880

s
l —
.
e
i
s

7127

Er
25835
2189

12

Note:
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Save and Close the Model.

m  Click Save .

m Click File, Close from the Menu bar menu.

Your design goal is complete. The structural ribs in the
EndCap provided an FOS greater than one.

lFHE Edit View Insert

| Mew...

: L‘} Open...

7 | Close <4+—

Analysis 2 - Static Study 2
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SolidWorks Simulation Conclusion

During this short session on using SolidWorks Simulation, you have had a brief
exposure to the main concepts of static analysis. Integrated within SolidWorks 3D
mechanical design software, SolidWorks Simulation allows you to update all of
your design changes automatically and to become immediately productive using
familiar SolidWorks functions and commands.

Compare alternative designs easily and quickly. SolidWorks Simulation lets
you study different design configurations created with SolidWorks software and
choose the optimal design for final production.

Study the interaction between different assembly components. SolidWorks
Simulation provides powerful tools for you to study and optimize assemblies.

Simulate real-world operating conditions. SolidWorks Simulation includes
several types of loads and restraints as well as part-to-part contact to represent
real-life situations. All loads and restraints are associative with the geometry and
automatically update with changes in your design.

Automate analysis tasks. SolidWorks Simulation utilizes a number of
automation tools to simplify the analysis process and help you to work more
efficiently.

Interpret analysis results with powerful and intuitive visualization tools.
Once you have completed your analysis, SolidWorks Simulation offers a variety
of results visualization tools that allow you to gain valuable insight into the
performance of your models.

Collaborate and share analysis results. SolidWorks Simulation makes it easy
for you to collaborate and share analysis results effectively with everyone
involved in the product development process.

SolidWorks Simulation Conclusion 59
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SolidWorks Simulation Professional

When you complete this chapter, you will have experienced the power and
capabilities of SolidWorks® Simulation Professional, including:

Notes:

The benefits of Thermal analysis, Drop Test, Optimization, and Fatigue
analysis.

The ease of use of SolidWorks® Simulation Professional to explore design
iterations using Trend Tracker.
The steps for performing upfront analysis on your designs.

The integration between SolidWorks® Simulation Professional and
SolidWorks.

The results of cost savings by avoiding field failures and eliminating the
prototype bottleneck.

The ability to document your analysis findings automatically.

The method to update your assembly based on the analysis results.

Time: 35 - 40 minutes
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SolidWorks Simulation Professional

In the first part of your analysis, you utilized SolidWorks Simulation to perform
two static analyses on the Housing. Next, you will use applications available in
SolidWorks Simulation Professional to continue your investigation. SolidWorks
Simulation Professional combines all of the features of SolidWorks Simulation
plus additional software analysis applications. SolidWorks Simulation
Professional includes:

Static analysis of parts and assemblies

Drop Test simulation

Frequency and Buckling analysis

Fatigue analysis

Optimization performance

Pressure vessel analysis

Thermal analysis

Trend Tracker to document design iterations

In this second part of your analysis, you will perform the following studies:

62

Thermal analysis to determine the heat dissipation from the EndCap
surrounded by seawater.

Drop Test simulation of the Housing from a height of four feet.
Optimization to find the best combination of EndCap thickness and Rib
thickness to minimize the mass.

Fatigue analysis on the 3 Finger Jaw.

Housing 3 Finger Jaw

SolidWorks Simulation Professional
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Trend Tracker Analysis

When you complete this chapter, you will have
experienced the power and capabilities of the
trend analysis feature inside SolidWorks
Simulation Professional.

B Trend analysis allows you to track the
changes that were made to your designs in a
systematic way.

m It helps you to compare the various design
changes and understand why and how your
changes were better or worse than your
previous designs.

m [t provides complete and automated
documentation of the analysis changes
throughout your design cycle.

You will start by performing a trend analysis on
the housing components of the SeaBotix LBV 150
assembly. This is the same assembly that you
analyzed before using the static analysis feature
inside SolidWorks Simulation.

Trend Tracker Analysis

SolidWorks Simulation Professional

Unit gypstem

@ 51 [MKS)

() English (IPS)

) Metric [G)

Units

Length/Displacement: mm -
Temperature:
Angular velocity:
Prezsure/Stress: N 2[MF +

? Trend_Study (-Default-)
|$_| % Parts
= ﬁ; Connections
(7} & Component Conkacks
(= g:fFixtures
Ej Restraint-1 {:variable:)
(= g External Loads
LU Pressure-1 (:1500 psis)
[+ |£ Trend Tracker (-Iteration 2-)
% Mesh
= El Results
5
. & Displacement] {-Res disp-1
& Strainl {-Equivalent-)

O

Time: 15 - 20 minutes
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Note:

Note:

Note:
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Open the Housing_Assy
Assembly.

m  Click Open from the
Menu bar toolbar.

B Double-click the LBV_Assy
from the
SeaBotix\SolidWorks
Simulation
Professional\TrendTracker
folder. The LBV _Assy is
displayed.

View the Trend_Study tab in the
bottom section of the Graphics
area if SolidWorks Simulation is
active.

If required, activate SolidWorks

Simulation. B 57 [Elz\ 1By assv.sipasM
EI Options
m  Click the Options drop-down Custortize...
dd-Ins. ..
arrow from the Menu bar toolbar. Beting 4
B Click Add-Ins. The Add-Ins dialog box =]
. . Active Add-ins [startup |
ls dlsplayed‘ E SolidWorks Premium Add-ins
B Check the SolidWorks Simulation box. ggﬂﬂ”ﬁs -
‘eatureWWorl [
m  Click OK from the Add-Ins box. ggl;:::x';; 0 N
D%’smud\nmrks Design Checker 0
. . [7] & solidworks Motion [}
You don't have to activate SolidWorks I g
. . . . . . . /| [ SolidWorks Simulation
Simulation if your SolidWorks Simulation is it el B
. 1 SolidWorks Toolbox Browser [
already added 1n. [ 32 solidworks Utiities ]
[F]  solidworks Workgroup PDM 2011 =]
[]  Solidworks Warkaroup PDM 2012 |
[C1ET Tolanalyst ]
B SolidWorks Add-ins
[[] Autotrace ]
[F]  SolidWarks Flow Simulation 2012 m
[7]  solidworks Part Reviewer ]
[[]  SolidWorks XPS Driver ]
i |
To display the Simulation Advisor
[+] Fun Simulation Advizor from C dkd [ d b tart
CommandManager, check the Run e e
ger,

Simulation Advisor box under
Simulation System Options.

SolidWorks Simulation

<« SolidWorks Simuletion Pr... » TrendTracker » e 2

New folder

4 Name E Date modified Type

t Favorites

[
B Desktop | Finished 8/21/2011 009 AM __ File folder
i Downloads “ LBV.ASSY. 10/16/2009 250 PM__ SolidWorks Asser
] RecentPlaces  |=
4 Libraries
[ Documents
& Music
5] Pictures
8 videos
3 Homearnun ad| n ]
Mode: Do not load hidden
components
: Simulation_ Original | Bl ot

File name: LBY_ASSY

Trend Tracker Analysis
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3 View the Trend Study FTTTe T Thoael T Moton Study - Defaull | W Trend fudy
®  Click the Trend_Study tab as EolidWorks Premium 2012 164 Edition X |
illustrated. The Trend_Study iS ?&Trend Study (-Simulation_Criging
displayed. = W parts

e [[¥j cH End Cap - 300m STED-nC

& [[¥j cH End Cap - 300m STED-nC

) ([¥ view Port, Acrylic 150m-1 (]
+ ﬁ; Connections

- b Fixtures
[#) ] External Loads
9 Mesh
+- [| Resulks
4 Perform an Analysis on the Study.

m  Click Run from the Simulation tab in the Conlz_%ﬁons Re%ts_ =
CommandManager. The analysis runs and Ad\,'sm . Ad\jsm A
three default plots are created. aluate [ Office Produds | Simulation

5 View the Von Mises Stress on the EndCap. T T T
®  The plot is displayed in the Graphics area. = Wparts
Double-click Stress1 (-vonMises-). The %E: E:: E:g ) 2EE$ ;gg:z
Stress Plot PropertyManager is displayed. & [P view Port, Acryic 150m-1 (]
View your available options. E_‘%E;:Sf;m”s

m  Click OK| ¥ | from the Stress Plot %;j:;”a' L

PropertyManager. = (i Results
6 Fit the model to the Graphics area. %_)
B Press the f key. [ Straint (-Equivalent-)

Tip:  To Zoom out, press the z key.

7 Hide all symbols. &
®  Click the drop-down menu from the Hide/ Show ~

items tool in the Heads-up toolbar as illustrated.

B Click the View Simulation Symbol icon to hide
all symbols.

Trend Tracker Analysis 65
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Note:
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m  Click the Update button. View

m  Click OK from the Probe

m  Click the Plot Tools drop-down arrow from the
Simulation tab in the CommandManager.

m  Click List Selected . The Probe Results
PropertyManager is displayed.

The On selected entities box is selected by default.

B Zoom in on the front hole of the EndCap as
illustrated.

m Click the edge of the front
hole of the EndCap. Note: The
icon feedback symbol of an
edge. Edge<1> is displayed in
the Results box.

the results. 0
\

Result PropertyManager.

SolidWorks Simulation

E Design Insight
Uy PlotToqu [
@3 | section Clipping
@' | Iso Clipping

_,/ Probe
—p ‘g | List Selected
@ Save As

B Animate

« ¥ 42

Options

b3

O ak lacation

qun selected entities

Results A

T ]

[CIFlip edge plat

Base-Revolve of CH End Cap - 300m STED-no kab-revf<l >

[~ Flip edge plot

L!Dﬂﬁ':e

Node [Value (N/mm~2 (WPa)
3366 452.397 T
232 366.270 ‘E‘
3369 532.819
233 466.749
3361 440.842
234 403.149
3356 441.939
235 364.080 i
4 |_ . | 3
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8 Fit the model to the Graphics area.

m  Press the f key.

SolidWorks Simulation Professional

@saunumxs jj Fle Edt Vew Insert Toos Smuaton Window Help ] lD B e AT, > P [ [
= d iﬂ 73 h — E Design Insight
Study A‘_I Fixtures External Connections Run | Results Debacd G Plot Taol = e
Advisor M PRY  Advisor Loads...  Adwisor Advigor -orormE - Rk
aterial Result Results
Assembly | Layout | Sketch | Evaluate | Office Products | Simulation | [ v Misss (B2
B |5 2, | e »| Modelname: LBV ASRY T W W (B (P 6o @ B B 532,819
(% Study name: Trend Study
W % Plot type: Static nodal stress Stresst 455.470 @
= ensors -
@ Design Binder . L4441 ﬁ
Annotati
nnotations _zmarmt [
T~ I . 385422
Ct*Trend Study (-Simulation_Crigina 31073 e
E| % Parts ﬁ
b
I CH End Cap - 300m STED- 266,724
I CH End Cap - 300 STRD- s
[ View Port, Acrylic 150rm-1
3 Connections L 178.026
-gCDmponentCUntacts s
Fixtures [ ’
B On Cylindrical Faces-1 (wva 809328
@ External Loads
A Pressure-1 (1500 psi) 44309
0630
¢ Trend Study |
Under Defined  Editing A bl MMGS - [F] !
Note: Study Advisor recommends study 1= mmwmme 9] [[ 75 Smumoadne 9
types and outputs to expect. Study x
Advisor helps the user to define ||| wetcomero sohworks i I
. ] udy
sensors and creates studies l | |2 souiez ana watsria
. || The Simulation Advisor helps L= 3 Interactions
automatically. pyermnemepooershy | YRR |4 WoshangRun ‘
[ 5 Results ‘
E For basic static studies of "
||| parts and assemblies, the e
§ | Advisor provides information | | Tohelp you create the proper
[= 1| and drives the interface to ﬁ study, select one of the
guide you through the F Tollowing:

Trend Tracker Analysis

simulation process.

The Simulation Advisor does
not support other types of
studies in this release. t also
does not provide access to
sorne features used in static
studies. To access full
functionality, use the
Commandianager, right
mouse clicks on tree folders
and features, or menus

Click here for online training on
Solichiorks Simulation Courses

Next

r Da not show me this
again.

| am concerned about
excessive deformation or
strasses.

| am concerned about the
3 effect of loadiunioad
cycles.

| am concerned about
sudden collapse under
cofmpression.

| am concerned about
excessive shaking.

| am concerned about
temperatures
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9 Invoke Trend Tracker. W‘_
m  Right-click Trend Study (- & @parts | & | B
. . . . = Z Conrec! Update all Components
Simulation_Origin_Design). T M |Emort.
®  Click Trend Tracker. The Tend Tracker folderis | affues—
. 8 ont s N e
displayed. S@eend | e
LU Pres
%Mesh Details...
[l [f] Result Properties. ..
[B str
& Disr Define Function Curves,
&Facl Rename

SolidWorks Simulation

10 Set a Baseline.
B Right-click the Trend Tracker folder.
m  Click Set Baseline.
m  Expand the Trend Tracker folder. View the created
graph icons.

Note: The current stress analysis will be the baseline to which
future designs are compared to.

Perform design changes to strengthen the End caps. View
how the new designs changes compare with the initial

= _i_] External Loads
LU Pressure-1 {:1500 psit)
'@ Mesh
[+ |£) Trend Tracker
=[] Results

= & External Loads
LU Pressure-1 {:1500 psi;

% Mesh
S

_ I_I Res Set Baseline
@ Stress[ é-vonMises-)

@ Mass1
@ Stressi

[ Displacement1

(Baseline) design in terms of: stress, displacement, etc. using the Trend Tracker

tool.

See how Trend Tracker allows you to perform design changes without creating

multiple studies or configurations.

In the next section, define a sensor. You define sensors to monitor result quantities
at a set of locations, mass properties of components or bodies, interferences

between components for assemblies, and dimensions.
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11 Add Sensors. TS T Woder Woton 5wy
®  Click the Model tab at the bottom of the Graphics

area. ST y
m  Right-click the Sensors folder from the (7~ ]
Assembly FeatureManager. ?g-w“fff_'”‘“‘a“n”-o”g'”a'-[’“
B Click Add Sensor. The Sensor PropertyManager : g 3——“[%55””'7
iS displayed, ] Motifications. ..
m  Select Simulation Data for Sensor type from e
g =N |
the drop-down menu. ——
m  Select NNmmA*2(MPa) for Units. ¥ % =
B Select Max over Selected Entities for Sensor Type 2
Criterion. B
m  Right-click Clear Selections in the selection ittt
box as illustrated. ”é:"‘""’""“—*
plswes -]
&
[ Use PSD Value
Properties A

E| Nfmm~2 (MPa)
@ Max over Selected St
Clear Selections

Del

@ Customize Menu

| Factor of Safety ¥

[ Alert ¥

m  Click the edge of the front hole of the
EndCap as illustrated. Note: The icon
feedback symbol of an edge. Edge<1> is
displayed in the selection box.

m  Click OK from the Sensor
PropertyManager.
B Expand the Sensor folder in the Assembly
FeatureManager. View the folders.
12 Return to Trend Study.
m  Click the Trend Study tab at the bottom of
the Graphics area.

- [p Stress1(532.819 N/mm*2
&l Displacementl (4.4339 mn|

@ @ Stress?
[+-€ Design Binder
Wotion Study - Detault Trend Stu
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13 Add a second Tracked Data Graph.

m Right-click the Trend Tracker (Baseline)

folder.

m Click Add Tracked Data Graph. The

Tracked Data Graph PropertyManager is

displayed.

m  Select Stress2 for Sensor Type from the
drop-down menu as illustrated. View your

options.

m  Click OK from the Tracked Data Graph
PropertyManager. The Stress2 folder is

displayed.

14 Perform a Design Change. Modify
the EndCap Part.
®  Click the Model tab at the
bottom of the Graphics area. The
Assembly FeatureManager is
displayed.
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% Mesh

&

= \_| Resi

.Ad Tracked Data Graph...

Manually add iterations

Wiews Gallery

Delete Iteration. ..

Restore Model ta Iteration)

?"'I'.rac.l-(ea bata ﬁrapil R
l.n_/‘? | Stress2 S ||

{Mass1
Stressi
Displacement 1

?.v

Ct* Trend Study {-Simulation_Original_|
= % Parts
e
[+
£
= ﬁ; Connections
e & Component Conkacks

= g:f Fixtures

[ & External Loads

% Mesh

=l l«L@ Trend Tracker (-Baseline-)

1 cH End Cap - 300m STED-]
1 cH End Cap - 300m STED-]
{7 view Port, Acrylic 150m-1

B On Cylindrical Faces-1 (v

LU Pressure-1 (31500 psis)

L}Ej Trend Journal

@ Mass1
@ Stressi

[ Displacement1

@ Stressz

[RISEIH]]_Model

Tiotion Study -

Default | 3 Trend Study

SolidWarks Premium

12 64 Edition
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m  Expand the first CH End Cap - 300m
STBD from the FeatureManager as
illustrated.

® Right-click CirPattern1.
®  Click Unsuppress from the Context

toolbar. The Housing with the ribbed End
caps is displayed in the Graphics area.
15 Return to the Trend Study.
m  Click the Trend Study tab as the bottom
of the Graphics area.

16 Run an Analysis.

m  Click Run from the Simulation tab in
the CommandManager. Once the analysis
is completed, the plots under the Trend
Tracker folder are updated.

® View the Stress1 (-vonMises-) plot.

Trend Tracker Analysis

SolidWorks Simulation Professional

= (A
3=
&
&
&
L
65
&
ERE
g
= &

58 (F) view Part, Acrylic 150m<13-3? (C
=% (F) CH End Cap - 300m STED-no tab-re]
(3] sensors

# % () CHER
[+ @@ MateGrauy

Annotations

Material <not specified =
Plane1

Planez

Plane3

Crigin

Basef [ (18| §
ase

Ribs Em___IUnsuppress ||

cut-f B | Invert Selection

Plane

Feature (CirPatternl})

[alg]
Compare
Results

Results
Advisor

Run 1
Run Design Scenarios
Create Mesh

Run &l Studies

(T~ )
Ct* Trend Study {-Simulation_Original_|
= % Parts
[ cH End Cap - 300m STED-r
& [ cH End Cap - 300m STED-r
& [ view Port, Acrylic 150m-1 {
1= TZ Connections
W &Component Contacts
= g;fFixtures
E] on Cylindrical Faces-1 (iva)
(= 3] External Loads
- Pressure-1 (:1500 psit)
g Mesh
= Li@ Trend Tracker {-Iteration 2-)
@ Trend Journal
- @ Mass1
K Stressi
@ Displacement1
E StressZ
=[] Results
gt vorlises-}
TR Displafferent {-Res disp
&EStra\nl (-Equirvalent-}
& Displacement1{1} (-Di
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17 Examine the total mass of the

EndCap Part.

m  Double-click the Mass1
folded as illustrated. The
total mass increase from the
first iteration to the second
iteration due to the addition
of the ribs.

Note: The additional weight is
expected to increase the FOS.

m Close the graph.

18 Examine the Stress1 graph.
m  Double-click the Stress1
folder. View the results.

Note: The maximum von Mises stress
in the hole has decreased due to
the addition of the ribs.

m Close the graph.

File Options Help ;i

SolidWorks Simulation

(=t |l~_9 Trend Tracker {-Iteration 2-)

@ Trend Journal
£
[ stredhl
@ Displacement1
@ Stressz
- % Mesh

(=t E Results
@ Stress1 (-vonMises-)
&l Displacement] {-Res disp-)
&E Strainl {-Equivalent-)

Mazs1 [ka)
I
@
=)

0.0

Iteration

Mass1

File Options Help

600.00

72

o
=]
=]
8

400.00

won Mises (Nfmm®2 [MPa||

300.00

200.00

lteration

—— von Mises

0.0
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19 Review the Trend Journal.
®  Double-click the Trend Journal folder. The Trend |
Journal is displayed. The journal contains all details :

about the different iterations that were performed on

the model.

SolidWorks Simulation Professional

= L.E) Trend Tracker {-Iteration 2-)|

m Mas
E Stressi

[ Displacement1

- E Stressz

m Close the Trend Journal by closing Microsoft Word.

Using Trend Tracker, you can also roll back your model to
an intermediate iteration without having to save any

conceptual changes. Trend Tracker is also integrated with
Design Scenarios in SolidWorks Simulation Professional

to track structural feature changes.
20 Save and Close the Model.

m Click Save [H]

m Click File, Close from the Menu bar menu.

Trend Tracker Analysis

Trend Journal

File Name: LBV_ASSY
Smdy name: Trend Study
Description:
Baseline
Time Completed: ~ Saturday. October 15, 2011 5:02:10 PM
Tracked Data:

: | . = Normalized

Source Type Actual Value Value
Mass1 Model Max 4.05904 (kg) 100
5 /mm™2

Stress] (VON: von Mises Stress) [Model Max f.:é;i)l)g (Nimm™2 ) 5
Displacement1 (URES: Resultant
Displa 1) Model Max 4.4339 (mm) 100

i " . Max over Selected|532.819 (N/mm"2
Stress2 (VON: von Mises Stress) [Entities (MPa)) 100

Iteration 2

Time Completed: Saturday, October 15, 2011 5:07:11 PM
Tracked Data:
Source Actual Value
Mass1 Model Max 5.16175 (kg) 127
"2
Stress] (VON: von Mises Stress) Model Max égg[;;?)g (Mimm"2 |5
Displacement] (URES: Resultant p
Displa 1) Model Max 4.43571 (mm) 100
. . Max over Selected|258 487 (N/mm"2
2 -
Stress2 (VON: von Mises Stress) [Entities (MPa)) 48
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Thermal Analysis

Design performance can be compromised due to excessive temperatures or heat
transfer between components. SolidWorks Simulation Professional allows you to
perform thermal analyses with the following parameters:

Conduction, convection, and radiation

Steady state and transient with time-dependent loads
Temperature-dependent materials and loads
Temperature, heat flux, and heat power

Thermostats for closed-loop feedback in transient studies
Thermal contact resistance

You will again perform an analysis on the EndCap of the Housing. The Housing
contains the camera and lighting system of the SeaBotix LBV 150 assembly. The
EndCap analysis will determine the amount of heat lost to the surrounding
seawater. You will only address natural convection today. To simplify the model,
the camera and lighting system are represented as a concentrated heat source.

Your design goal is to improve the thermal distribution of the EndCap. You will
learn if the addition of Ribs, “mass,” will help to dissipate the generated heat from
the camera and lighting system to the surrounding seawater.

Without Ribs With Ribs

Time: 10 - 15 minutes
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Create the Thermal Analysis Study

1 Open the EndCap Part. — /1 —
= Click Open ] from the ] T
Menu bar tOOlbar. f::u \tupa: ) L E dCap\ 10/23/2010816PM  SolidWor
B Double-click EndCap from — ‘
the SeaBotix\SolidWorks ol
Simulation B
Professional\Thermal folder. T — »
. . “
Note: Files of type is Part. The EndCap e B .
is displayed in the Graphics area. s I
2 Create a Thermal Study.
m  Click the Simulation tabin || & = M
the CommandManager. fiine
: Q%..Study Advisor luate | DimXpert | Office Products | Simulation
-=-|~ Q Mew Study = I
m  Click the Study Advisor
drop-down arrow from the Simulation tab. ¢ X
®  Click New Study . The Study PropertyManager Message A
is displayed. oy g de bt o
m  Enter Thermal-Study 1 for the name of the Study. canvectian and radiation
m  Click Thermal |« | for Type. ”a'“e| ThI-Stdl 7
3 Display the Study. 2L
. Type A
m  Click OK from the Study PropertyManager. %-l .
|@| Frequency
|§| Buckling
Thermal
|§| Drop Tesk

Thermal Analysis

SolidWorks Simulation Professional
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Applying the EndCap Material.

SolidWorks Simulation

@l Thermal-Study 1 {-Default-)
1 Apply the Material of the EndCap. %c o
m  Click EndCap from Thermal-Study 1 2R Thermal Loads
(-Default-). Totect
®  Click Apply Material from the o - 3 1 T
Simulation tab in the S| e Tl i e
CommandManager. The Material T s —
dialog box is dlsplayed View your Features | Sketch | Evaluate | DimXpert
options.
m  Click AISI 1020 from the Steel folder.
m  Click Apply.
®  Click Close from the Material dialog box.
i X
= ig_il Salidworks Materials - Propetties .VTables&Curves Appearance CrUssHatEhr Custumr Application Data |F ¢ *

= =] Steel
3= 1023 Carbon Steel Sheet (S5)
3= 201 Annealed Stainless Steel (55)
§E AZEE Iron Base Superalloy
$= AISI 1010 Steel, hot rolled bar
§- AISI 1015 Steel, Cold Drawn (S5)

Material properties
Materials in the default library can not be edited, ¥ou must first copy the material to
a custom library to editit,

|Linear Elastic Isotropic

[51-Nm~2 pay

I 1020
k‘ 020 Steel, Cald Ralled —
3= AIST 1035 Steel (55) | |41
3= AIST 1045 Steel, cold drawn -
3= w151 304

§E AISI 316 Annealed Stainless Steel Bar (35
E AISI 316 Stainless Steel Sheet (S55)

§E AISI 321 Annealed Stainless Steel (35}
§E AISI 347 Annealed Stainless Steel (553 . [oefi
§E AISI 4130 Steel, annealed at 5852
§E AISI 4130 Steel, normalized at S70C

3= chrome Stainlsss Steel
3 e

e Property Walus Lnits -~
gf ARG EE L e Elastic Modus Jermi1 N2 i
§= A15T 4340 Steel, normalized Lo 028 M
§E AI5I Type 316L stainless steel Shear Madulus 774010 M2
$= AISI Type A2 Tool Steel Densiy 7800 kam’3
3= alloy Steel Tensile Strendth 420507000 Min"2
§E Alloy Steel (S5) Compressive §treng{h in ¥ Mim*2
$= asTH A36 Steel ield Strength 351571000 Min2
SE Cast alloy Stes! merm_a: Expa:niunfuefﬁc_ierﬁ le-ODS »J!:”( o

— ErimEl Conciuctiv -
gf SR Specific Hest = 420 Wker )
4= Cast Stainless Steel Meaterial Diameinn Retin hia, &

Note: A green check mark on the Parts folder indicates that
material is assigned to the part.
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Qﬂ Thermal-Study 1 {-Default-)
[P Endcap (-a151 1020-)
ﬁ; Connections
'fﬂ Thermal Loads

% Mesh
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Thermal Loads and Boundary Conditions

Thermal loads and restraints are only available for thermal studies. For steady
state thermal studies with a heat source, a mechanism for heat dissipation must be
defined. Otherwise, analysis stops because the temperatures increase without
bound. Transient thermal studies run for a relatively short period of time and thus
do not require a heat dissipation mechanism.

You will assume natural convection for the EndCap. You will apply a 600 watt
power load to the system to simulate the heat load generated from the internal
camera and search lights.

The following types of loads and restraints are available for thermal studies:

, Load Type Geometric Entities Reference Geometry Type Required Input
Temperature Ve = e a
ertexes, Edges, Faces an
companents (2178 Unit and ternperature value
| Film coefficient and bulkc
| Convection Faces (2178 termperature in the desired
units
Unit and value of the
Radiation B N surrounding ternperature,
emissivity, and view factor for
surface to ambient radiation
Unit and value of the heat fl.x
Faces and an optional vertex for (heat powerfunit area)
Heat Flux thermostat location for transient IfA, Temperature range for optional
studies thermostat for transient
studies
Unit and value of the heat
Verexes, Edges, Faces, Components, pnvx;erd'trhe spheclﬂ‘edtvadlue ‘ts
Heat Power and an optional vertex for thermostat (R17:Y EIARE Rl el Rl
Incation for transient studies S T R
thermostat for transient
studies

Thermal Loads and Boundary Conditions 77
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Applying a Thermal Load

1

Note:

78

Apply a Thermal Load.

m  Click the Thermal Loads drop-
down arrow from the Simulation
tab in the CommandManager.

m  Click Heat Power . The Heat

Power PropertyManager is
displayed.
Select the Face.

B Zoom in on the inside center hole face of

the End Cap.

m  Click the inside center hole face of the
EndCap as illustrated. Face<1> is
displayed in the Selected Entities box.
Note the icon system feedback symbol for

a face.

Enter Heat Power.

m  Select Sl from the Units drop-

down menu.
m  Enter 600 watts in the Heat
Power box.

600 watts is an estimate for the
total amount of power generated
by the camera and the internal
search lights of the assembly.

Apply the Values.

Click OK from the Heat
Power PropertyManager. Heat
Power-1 is displayed.

g | Convection

g Heat Flux
W& | padiation

& | Heat Power <4—

SolidWorks Simulation
8 73 & .
Thermal | Connections Run | Results . I
Loads | Advisor Advisor ST e
Results
E[%.Temperature 1 Office Products | Simulation

-R“
.

\

Sis @ee]
HeatPower 7

wer

« ¥ 42

(e 28]

Selected Entities A

Select all exposed
faces

@ Per item

Total

Heat Power A

A —>|

b3 Thermal-Study 1 (-DeFault-}
[P endCap (-A151 1020-)
i ﬁ; Connections

lj 'fﬂ Thermal Loads

; c’.Heat Power-1 {:Per item;

:- %Mesh

& [0 S—

[Creverse direction

| Symbol Settings ¥

£00 1)

Thermal Loads and Boundary Conditions
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Applying Convection

1

2

3 Select the other three exposed outside

Note:

Apply Convection.

m  Click the Thermal Loads
drop-down arrow from the
Simulation tab in the
CommandManager.

® Click Convection . The
Convection
PropertyManager is displayed.
Select the Exposed Faces.

B Rotate the EndCap with the middle mouse button as

illustrated.

®  Click the outside face of the EndCap. Face<1> is
displayed in the Faces for Convection box.

Faces.

B Click the other three outside faces of
the EndCap. Face<2>, Face<3>, and
Face<4> are displayed in the Faces for
Convection box. Rotate the model to

select Face<4>.

Apply the Zoom to Area tool from the
Heads-up View toolbar to select the correct

faces.

Thermal Loads and Boundary Conditions

SolidWorks Simulation Professional

5 | 1
Loads Advisor
I E%-'I:;amperature |

Thermal | Connections Run | Results .

B - s
=t Compare

Advisor Results

Office Products | Simulation

—.g I Convection

}. !Heat Pawer
g | Heat: Flusx

|
© | Radiation

Base-Revilve

Bk &mbient Tem)

Convection Coefficient (Wm"2 K

0

Base-Revilve

u
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Note:

Note:

80

Set Units and Value.

m  Select English (IPS) from the Units drop-down
menu.

m  Enter 0.22 in the Convection Coefficient box.

®  Enter 50 in the Bulk Ambient Temperature box.

The inputs simulate seawater conditions at the operating
depth of 3,400 feet.

Apply the Values.

SolidWorks Simulation

Type || Split
Selected Entities

i

=

Face<l=
Face<z>=
Face <

Select all exposed
faces

Units A

Convection Coefficient A

o
(022 e
[l | .

Bulk Ambient Temperature &

E L —MFahrenheit

| Symbol Settings ¥

m  Click OK from the
Convection PropertyManager.
Convection-1 is displayed.

Fit the model to the Graphics area.

m Press the f key.

SolidWorks Simulation Professional
applies convection to the four
selected exposed faces and creates a
single entry. Convection symbols
appear on the four selected outside
faces.

QﬂThermaI-Study 1 {-Default-)
- [FEndcap (-A151 1020-)
. ﬁ; Connections

= 'fﬂ Thermal Loads

& Heat Power-1 {:Per item: 600 W)
ﬁ Convection-1 ;0,22 BTUf{s-in"2F ;)

- % Mesh

Thermal Loads and Boundary Conditions
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Creating a Mesh and Run an Analysis

1

Create a Mesh and run an Analysis.

Click the Run drop-down arrow

from the Simulation tab in the
CommandManager.

Click Create Mesh . The Mesh

PropertyManager is displayed

suggesting Global
Tolerance value.

analysis box.

Size and

Check the Standard mesh box.
Check the Run (solve) the

Start the Mesh Process.

Click OK from the Mesh
PropertyManager. You created a mesh
and the Thermall plot is displayed.

SolidWorks Simulation Professional

Results
Advisor

Run
| Run Design Scenariod
Create Mesh

| Run All Studies

& K

Mesh Density

3

& U

Coarse

Fine

— P hchraametes

3

——P>© Standard mesh

(") Curvature based mesh

5] PY—

A 0.2745553n  w [
=

e

0.01372777n ¥ |%
LR RRREEETITT

[] Automatic transition

‘ Advanced

£

Options

3

[ Save settings without
meshing

Etgaun (solve) the analysis

@SOUMRKS I File Edit View Insert Tools Simulation Window Help QlD - L% - H - ' T SO =]

~ -
Q = % LE
A ‘_I Thermal Connections Run | Results
Advisor PRY  Loads Advisor
Material

)

Advisor S

Deformed Compare
Results

m Plot Tools - @ Report

@ Indude Image for Report

Features | Sketch | Evaluate [ DimXpert | Office Products | Simulation |

S EIR e .

e 1 " +
T~ D,
@f Therrmal-Study 1 (-Default-)
B EndCap (-AIS1 1020-)

T2 Connections

Q---’}\EThermal Loads

i éHeatPower-l(:Peritem:t

laaaf

ﬁ Convection-1 (0,22 BTUA
%Mesh
é--@lﬂesults

W hermall [-Temperature

Model name: EndCap o4,
Study name: Thermal-Study 1

Plat type: Thermal Thermall
Time step: 1

i

?

(I S =

I\ MWE-T-o0-@ - B~

%

Temp (Kelvin)
E29.385
. f00.532
L 5T1.679

. 942826
. 9134973
. 485120

456 267
427 414
. 395.562
. 369.709

l 340.856

312.003
283150

SolidWorks Premium 2012 x64 Edition

1 1> T0[ _Model [ Mofion Study 1 [ % SimulationXpress Study | § Thermal-Study1 [

Editing Part

Custom +
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3 View the Thermal Plot.

m  Double-click Thermal1 (-Temperature-). The
Thermal Plot PropertyManager is displayed. View

the options.

m  Click OK from the Thermal Plot
PropertyManager.
m Right-click Thermal1 (-Temperature-).

m Click Edit definition. The Thermal Plot

PropertyManager is displayed.
4 Modify Temperature units.

m  Select Fahrenheit from the Temperature drop-

down menu.
m  Click OK from the Thermal Plot

PropertyManager. The Thermal Plot is displayed

in Fahrenheit.

m Rotate the model with the middle mouse button to

view the temperature profile.

Note: Note that the

SolidWorks Simulation

QﬂThermaI-Study 1 {-Default-)
[P Endcap (-a11 1020-)
ﬁ; Connections
= 'fﬂ Thermal Loads
é’ Heat Power-1 {:Per item; 600 W)
ﬁ Convection-1 ;0,22 BTUf{s-in"2F 1)
% Mesh
= E] Results
ﬁ hermall {-Temperature-

QﬂThermaI-Study 1 {-Default-}
[P Endcap (-a151 1020-)
ﬁ; Connections
(= ?E Thermal Loads
& Heat Power-1 {:Per item: 600 Wi}
ﬁ Convection-1 (10,22 BTUM{s-in"2F):)
% Mesh
[/ (i Results
i fhery

Hide

dit Definition. ..

D Bimate. ..

% Section Clipping. ..

X 42

Display ]

m i TEMP: Termperature i :

E| | Fahrenheit f'}:

PR Fahrenheit |

| Property ¥ !

maximum
temperature is
approximately
673°F.

Temp (Fahrenheit)|
E73.222
E21 287
. 969.352
. 91Ty
. 4654582
. 413546
| 361 611
. 309.676
L2577

. 205806

153.870
101.935
50.000
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Applying the Probe tool

1 Apply the Probe tool.

m  Click the Plot Tools drop-down
arrow menu from the
Simulation tab in the
CommandManager.

m  Click Probe . The Probe
PropertyManager is displayed.
The Probe tool provides the
ability to list the temperature at
a specific location in the model.

B Zoom in on the inside face as
illustrated.

B Click five points as illustrated
from top to bottom as
illustrated. The Probe box lists
the temperature and the X, Y,
and Z coordinates of the
selected vertices in the global
coordinate system.

Note: Results will vary depending on your selected position of

the EndCap.
2 View and close the Probe Plot.

m  Click Plot . The Probe Result window appears
with a graph of temperatures at the selected vertices
versus node numbers at the vertices. View the plot.

m Close the plot.

m Click OK in the Probe Result PropertyManager.
3 Fit the model to the Graphics window.
m Press the f key.

Thermal Loads and Boundary Conditions

SolidWorks Simulation Professional

B [@3 Plot Tools B
Compare @3 Section Clipping
Results @ﬂ Isa Clipping

simua 7 |Proved—
_}g List Selected
@ Save As

ftucy 1

- B> | Animate

= 435.261 Fahrenheit

[MeJiode 835A 1.0 192 0 503 0 594 in
{Hode 8365 (01930771 0. 554 in)
—
= fhlode 9367 (-0.122,0.901 0613 in)|
-

»

Options

(&) At location

() 0n selected entities

Results A

Mode |Value {Fahrenheit) ¥ {in

9435 603,362 129¢
9354 569,687 129¢
9353 577.074 1931
9360 538,401 1931
9359 500,186 1931

< | i
Repart Options A
) G ) L
Annotations [PIot A

Show Nade/Element.
Mumber

[¥]5how ¥,¥,Z Location
Show Yalue
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Modify the Design

In the first study, temperatures reaching
approximately 673°F on the center hole of the
EndCap were calculated using the supplied
Load information.

In this section, redesign the EndCap to use
ribs. The ribs will help to dissipate the heat
generated by the camera and search lights
within the EndCap to the surrounding
seawater.

Without Ribs
You will:

m  Unsuppress the rib feature in the EndCap
part.

®  Copy and paste the material and Load/
Restraint information from the first study
to the second study.

®  Mesh and Run the second analysis.

®  View the results of the second study.

®  Compare the first study to the second
study.

With Ribs
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Create the Second Analysis

1 Create Thermal-Study 2. | Renameg
. . Delete
u nght-Cth the Delete Al Simulaton Studies
ThermaI-StUdy 1 tab Create Mew Motion Study
at the bottom of the Create New Simulation Study
Graphics area as Create New Design Study
Stu
lllgstrated. . Define Study Name rz|
m  Click Duplicate. The 3 —
Thermal-Study 2 {-Default-) s
Define Study Name (%) Endcap (-A1st 1020-) |Thermal-8tudy21 |
dialog box is T2 Connections -
. = ’2‘8 Thermal Loads Configuration to Lise:
dlsplayed' 4 -c’.Heat Power-1 {:Per itemn: 600 W |Default v|
[ Enter Thermal_study : ﬁ Convection-1 (10,22 BTU{s-in"2
% Mesh
2 for new Study o (i) Results
= [ QK. [ Cancel ] [ Help ]
name. . N Thermall {-Temperature-)

m Click OK from the

. W4l el o [ Mgdel | Motion Study 1
Define Study Name dialog box. Thermal- bolidWorks Premitin 2012 x64 Edition
Study 2 is displayed. _
2 Add Ribs to the EndCap Part. RElEd® >
: €
®  Click the Model tab at the bottom of the i .
. % EndCap {Default<<Default=_Dis
Graphics area. (i) sensars
m  Right-click CirPattern1 from the @ gl_;l R
FeatureManager. % Plaret "
. = & Plane
®m  Click Unsuppress from the Context N .
toolbar. The EndCap with Ribs is displayed bor o
; : 62 B3 & | ‘F?@lc:ﬂ
in the Graphics area. D& L@
3 Return to Thermal-Study 2. E = lunsuppress}
®  Click the Thermal-Study 2 tab at the bottom i [ |G
of the Graphics area. % hy ;::;:;ncth"dm
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Note:

86

Review Thermal-Study 2.

m  Review Thermal-Study 2. The Thermal
information was copied from the first study to the

second study.

Analysis the Model.

m  Click Run [&] from the Simulation
tab in the CommandManager.
Thermall (-Temperature-) is
displayed. View the plot in the

Graphics area.

SolidWorks Simulation

Qﬂ A Thermal-Study 2 (-Default-)
[P endcap (-A151 1020-)
ﬁ; Connections
= 'fﬂ Thermal Loads
4 -&Heat Power-1 {:Per item: d
¥ Convection-1 (:0.22 BT

-%&Mesh
[+ @&Results
& w W
E Run | Results c @
Ly Advisor RDEH;E'?‘;E

nxpert | Office Products | Simulation

The addition of the ribs resulted in a temperature range between 50 and 329 °F.

@SOL]MRKS l Fie Edit View Insert Tools Simulaton Window Help & I O-&-EH-8.92 - = O :2

Material

~ =
= 8 73 &

Study A ‘_I Thermal Connections Run | Results

Advisor PRY  Loads Advisor Advisor

% Plot Tools - @ Report

@ Indude Image for Report

@f Thermal-Study 2 (-Default-)

B EndCap (-AIS1 1020-)

3 Connections

=] _EThermaILoads

. é Heat Power-1 (:Per iterm: £
5% Canvection-1(:0.22 BTUA
; %Mesh

E!{E_IResults

¥\ fThermall (-Temperature

Features | Sketch | Evaluate [ DimxXpert | Office Products | Simulation |
7 i @ Th W I
Model name: EndCap &4 & X8 m @' @' G ~ 9 ;%' Exf -
Study name: Thermal-Study 2
Plat type: Thermal Thermall

Time step: 1

N

W4 kM|l _Model | Motion Stud

SolidWaorks Premium 2012 x64 Edition

]

SimulationXpress_Stu

1] & Thermal-Study 2
Editing Part Custom «

I S =

Temp (Fahrenheit)

229710
. 306.400
| 283091
| 259782
| 236473
213164
[ mess
| 166545
143236
119927

96 615
l 73309
50.000

Modify the Design



SolidWorks Simulation SolidWorks Simulation Professional

6 Compare Study 2 to Study 1.

m  Click Compare Results | @ | from the
Simulation CommandManager. The
Compare Results PropertyManager is

m Plot Tools - w Report

@ Include Image for Report

displayed. Both Study 1 and Study 2 are

Compare Results

Checked, Compares mulkiple results side-by-side, )

m Click the Compare selected results
across studies box. Note: The Use settings from

this plot for plots of the same type box is selected.

m  Click OK from the Compare Results
PropertyManager. View the results. The two
Studies are displayed.

Modify the Design

Compare Results

@ R

Options ]

Compare selected result
/'6) across studies
o) Wiews multiple resulks of
current study

Manually select results to
o wigw

= Studies
Thermal-Study 1
Thermal-Study 2

Use settings from this plok
for plots of the same type:
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Note:
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Return to

m  Click the Exit Compare button. View Thermal-

Study

SolidWorks Simulation

([ SOLIDWORKS | Fle Edt Vew Insert Tooks Smuaton Window Hep & | O-2- 9. \ B SEE -

2 A Thermal-Study 1 (-Default-)
T EndCap (-A11 1020-)

-f1% Connections

=38 Thermal Loads

- Heat Power-1 (Per item: ¢
5% Convection-1 (0.2 BTU/|
Bp A Mesh

i1-{) A Results

[T 31| [_Model [ Wofion Siudy 1 | &% SimulationXpress_Study | 4 Thermal-Study1_[§ Th

= %8 [H B W& PotTools - G Report
).fﬂ:gr Appl T[‘i?j' o e :sj“;';f Deformed Compare B Indude Image for Report
Material Result Results
Features | Sketch | Evaluate | Dimxpert | Office Products | J SN G0 @ (P @ BB =
|2, |4 ] 5| Model name: EndCap
SrEikelel Study name: Thermal-Stucly 1 Temp (Fatwenheit)
& Pict type: Thermal Thermal2 (&
[, EndCap (Default<Copy of <Def{ Time step: 1 329710 | ]
il srece 306.400 al)
[@-[A] Annotations =]
= Material <not specified> | 283081
= Material pecified: =
) 258782 =
- Plane2 [ L!
&> Plane3 | 236473 =
L, Origin =]
i}-6f Base-Revolve 213115
%t Plane? | 183358
([ Ribs Extrude
- CirPatternl L 188545
i [@) Cut-Bxtrudel B
) Filletl
& Fillet2 L 1aazr
< i 3
T~

96,618
73309
50,000

Modiel name: EndCap
Study niame: Thermal-Study 2
Plat type: Thermal Thermali
Time step: 1

D 2012 474 Fition

Temp (Fahrenheit)
329710
l 306.400
L 28309
. 2ma7E
| 236473
L 213164
| 180855
| 166545
| 143236

| 119927

96518
I 73309
50.000

Study 2.

1.

Save and Close the Model.

m  Click Save .

m  Click Window, Close All from the Menu bar Arrange Icons

menu.

Windgw | Help & |:|v
Wigwport L4
EE e Window
Cascade
E Tile Horizontally
O3 | Tile vertically

__> Close all

You improved the thermal dissipation of the Endcap
by adding the Ribs. The Ribs added mass, which in
turned provided a better thermal load path to the entire part.

Modify the Design
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Drop Test Analysis

A Drop Test study evaluates the effect of the
impact of a part or an assembly with a rigid or
flexible planar surface. Dropping an object on
the floor is a typical application and hence the
name. The program calculates impact and
gravity loads automatically. No other loads or
restraints are allowed. The program solves a
dynamic problem as a function of time.

Will your Design Fail?

The study does not answer this question

. . . e e T A s
automatically. It can predict the separation of ef&%z&{ﬁ%ﬁ%%’#m,
: : R A AT
components due to impact. You will use the S

results to assess the possibility of such an event
occurring. You will use maximum stresses to
predict material failure and contact forces to
predict separation of components.

X ‘_L'L
ARV il
o P T

‘ﬁﬂg' g!‘"

Perform a Drop Test analysis on the Housing
component.

O

Time: 20 - 25 minutes

Drop Test Analysis 89
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Creating a Drop Test Study
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1 Open the Housing Assembly.

m  Click Open from the
Menu bar toolbar.

B Double-click the
Housing_Assy assembly
from the
SeaBotix\SolidWorks
Simulation
Professional\Drop Test
folder. The Housing is
displayed in the Graphics
area.

2 Create a Drop Test Study.

m  Click the Study Advisor
drop-down arrow from the
Simulation tab in the
CommandManager.

m  Click New Study . The
Study PropertyManager is
displayed.

®  Enter Droptest Study 1 for
Study Name.

®  Click the Drop Test
button for Type.
3 Display the Study.

Click OK[#] from the Study
PropertyManager. Droptest Study
1 (-Default-) is displayed.

SolidWorks Simulation

<< SolidWorks Simulati... » Drop_Test »

1 & Study Advisor

Q |
Study | Design
Advisor | Study

ketch | Evaluate

Office Products

Simulation

Q Mew Study

\\I

$ Droptest Study 1 {-Default-)
I+ % Parts
= ﬁ; Connections
= & Component Contacks
% Mesh
w Setup

- @ Result Options

wxwwm

Message 3

Study stresses, deformation,
strains, velocity and acceleration
time histories in an object dropped
orto a floor

Mame i

[oeponsuor |

Type o
|§| Static

Ig'l Frequency

Ia__él Bucking

IQ:M ]

|j‘ 4 Drop Test
|&brop Test
|§| Monlinear

|@| Linear Crynarmic

|§| Pressure Yessel Design

Drop Test Analysis



SolidWorks Simulation

4 Setup the Drop Test Study.

m  Right-click the Setup folder as illustrated.
Click Define/Edit. The Drop Test Setup

PropertyManager is displayed.

Check the Drop height box.
Select ft for units from the drop-
down menu.

Enter 4 in the Drop height from
centroid box.

Click inside the Gravity box.
Expand the Housing_Assy
flyout FeatureManager from the
Graphics area.

Expand the second CH EndCap
component as illustrated

Click Plane3 from the flyout
FeatureManager. Note: Under the
second CH EndCap component.
Plane 3 is displayed in the
Gravity box.

Select m/sec? for the Gravity
magnitude units.

Click the Normal to gravity box.

Click the Rigid target box for
Target Stiffness.

5 Display the Study.

®m  Click OK| ¥ | from the Drop Test Setup
PropertyManager. Setup is displayed with a check

mark.

Drop Test Analysis

SolidWorks Simulation Professional

e
&

ﬁDroptest Study 1 {-Default-)
.+'| % Parts

= ﬁ; Connections

(7} & Component Conkacks

% Mesh

%’Eﬁéa}t. "

Details...

- —>¢ Drop height

() Velocity at impact

Height =

@) From centroid

() From lowest point

a 9.81

Target R
Target Orientation

— —»0 Mormal to gravity

() Parallel to ref. plane

s ]

=20
Target Stiffness

— —}-a} Rigid target
() Flexible target

Contact Damping

J“‘[n, 0

Symbeol Settings b I

£

[E
[

@ Housing_fssy (Default

2l Sensars

HE Annotations

2 Front Plane

=& Top Plane

_Q Right Plane

His Qrigin

- () View Port, Benic
-8 () CH End Cap - 300
38 ) CH End Cap - 300
EH@ rdates in Housing
HE] sersars
EHA] Annotations
= arsr020
8 Planel
—§ Plane?

B

—h Oriy\ﬁ
E]—Si'ﬁ Baze-ReNalve
‘\Q Plane?
Fr-TEY Ribs Extrude

—%} CirPatternl
EH[E) Cut-Extrudel

J—@@ Pates

(ﬁDroptest Study 1 (-Default-)

1+ % Parts

= ﬁ; Connections

% Mesh
? Setup

@ Result Options

& Component Contacks
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Meshing the Model
&

1 Mesh the model. T
m  Click the Run drop-down arrow menu from the s

S

Simulation tab in the CommandManager @ Run
Create Mesh
m Click Create Mesh . The Mesh 1 Run All Studies

PropertyManager is displayed.
B Check the Standard mesh box as illustrated.
m  Expand the Advanced dialog box.
B Check the Draft Quality Mesh box.

« R

i.Mesh Density

» |

Note: A coarse Mesh Factor will result in a faster mesh B J
time. Actual results will vary depending on Mesh Coa—se R
Fact;)r =
' _ ) Crr— A
2 Start the Mesh and Analysis Process. — P G standard mesh
m Click OK from the Mesh PropertyManager. Cinsusten mefh
Meshing starts and the Mesh Progress window Bl [ =

appears. After meshing is completed, a M | 1ser2ein S
checkmark is displayed next to the Mesh folder.

A | 0.s74aezeznr v 2
WL e |

|:| Autamatic transition

|»

_.Advanced

Draft Quality Mesh
[ automatic trials for solid

Remesh failed parts with
incompatible mesh

« |

| Options

o b L,
R R O Y
| VAA "‘:&'{;‘aﬂ"ﬂ
s Sy
[

o

war B |
EERE DAL
E r 1 LA
N R

$ Droptest Study 1 {-Default-)
1+ % Parts
[ ﬁ; Connections
[+ & Component Contacks
% Mesh
? Setup

@ Resulk Options
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Running the Analysis
Run the Analysis.

1

Note:

Click Run [&]

Click No in the Linear Analysis dialog
box to retain your element choice. The
analysis runs and the default plots are
created.

Run time will take approximately 15 - 30
seconds.

Review the Results Folder.

Expand the Results folder. The
Results folder contains three plots:
Stress, Displacement, and Strain.
View the Stress1 (-vonMises-) plot in
the Graphics area.

SolidWorks Simulation Professional

Run | Results '_ : . m @ a +
Advisor AMEpENT &k
Results

Evaluate | Office Products | Simulation i

Linear Analysis
2 DieFault lower-order tetrahedran may not give accurate results

o] Do you want to switch the element type from
default to enhanced tetrahedron?

Wes Mo [:

$Droptest Study 1 {-Default-)
E! % Parts
= ﬁ; Connections
(£ & Component Conkacks
g’ Setup
@Result Options
% Mesh
R SResults
B
: w Displacement] {-Res disp-)
& he Strainl {-Equivalent-)

Model name: Housing_Assy

Study name: Droptest Study1

Plat type: Stresst

Plot step: 25 time : 243.001 Microzeconds
Deformation scale: 1

won Mises (Minm-2 (MPa))

2,493 658
2,285 927

| 2078135

1 ETO4E4

1 EE2T32

| 145500
1,247 270
1,39 538

| E3.A07

| 624075

416344
208612
0851

Running the Analysis
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Set Scale Factor and View the von-Mises Plot.

Double-click Stress1 (-vonMises-). The Stress
Plot PropertyManager is displayed. View the
options.

Click OK from the Stress Plot
PropertyManager.

Right-click Stress1 (-vonMises-).

Click Edit Definition. The Stress Plot
PropertyManager is displayed.

Click Automatic in the Deformed Shape box.
Accept the default values.

Click OK from the Stress Plot
PropertyManager. View the plot in the Graphics
area.

SolidWorks Simulation

CﬁDroptest Study 1 (-Default-)
1+ % Parts
= ﬁ; Connections
[+ & Component Contacks
% Mesh
? Setup
@Result Options
= Pﬂ Results
ﬁ = IRessl -vonMises-
ﬁl Displacement] {-Res disp-)
. &E Strainl {-Equivalent-)

ﬁDroptest Study 1 {-Default-)
I+ % Parts
= ﬁ; Connections

e & Component Conkacks

- % Mesh
? Setup

@Result Options
[ [[] Results
-E‘Dis; Hide
Eop |l —————
Ty St EEit Definition. .
[ | dinate...

SIEEe)

« ¥ 42

Display "

& WOM: von Mises Stress hd

@ 243,001 microsec

> :

[¥| Deformed Shape

b3

@ Automatic

|j| 22.0803070

() True scale

() User defined

o |

i Property

«
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Animating the Plot
1 Animate the Plot.

@y Fiot Toos 7\

@3 | Section Clipping

m  Click the Plot Tools drop-down arrow menu from M | 1:0 Cliping
. . . | | Probe
the Simulation tab in the CommandManager. - g :Est e
® Click Animate . The Animation Ei::a:

PropertyManager is displayed.

m  [fneeded, click Play El to start the animation.
View the animation in the Graphics area.

m  Click Stop El to stop the animation.

»

Message

Creation of Frames Completed
Plavying Animation. ..

Basics &

von Mizes (Nmm*2 (MPa))
2,493 855
l 2,285.927
. 2078185
. 1,570.464

. 1.BE2FE2

. 1.,455.001
1,247.270
1,039.538

L 831.807

. B24.075

416.344
208 612
0831

m Click OK from the Animation PropertyManager.
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Note: You can save the animation of the plot in an avi file format.

2 View the Displacement Plot.

SolidWorks Simulation

®  Double-click Displacement1 (-Res disp-). View the plot in the Graphics

window.

Model name: Housing_Assy

Study name: Droptest Study1

Plat type:  Dizplacement1

Plot stepr 25 time : 243.001 Microseconds
Deformation scale: 1

URES (mm)
1145
1081

L D.ase
. 0864
. 07T
0677
0583
0483
0386
. 0302
0209
0115

0021

3 Create the Time History Graph.
m Right-click the Results folder.
® Click Define Time History Plot. The
Time History Graph PropertyManager is
displayed.

$Droptest Study 1 {-Default-)
é ﬁ; Connections
4B, Component Contacts

B{EIm

% Parts

% Mesh
g Setup

@ Resulk Options

| PN

8
i
R

Solver Messages. ..

w Define Stress Plat...
w Define Displacement Plat.
he Define Strain Plat. ..

[ Define Time Histary Plat..
[—hs
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m  Click Node 1 as illustrated.

SolidWorks Simulation Professional

m  Select Time for X-Axis from the drop-down menu. ® l & .e :
m  Select Translational Acceleration for Y-axis from x|
the drop-down menu. =
m  Seclect g for Units from the drop-down menu. Fredefined lcaions
@ All nodes

4 View the Time History

Graph.

m  Click OK from the
Time History Graph
PropertyManager.
View the Graph.

B Close the Time History
Graph.

5 Save and Close the

Model.

m  Click Save .

m  Click Window, Close
All from the Menu bar
menu.

Running the Analysis

EI Microseconds

' amis

Tranglational AccefE
k ARES: Resultant Ao +

!

X-Axis Range (Time) ]
@ Full

() Defined

-
"
—+m

.
£

£5% Time History Graph

File Options Help

Time History Graph

3.00:04

2.00:04

ARES (g]

1.00+04:

0.00+00:
972 5638 10303 14969 19634 24300 28966

Time (microsec)

—+— Node 1

0.0

97



SolidWorks Simulation Professional SolidWorks Simulation

Notes:

98 Notes:



SolidWorks Simulation SolidWorks Simulation Professional

Optimization Analysis
The Optimization analysis enables designers to meet functional design
specifications without wasting materials and overdesigning. Seemingly
insignificant amounts of weight cut from dozens of components can add
significant cost reductions in production, shipping, and packaging. You can also
test designs with alternate lighter or lower-cost materials in SolidWorks
Simulation.

Perform an Optimization analysis today on the EndCap. The goal of the analysis
is to minimize the mass of the EndCap. Optimize the EndCap Lip thickness and
the Rib thickness in the analysis.

Rib Thickness

The Factor of Safety is greater than one.

o

Time: 15 - 20 minutes

Optimization Analysis 99
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Creating an Optimization Analysis

100

1 Open the Part.

m  Click Open from the
Menu bar toolbar.

B Double-click EndCap from
the SeaBotix\SolidWorks
Simulation
Professional\Optimization
folder. The EndCap (Add
Rib) configuration is
displayed in the Graphics
area.

2 View Static Study1.

m A Static study was created for
this part. Click the Study 1
tab located at the bottom of
the Graphics area as
illustrated. Study 1 is
displayed.

3 Run Study 1.

m  Click Run from the Simulation

SolidWorks Simulation

<< SolidWorks Simul.. » Optimization »

New folder

Finished

Display States: [<Add Rib> Display 5 »

References ]

< [Part oprisidpr) =
Cancel

[l ]/ [_Model | Motion Study 1 | & ftudy 1 | udy1

SolidWarks Premium 2012 x64 Edition

Gt A study 1 (-Add Rib-)
[ Endcap (L3w]alst 1020-)
ﬁ; Connections
= g:\gFixtures
Qe Restraint-3
= é| External Loads
LU Pressure-1 (:1500 psi:)
4 Force-1 {:Per item: 54182 Ib|
% /i Mesh
(=[] Results
l]ﬁ_:f Stress1 (-vonMises-)
ﬁﬁ_{f Displacement] {-Res disp-)

tab in the CommandManager. View
the created plots in the Results folder.
The Stress1 (-vonMises-) plot is
displayed in the Graphics area.

G & o
s Run | Results o
- " it Results

[office Products | Simulation

[ Study 1 (-Add Rib-)
[P Endcap (-[3w]alst 1020-)
ﬁ; Connections
= g:fFixtures
?%e Restraint-3
= i| External Loads
LU Pressure-1 (31500 psi:)
4 Force-1 {:Per item: 54182 |
% Mesh
—b—- ﬂ Results
5

& Displacement] {-Res disp-1

Optimization Analysis



SolidWorks Simulation SolidWorks Simulation Professional

Model name: EndCap

Study name: Study 1

Plat type: Static nodal stress Stresst
Deformation scale: 128776

#

von Mises (psi)
342984004
314084004
2857e+004
257384004

. 228984004
2006e+004

1 72264004

1 439e+004
1.1558+004

| 8719e+003

5863e+003
30488+003
iz |3 424e+004 2129e+002

— Yigld strength: 5.099e+004

4 Create an Optimization Study. =

m Right-click on the Study 1 tab at the bottom d iy
of the Graphics area. DRele

m  Click Create New Design Study. The s
Design Study 1 tab is displayed along with ' /

the Design Study dialog box.

B9 D Sl Variable View | Table View Results View | @ L_} H

------ [| Results and Graphs
] P Fun | [¥] Optimization

[=] Variables
[ Click here to add Variables |

[=I Constraints
[ Click here to add Constraints ~

=l Goals
[ Click here to add Goals ~

W4 [+ TH][_Model [ Motion Study 1 Study 1 | Br ign $tudy 1
SolidWorks Premium 2012 64 Editi
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Note:

102

You can also click Simulation, —
Design Study from the Menu WYariable Yiew Table Yiew | Y | = @ L% H
bar menu.

Select the First Design
Variable (EndCap Thickness)
for the Optimization Study.

Optimization

1= Wariahles

Click Add Parameters

from the Variables drop- o T R T
dOWIl menu. The Parameters EndCap Thickness Model Dimension - | 0.15 in |
dialog box is displayed. Model Dimension =l © E

Enter the Name.

Enter EndCap Lip
thickness.

Click inside the
Name box.
Enter EndCap
Thickness for
name.

Click the drop-
down arrow from
the Model
Dimension
Category.

Select Model
Dimension from
the Category
column.

Click inside the
Value column box.
Rotate the model
with the middle
mouse button and
zoom in on the
.150in EndCap Lip e
thickness

dimension.

Click the .150

EndCap Lip thickness dimension as illustrated. The selected dimension is
displayed in the Value column. Units are displayed in the Units box.

Optimization Analysis
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m  Click Apply. The

(L) Porometersumih (= W - m——— - ™
information is
Name Category Value Units Comment Linked|
added tO the EndCap Thickness Model Dimension LJ0.15 fin j *
Parameters dialog Pockivmerin o]0 B
box. '
References
Madel Dimesion: D8@Sketch2@EndCap.Part aﬂsﬁfgmﬁi‘ irg';iﬂarr'aﬂ;‘:gu
ok | [ Canl | [_[}:my ] [ heb ]

8 Select the Second

Design Variable.

9 Enter the Name.

B Click inside the
Name box.

m Enter Rib
Thickness for
name.

10 Enter Rib Thickness.

m  Click the drop-
down arrow from
the Model
Dimension
Category.

B Seclect Model
Dimension from

o,

the Category
column.
m  Click inside the Diccamge « o o SHEED - = & e
Value column box. Hame Category Value units Comment | Linked
m  Click the .150 B ﬁ::jgﬁi:::: e = -
EndCap Rip ‘ |MudE\ Dimension «[ 0 -
thickness
dimension as
illustrated.
" 8101; gr})(ply. o R st e smetn ot
[ ic .
—B o] [(ow ] [ew] [
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11 Expand the Variables cell in the Design Study.
m  Click the drop-down arrow in the Variables cell. View the results.

ariahle Wiew | Table view | ng @ i.% H
[#] Cptimization Total active scenarios: 9
1=l Wariahles 5
EndCapThickness | Range wih step v| Mirn: |0.075i0 : Max: 0.225n c Step: (00750
RibThickness Range wih step v| Mirn: 0,07 5in : Mz 0.225in 3 Step: |0.0735i0
Click hete to 2dd Variables
| = Constraints
| Click here to add Constraints v|
1= Goals
| Click here to add Goals v 3
¢ »
12 Set the ranges for the variables in the Design
Study.
m  Sclect Range from the drop-down menu for SR |
. EndCapThickness | Range b
Endc apThl Ckness : |RibThickness : Rance
m  Select Range from the drop-down menu for | Glick here to add
. . Dizcrete Values
RibThickness. Do Range

m  Enter the illustrated numbers for the
EndCapThickness (Min: & Max:) range and
the RibThickness (Min: & Max:) range.

[=TVarahles
iEndCapThickness _Range v| Mir: _D.DSin : RS _D.2in \ :
e Range v| Min: |0.05in & Maz: |0.2in B
| Click here to add Variables v| N
13 Set a Constraint (Sensor to monitor) the study. — ——

m Click Add Sensor from the Constraint drop- [EndCapThickness | Range 4
down menu. The Sensor PropertyManager is [rioThickness | Range v
displayed | Cifck heve to add lrariables v|

I=l Constraints
= Zoald
| Ciick here to add Goals ]
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m  Select Simulation Data for Sensor Type. ——e

B Select Stress for Results. olj E $ 2

m Select psi for Units. YT

m Click OK from the Sensor PropertyManager. Sensor Type A

ENET———

Value : Data not available

Data ity ]
E? Stress —P
N

[T Use PSD Value

Properties "
el
3
[ CFactor of safety ¥
[ adert %
14 Set the conditions
- = i
for the Constraint. | —
S lect |s |ess Stress1 _Max; !_SD_D_DD psi - St_uc_!y1_ »i
[ ] e
than for Stress.
m  Enter 60000 for
Max condition.
15 Set a Goal (Sensor to monitor) the study. -
=l Constraints
® Click Add Sensor from the Goals drop-down Stresst klessthan v
C.I’J'c.;’f'he're to eé’d Caonstraints o

menu. The Sensor PropertyManager is
displayed. Accept the default Sensor Type: = Gosls
Mass Properties.

B Click OK from the Sensor T —.
PropertyManager. ® | ||% b |

T

ﬂ%r Type ~
l/\_/‘? lMass Properties R

Properties £

Walue : 1.91677819 kg

| O alert ¥ |
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17 Run the Design Study.
®  Click the Run button. The
results table is displayed and
updated as the study is running.
This may take a few minutes.
View the finished table. You

can now interact with
results.

16 Set the condition for the Goal.
m  Select Minimize.

SolidWorks Simulation

= Goals
I
Mazz1 ) | hinimize
Click heve to add
Maximize
; Sl'u@‘! T Iz exactly
‘ariable Yigw | Table Wiz | i, ‘ = W L% H
Ryn | [#] Optimization
EndCapThickness  Range v|_ Mir: _EI.EIS\n
R_il:!Thickness ) | R_angz_a VI Mir: | 0.05in
Click hete to add Varables vl'
(= Constraints
the S‘_tr_ess1_ . i Iz less t_h_an v| Man: _BUUUU psi
Ciick here to add Constraints vl
[=l Goals
|Mass1 hinitnize: v|
)

@SOLIMRKS . File Edit View Insert Tools Simulaton Window Help Q[D - L;%' SR 0 S 1 -4

Study

Advisor

Features | Sketch | Evaluate | DimXpert | Office Products | Si BB 32
=

»
5

(T

%, EndCap (Add Rib<<Add Rib> =
+-[3] Sensors |

m

- @ 25

?_»? Design Study 1
[+-{la] Results and Graphs

| Variable View | Table View | Results View | E @ l\ﬂ H
11 of 11 scenarios ran successfully. Design Study Quality: High

Current Initial Optimal
EndCap 5, 0.11677in [~| 0.15in 0.11677in |_E_i
Rib Thickness U 0.06452in = 0.15in 0.06452in
P =] e e T e b
1< [0 [0 _Model [ Mofion Study 1 T Study T | % Design Study 1|
Editing Part Custom « [7]

SolidWorks Premiurn 2012 x64 Edition
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18

Note:

Interact with the Results.

m  Click in the Initial
Column.

B Click in the Optimal
Column. Compare the
two columns.

You can look at any of the
individual designs by
dragging the EndCap
Thickness or Rib
Thickness slider.

19 View the Trend Results.

m  Right-click the Results and Graphs

folder.

m Click Define Local Trend Graph. The

SolidWorks Simulation Professional

| Variable View | Table View | Results View | IEI @ Lf}’ H
11 of 11 scenarios ran successfully. Design Study Quality: High

Current
EndCap n 0.15in
Rib Thickness ﬂ 0.15in
Stress1 = 60000 psi 34235 psi
Mass1 Minimize 1.91678 kg
| Variable View | Table View | Results View | ILZ—I @ l'j} H

11 of 11 scenari

Current iteration is the optimal solution.

os ran successfully, Design Study Quality: High

Current Initial
EndCap ﬂ 0.11677in  [~]| 0.15in
Rib Thickness ﬂ 0.06452in [~]| 0.15in
Stress1 = 60000 psi 55295 psi 34235 psi
Mass1 Minimize 1.69425 kg 1.91678 kg
EndCapThickness
-
RikThickness W
Stress] = GO000 psi
% Design Study 1 I“ v
@ Sk Purge Resulks
Define Design History Graph, .,
Define Local Trend Graph. ..
Customize Menu

Local Trend PropertyManager is
displayed. View your options.
® Click Constraint. Accept the default

settings.

m Click OK from the

PropertyManager. View the results in

the Graphics area.

Optimization Analysis

Role |

« R

| Design variables (X-Axis) &

EndiZapThickness b

| Y-Axis
) Objective

|3

Constraint
| Stress1 |

MNormalized to initial
O wvalue

3 |

[Local trend at

| Optirnal |
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20 Close the Graph1 dialog box.

m Click Close.

21 Save and Close the Model.

m Click Save [E]

m Click Window, Close All
from the Menu bar menu.

SolidWorks Simulation

(Ei=l

& Graphi
File Options  Help

Local Trend: Design Study 1 Optimal
e e S B
1.40+05
1.20+051 - -

1.00+05

Stress1 [psi]

RO s R S B R L A

T —

4.00+04

0.08 n.zo 0.2z

0 014 017
EndCapThickness (in]

0.0g

——  Stresz] [psi]

0.00767568, 100354

@sauawmxs jj Fle Edt Vew Insert Toos Smuaton window Help QID i P [O]53

Study
Advisor

Features | Sketch [ Evaluate [ DimiXpert [ Office Products | Simulation [

E I R =

]%I_III%IWIIOI i
@ EndCap (Add Rib<<Add Rib>,
@ Sensors

A Annotations
= AISI1020
> Planel .
> Plane2

| »

m

(#1672 Base-Revolve
1 m | 3

- @ & B

?_»? Design Study 1
=-{Ha] Results and Graphs

| Variable View | Table View | Results View | @ L% H

11 of 11 scenarios ran successfully. Design Study Quality: High
Current iteration is the optimal solution.

Current Initial
EndCap U 0.11677in : 0.15in
Rib Thickness : n 0.06452in : 0.15in
<[
wilal el [ _Model | Motion Study 1 Study 1 | Tr Design Study 1
SolidWorks Premium 2012 x54 Edition Editing Part Custom « [7] !
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Fatigue Analysis

It is observed that repeated loading
and unloading weakens objects over
time even when the induced stresses
are considerably lower than the
allowable stress limits. This
phenomenon is known as fatigue.
Each cycle of stress fluctuation
weakens the object to some extent.
After a number of cycles, the object
becomes so weak that it fails.
Fatigue is a primary cause of the
failure in many objects, especially
those made of metals.

3 Finger Jaw

The SeaBotix LBV 150 contains an optional MiniGrab assembly. In this study, you
will analyze the 3 Finger Jaw part which is attached to the SeaBotix LBV 150 to
grip and hold objects from the sea floor. Before you create the Fatigue analysis,
perform a Static analysis with a force applied to the tips of the 3 Finger Jaw.

MiniGrab Assembly

Time: 15 - 20 minutes

Fatigue Analysis 109
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Creating a Fatigue Analysis

1

Note:

110

Open the Part.

m  Click Open from the Menu bar

toolbar.

®  Double-click 3 Finger Jaw from

the SeaBotix\SolidWorks

Simulation Professional\Fatigue

folder.

Create a Static Analysis Study.

| < SolidWorks Simulation ... »

SolidWorks Simulation

New folder

Display States:

References..
+ [Part C.prtsidprt) -

m  Click the Study Advisor drop-down arrow from the
Simulation tab in the CommandManager.

®  Click New Study . The Study PropertyManager is

displayed.
® Enter Static-Study 1 for
name.

m  Click Static for Type.
Display Static-Study 1.

m  Click OK[¥]from the Study
PropertyManager.

The Static-Study 1 tab is
displayed in the bottom corner of
the Graphics area.

% 3 Finger Jaw {Defaul<<Default>_|
|>_;7.<| Sensors

[+ I-il Annotations

: 3= Material <not specified:=
% Front Plane
% Top Plane
% Right Plane
I.. Crigin

& @ Extrudel

[ Cut-Extrudel

(T~
&t static-Study 1 (-Default-)
@ 3 Finger Jaw

ﬁ; Connections IEE &
g:f Fixtures |_§| Static

£| External Loads

% Mesh |-ﬂtatic BOUENCY

Q |
Study | Design
Advisor | Study
I Q;[%s

tudy Advisor

[ Q Mew Study{_

ST

@ ¥ 42

Message A |
Study stresses, displacements,
strains and Factor of safety For
components with linear material

MName A |

[ static-study 1]

Fatigue Analysis
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Applying Material

1 Apply Material.

Note:

Click Apply Material from the
Simulation tab in the CommandManager.
The Material dialog box is displayed. /
Expand the Aluminum Alloys folder.

SolidWorks Simulation Professional

tudy
Advisor

I-
DD asee
5a oill
-~

- 7 @
Fixtures External Connections Run
sl Advisor Loads...  Advisor

Features | 4

| Defines material to selected Thems.

eich | Evaluate | DimXpert | Office H

e |
Apply Material )

Click 6061-T6(SS) Alloy. View the

material properties.

Click Apply.
Click Close. Material is applied to the part.

the parts.

"

Material

3= soszHag

- $= 5052-H38, Rod (55)

8= soszo
= 5052-0, Rod (55)
3= some-H3z, Rod (55)

3= 51540, Rod (55)

8= sezaHinn
3= samaH11z
3= dcaHmz

82 Ea54H

3= sase-0
3= 6ol oy
3= eoel-0(ss)

3 eoeL T4 (59

=)
i= f0840

3= 60630, Exbruded Rod (55)

~$= eoeaTL

8= soeaT4
3= soea-Ts
3= eoesTe

82 e063-Te, Rod (55

8= soea-Taa
= 7050-T73510
3= 7o50-T7451

- $= 7050-T7EEL

8= 7ors-o(55)
= 7075-T6 [SM)
3= 7075-Té, Plate (55)

82 7079 Aoy
i

4

Properties ‘LTables & Curves .Appearance Il CrossHatch | Custom Application Data | FL %

Material properties

Materials in the default ibrary can not be edited. You must First copy the material to

a custom library ko edit it

A green check mark on the Parts folder indicates that material is assigned to

®

|Linear Elastic Isotropic b |
[51-mmz (Pa) v
[ |
| |
|
T 1
|
L
| |
Property Walle Units o
Elaztic modulus G.900000067e+010 Min"2
Foizzon's ratio 033 MiA
Shear modulus 2 E0000001 Je+010 Min"2
hlazs density 2700 kgim™3
Tensile strength 310000002.1 Mim"2
Compressive Strengih in ¥ PmA2
“ield strength . 27350000009 B2
Thermal expansion coefficient 2 4e-005 M
Thermal conductivity 166.9 WK
Specific heat 596 JiCkgHK)
htaterial Mameinr Ratin Pia, o

Fatigue Analysis

bt static-Study 1 (-Default-)
[ = Finger 32w (-6081-T6 (55)-)
ﬁ; Connections

- g:f Fixtures

@ External Loads

% Mesh
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Adding a Fixture

. ot | 18 73
1 Adda Fixture. e
m  Click the Fixtures Advisor drop-down arrow . .
from the Simulation tab in the CommandManager c:ék%ixtures Adisor
. . . . Fixed Geometr
] .Chc.k Fixed Hinge. The Fixture PropertyManager L cten il !
is displayed. ) Feed Hings
Elastic Support
Advanced Fixtures

2 Select the Cylindrical Face to be
Fixed.
®  Click the inside cylindrical face
of the hole in the 3 Finger Jaw as
illustrated. Face<1> is displayed.
Note the icon feedback symbol
for a face.

® Click OK from the Fixture
PropertyManager. Fixed Hinge-1
is displayed.

€

standard (Fixed Hinge) %

|§| Fixed Geometry

|§ | RollerSlider

@ Fixed Hinge

Face<i> |

|

&t static-Study 1 (-Default-)
[ = Finger 2w (-6081-T6 (3
ﬁ; Connections

= g:f Fixtures

@ Fixed Hinge-1
{Q External Loads

I Advanced

«

% Mesh Symbol Settings

«
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3 Add a Second Fixture.

m  Click the Fixtures Advisor drop-down arrow from o | i 9T
the Simulation tab in the CommandManager. | [ A
m Click Advance Fixtures. The Fixture e nvsor ]
PropertyManager is displayed. Perform a radial Fixed Geometry
support on the right-hand face. :;'f::i"ndge;
Elastic Support
—P | advanced Fixtures

4 Select the inside Cylindrical

Face.
®  Click the On Cylindrical \
Faces box. ‘A

® Rotate the model to view the
side cylindrical face as

llustrated.

m Click the inside face of the ,@
slot as illustrated. Face<1> is \ -
displayed. IK“

5 Select Units and Displacement
Components. [Bn Cylindrical Faces: ]|

m  Select inch from the Units

Standard ¥
drop-down menu.
m Click the Radial box. ray=in otndil__2 |
6 Apply the Second Fixture. () symmetry
. . =i |2 | | e »| |3 o
m Click OK from the Fixture ? ElR[¢|S) () ey
= ([P Use Refe Geometr
PropertyManager' On % $Finger Jaw (Default<<Default=_Did I®I e e broney
Cylindrical Faces-1 is ﬂ ie””tfst () on Flat Faces
) - ninotations =
dlsplayed. 8= Material <not specified: E?‘ n Cylindrical Faces
% Front Plane s
% Top Plane |g| On Spherical Faces
?: RN e o =
Qrigin |

F] @ Extrudel
[+ Cub-Extrudel

K 3 4
T~ | |[Transiations N
[ = Finger 32w (-6081-T6 (55)-) =
T2 Connections |@ _}-D L
= g:f Fixtures -: Radial
@ Fixed Hinge-1 | é [=
Ej On Cylindrical Faces-1 {:0in:} =
a in
(] External Loads |@|
8 Mesh Swmbal Settinge x|
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Applying a Force
1 Apply a Force.

m  Click the External Loads drop-down arrow from the
Simulation tab in the CommandManager.

m  Click Force . The Force/Torque

PropertyManager is displayed.

B Check the Normal box.
2 Select the contact face.

m  Rotate the model with
the middle mouse
button to view the top
contact face as
illustrated.

m  Click the top contact /'
face. Face<I>is
displayed in the Faces
for Normal Force box.

3 Set Units and Value.
m  Sclect English (IPS) in the
Units box.
m  Enter 301lbf in the Force value
box.

Note: 30lbfis the normal force that the
MiniGrab assembly can apply in
holding an object from the sea

floor.
4 Apply the Force.

m  Click OK from the Force/
Torque PropertyManager.
Force-1 is displayed.

114

—’ i Farce

SolidWorks Simulation

| | 71 W
| External | Connections  Run
Loads... | Advisor

iﬂkExternal Loads Advisar

g\ Torque
i m Pressure

&t static-Study 1 (-Default-)
[ = Finger 32w (-6081-T6 (55)-)
ﬁ; Connections

= g:fFixtures

@ Fixed Hinge-1

Ej On Cylindrical Faces-1 {:0in: )|

[ & External Loads
4 Force-1 (iPer item: 30 IbF:)

% Mesh

orce, Torg
« R B
(e o
:‘Force,:’Turque A
L_Ll Force
‘&| Targue
T =
‘ (&) Mormal
() selected direction
fl [engisnirsy —Pp
L [ Ibf
|:| Reverse direc)
(&) Per item
:IEII;Iunun.i.ft.l.rm I.J.i.s.t.r.i.l.:u.ﬂ;iun U |
“."v‘yml‘m‘l.s.n;_tt-ings U |
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Meshing and Running the Model
Results
1 Mesh and Run the Model. e conare
m  Click the Run drop-down arrow - o
. . . =1
from the Simulation tab in the RE: Desian Scenarios
CommandManager Creats Mesh
| Run All Studies
® Click Create Mesh . The
Mesh PropertyManager is g
dl Splayed ‘ Mesh Density ¥
m Click Standard mesh. e
+|Mesh Parameters =
B Check the Run (solve) the — P Osnderdmeh |
analysis box. @t Static-study 1 (-Default-) Was"
. 8 = Finger Jaw (-8081-Té (55)-) |mm |
m  Click OK from the Mesh T3 Connections A [raerorsss w3
PropertyManager. View the B gffiues —
<&l Fixed Hinge-1 NAM | norazsaeor » 2|
results. Three plots are created. B on Cylinical Faces-1 0 R
2 Fit the model to the Graphics area. = i;]ExternaI Loads ] Automatic bransition
. -4 Force-1 (:Per item: 30 Ibf: |
m Press the f key. View the Stress1 5 hresh |advanced ¥
(-vonMises-) plot in the & (@] Results Options A
. @ O Save settings without
Graphlcs area. [P Displacement1 (-Res disp-) eti
he Straini {-Equivalent-) — + Run {solve] the analysis

Model name: 3 Finger Jaw

Study name: Static-Study 1

Plat type: Static nodal stress Stresst
Deformation scale: 21.3273

O Mizes (M2 (MPa))
126,439
15913
. 105386
. 94860
| 54334
L 73807
63.281
-
| 42228

L3102

21176
10,650
0123

—P iel strength: 275.000
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Performing a Fatigue Check Plot.

1 Create a New Fatigue Study.
m  Right-click the Results folder.
m Click Define Fatigue Check Plot. The Fatigue
Check Plot PropertyManager is displayed.
2 View the Fatigue Check Plot.
®  Click the Fully Reversing Load button. View the
results in the Graphics area. There is a possible
Fatigue issue.

m  Click Cancel from the Fatigue Check Plot
PropertyManager.

SolidWorks Simulation

Bl [;| External Loads g

L Force-1 (:Peritem: 30 IbF) 2

% Mesh

‘? Advisar,,

&; Solver Messages. ..

@ Define Factor OF Safety Plat)
ﬁ Define Stress Plat, ..
&l Define Displacement Plot. ..,
&E Define Strain Plot...

| Define Design Insight Plat. .

Deﬁﬂe Fatigue Check Flot..

8.7 - — B 3%

ot
Fixtures External Connections Run | Results

swdy | o5,
s y
Advisor Material Advisor  Loads.. Advisor Advisor Result  Results

B soLipworks jj Fie Edt Vew et Toos Smdaton Window kelp 2| =

¥y Design Insight L5 Report
Deformed Compare U7, Plot Tools

{5 Indude Image for Report

Features | Sketch | Evaluate | DimXpert | Office Products | SfmmationJ

|@|t%$e I A& ¢

C3] |2 3 Finger Jaw (Default<<De...

Modifying Factors A
Loading type

s

@ Calculate
(%) Spedify 3 _:]
p
.

0.95

I —

0.923 b

Ily Reversing Load ]
T

1 o075
=

Cumulative factor:
0.657537

Material
Material: 6061-T6 (S5)
Fatigue strength: 1.55e+008

Z’\x

@ ¢ @ WMEHE Tame: 3 F\ngemw
Stucly name: Static-Study 1
Plot type: Fatigue Check Plat Fatigue Check1

[EIR S =

HOEEER

Nfm*2 i Static-Study 1 [

'I:!H‘

Scale this value

g
3

Editing Part -

1

Minimum safety factor
1

@ Possible Fatiaue

You should run a full fatigue
analysis for more detailed
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Creating a New Fatigue Study. Q] - o
1 Create a New Fatigue Study. ol M‘;@r\i‘al i
m  Click the Study Advisor drop- | '

Q #Study Advisor
down arrow from the — B ety
Simulation tab in the | Study Properties
CommandManager. iy

m  Click New Study [2] The v %=
Study PropertyManager is Htessage 2
displayed. iR = *i
m  Enter Fatigue-Study 1 for Feneshdyl T )
Name. e i i
Q% |@ |% $‘ e »‘ ‘il Static
l_ Check Fatigue for Type. 'g T @] Frequency
2 Dlsplay the StUdy' @I Sensars il ‘§| Euckling
m Click OK[#] from the Study | “&mear, e | | moms
PropertyManager. View g Frant Plane 8] Drep et
. op Plane
Fatigue-Study 1 (-Default-). e = —
) . I.. Qrigin L ‘ fibsr
Note: The Fatlgqe-Study 1 tab is IR ool E I [ —
displayed in the bottom corner of .f%’ . ' —S N = pr———
the Graphlcs area. C.@Fatigue-study 1 {-Default-) Dptions 2
l:lLoadin {-Constant Amplitude-| e
E Resulthptions i _’@ Hﬂli|
3 View IToading Event. T ~
m  Click the Fatigue drop-down B Incude tmage for Report | 209%

arrow from the Simulation tab s

in the CommandManager. s | Simulation | %

m  Click Add Event | | The Add
Event (Constant)
PropertyManager is displayed. T A

B Sclect Static-Study 1 from the by 100000 €— |
drop-down menu. = [Fuly Reversed (R=-1) v

®  Enter 100000 cycles box. Q

m  Click OK[¥] from the Add
Event (Constant) e
PropertyManager‘ @b Fatigue-Study 1 (-Default-)

. . . B
m  Click 3Finger Jaw in the Study | & ﬁa . P(_Cmm o
tree. View the results. | Result optians
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Note:

118

Edit the Fatigue data.

m Right-click 3 Finger Jaw.

m Click Apply/Edit Fatigue Data. The Material
dialog box is displayed.

®  Check the Derive from material Elastic
Modulus box.

B Sclect Log-log from the Source area.

m  Click Apply.

B Click Close. View the results.

SolidWorks Simulation

#Fatigue-study 1 {-Default-) !-‘
@ E = ¢|
= @Loe i= _A_ﬁ_l_y,l’Edlt Fatigue Data
Copy

-||/_—Re

pMaterial 1]
003-H12, Rod (55) P Properties I Tables & Curves| Fatigue SM Curves |Appearance I CrossHatch I Custom | * | "
003-H14 =
e S B Source Preview

ik i) Interpolate: _Linear =
003-H16 )
003H1E (@) Define: Curve-0R=-1)
003-H18, Rod (55) _*ﬂjerive from material Elastic Modulus:
-
@ Based on ASME Austenitic Steel curves
*) Based on ASME Carbon Steel curves View All
Table data
StressRato (R): | -1 Units:
10 Points A =
1 100 q
2 200 13 =
£l b View
4
3 5 Save
(]
052-0, Rod (55) g =
~#= 5086-H32, Rod (55) Source:
8= 5454111
3= sasa112
4= 6061-T4 (55) \

Run the Study.

m  Click Run from the Simulation
CommandManager. View the Results
folder.

100,000 cycles represents approximately
100 cycles/dive x 100 dives/year x 10-year
life expectancy of the unit.

R soLpwoRKs || Fie it Ve

2

Q & .
Study, | (i RS Deformed  Compar
Advisor Advisor R s

C@Fatigue-study 1 {-Default-)
i @ 3 Finger Jaw {-ASME Austenitic Steel-)
H E] Loading {-Constant Amplitude-)
: l/_— Result Options
= @l Resuls
& Results1 {-Damage-)
& Resulksz {-Life-)
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View the Life Plot.

B Double click on the
Results2 (-Life-)
folder. The Life
plot is displayed.

Display the Chart

Options

PropertyManager.

®  Double-click on the
Total Life (cycle)
plot in the
Graphics areas as
illustrated. The
Chart Options
PropertyManageris
displayed.

Reverse the Life plot
results color.

®  Expand the Color Options box.

m  Click the Flip box.

m  Click OK from the Chart Options
PropertyManager. View the results in the

Graphics area.

SolidWorks Simulation Professional

Total Lite (cycle)
1,000,000 000
919220125

L B38,440313
_ 7aTBE0438
|} 576,560 563
| 996,100.688

! 515320844

434,541,000
| 353761125

L 272881250

182,201 406
111,421,947
30,641 B35

Color Options

_>ﬁ

i Default

v

=t |12

Flip

User Defined

s ]

2

Total Life (cycle)
1,000,000 000
919,220125
835440313

. 757 BE0.438

. B76,880 563
996,100 686

i 515,320 844
| 434 541.000

L 393 TE1A2S

. 272881250

L 182201 408

I 111,821 947
30,641 B35

Fatigue Analysis
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Applying a Load Factor

120

1 Apply a Load Factor.
m Right-click the Results folder.
® Click Define Fatigue Plot. The Fatigue Plot
PropertyManager is displayed.
B Check the Load Factor box.

m  Click OK from the Fatigue Plot

PropertyManager. View the Results folder.
2 Save and Close the Model.

m  Click Window, Close All from the Menu bar
menu. You are finished with the SolidWorks
Simulation Professional section of the HOTD
manual.

SolidWorks Simulation

C@Fatigue-study 1 {-Default-)
I+ !E_;] Loading {-Constant Amplitude-

o ) T

@ 3 Finger Jaw {-ASME Austenitic
l/_— Result Options

& @ Eefine Fatigue Plot.

& % List Fatigue Results)

Plot Type
O Life

O Damage

Load Factar
Biaxiality indicator

i Property ¥ |

3

C@Fatigue-study 1 {-Default-)
(¥ = Finger Jaw (-ASME Aust
1+ |E| Loading {-Constant Amplity
l/_— Resulk Options
=[] Results
& Results1 {-Damage-)
& Resulks2 {-Life-)

- & Results3 (-Load fac

Model name: 3 Finger Jaw

Study name: Fatigue-Study 1

Plat type: Fatigue(Load factor to cause failure) Results3
Load factors less than 1.0 indicate failure

Load factor
716184
656 576
536 955

L 53734
| 477723
| 418105
|| 358487
| 288870
| 238252
. 178634

L1207

I 50.398
o7
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SolidWorks Simulation Professional Conclusion

In your short time today, you have seen firsthand the functionality of SolidWorks
Simulation Professional applications. In addition to the design validation
functionality contained in SolidWorks Simulation, SolidWorks Simulation
Professional offers expanded analysis capabilities including: Thermal, Frequency,
Buckling, Optimization, Fatigue, and Drop Test Simulation.

Understand the effects of temperature changes. Temperature variations
encountered by mechanical parts and structures can greatly influence the
performance of your designs.

Evaluate natural frequencies or critical buckling loads and their
corresponding mode shapes. Often overlooked, inherent vibration modes in
structural components or mechanical support systems can shorten the life of your
product and cause unexpected failures.

Optimize designs based on your defined criteria. Design optimization
automatically determines the optimal design based on your specified criteria.

Simulate virtual drop tests on a variety of surfaces. In the event that your part
or assembly might be dropped, find out whether or not it can survive the fall
intact.

Study the effects of cyclic loading and fatigue operation conditions. See the
effects of fatigue on the overall lifecycle of your part or assembly to find out how
long it will last and what design changes can extend its working life.
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Notes:

SolidWorks Flow Simulation

When you complete this chapter, you will have experienced the power and
capabilities of SolidWorks Flow Simulation, including:

The benefits of using fluid-flow analysis.

The ease of use of SolidWorks Flow Simulation to perform analysis on your
design.

The steps for performing upfront analysis on your designs.

The integration between SolidWorks Flow Simulation and SolidWorks.

The results of cost reduction with virtual prototypes to save resources.

The ability to document your analysis findings automatically.

Time: 20 - 25 minutes
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SolidWorks Flow Simulation is the
first easy-to-use fluid-flow
simulation and thermal analysis
program that is fully embedded
inside SolidWorks. You will utilize
SolidWorks Flow Simulation to
understand, validate, and improve
new product ideas during the
design phase.

SolidWorks Flow Simulation
provides the user insight into parts
or assemblies related to fluid flow,
heat transfer, and forces on
immersed or surrounding solids.

You will use the SolidWorks Flow
Simulation Wizard to analyze the
drag created by the SeaBotix
LBV150 assembly as it moves
through seawater. This information
is critical to choose the correct size
thruster required for the assembly
to perform its tasks.

SolidWorks Simulation
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Starting a SolidWorks Flow
Simulation Session

1 Open the SeaBotix

LBV150 Assembly.
m  Click Open from
the Menu bar toolbar.

®  Double-click
LBV_ASSY from the
SeaBotix\SolidWorks
Flow Simulation
folder. A simplified
model opens in the
Graphics area.

2 Activate SolidWorks

Flow Simulation module.

m  Click the Options drop-down
arrow from the Menu bar toolbar as

illustrated.

m  Click Add-Ins. The Add-Ins dialog

box is displayed.

SolidWorks Flow Simulation

Open
» Solid... » SolidWorks Flow Simula... » v | 43 | Search SolidWorks Flow Simul.. 0
Organize »  Newfolder =~ 0 @
ot MName Date modified Type
B Deskiop 3 £/23/2011 1105 AM  File foldey
& Downloads Finished 8/23/2011 1105 AM  File folde
il Recent Places | =| | % LBV_ASSY 10/23/20108:17 PM  SolidWorl
& Libraries
=] Documents
2l Music
&) Pictures
Videos
#l Homearonn | <L Ll o *
Mode: [ Do not load hidden
compenents
Configurations: (pefaukl =
[7] Use Speedpak
Display States: | pisplay State-3 o

File name: LBV_ASSY

v | Assembly (*.asm;*sldasm) -
oo T

518 = (=g,

LBV _ASSY.SLDASM

? E Cptions
Customize. ..
of | Exploded
rials View Add-Ins... 4_.

Active Add-ns

|startup |

=l SolidWorks Premium Add-ins

Check the SolidWorks Flow
Simulation 2012 box.

Click OK from the Add-Ins dialog
box. The Flow Simulation tab is
displayed in the
CommandManager.

SolidWorks Flow Simulation

[T] & Circuitwworks

[ &8 Featureworks

[T Photoview 360

D'ﬁl" ScanTo3D

D-:Qf; SolidWorks Design Checker

[7] & solidworks Mation

[7] 1 solidwiorks Routing

['] SolidWorks Simulation

[[]  Solidworks Toolbox

] rg; SolidWorks Toolbox Browser
[T salidworks Utiities

[[]  Solidworks Workgroup PDM 2011
[[]  Solidworks Workgroup PDM 2012
[T Tolanalyst

El SolidWorks Add-ins

@

[ Autotrace

/|  SolidWorks Flow Simulation 2012
[7]  Solidworks Part Reviewer

[[]  Solidworks XPS Driver

[ OK ][ Cancel ]

I v o

A
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Start the SolidWorks Flow

Simulation Wizard.

m  Click the Flow
Simulation tab located
in the
CommandManager.

m  Click the Wizard
tool. The Wizard -
Project Configuration
box is displayed.
Create new is selected
by default. Accept the
default settings.

® Click Next>. The
Wizard Unit System
dialog box is
displayed.

®  Click IPS (in-lb-s) for
Unit system.

®  Click inside the
Velocity Unit box.

® Click Knot from the
drop-down menu as
illustrated.

®  Click .123 from the
drop-down menu from
the Decimals in results
display column.

®  Click Next>. The
Wizard - Analysis Type
dialog box is displayed.

SolidWorks Simulation

msmm . File Edit View Insert Tools Flow Simulation Wind|

|0 Wizard l: |E%
D New':\\

I

£ Flow
[E General | ||

Simulati..

| % Settings | ap,
B Clopd ‘miect @ = =

Asser card

Create a new Flow Simulation project
|6 [ using the Wizard

al =y

= fﬁ@ (? ‘A

§ Run | Load/Unload [ | <

’ Results =
qEa £

ce Products W Simulation

Wizard - Project Configuration

= mputl
~-[_1] Computational Domain
P18 Component Control
Fluid Subdomains
-} Baundary Conditions
[J% Fans
B4 Heat sources
- Parous Media
@ Initial Conitions
B Goaks
-8 Local Initial Meshes
-8B Results
5 Mesh
- Cut Plots
> surface Plats
&y Isosurfaces

.. =8 Flow Trajectories

Canfiguration
(@) Create new
O Use curent

Configuration name:

Cunent canfiguration

Comments:

|Detaurt (1) |

|Defauit |

=D Cancel Help

Wizard - Unit System

Unit spstem: »
System Path Comment
CES [emgs) Pre-Defined CES [emgs)
FPS [ftbes) Pre-Defined FPS [ftdhes)
1P5 (irvlb-s) Pre-Defined 1P5 (irelb-s)
N [mm—g\ Pre-Defined N [mg-)
Sl fmkg-s] Pre-Defined 51 [mkg-s)
Usa Pre-Defined Usa
[ Create niew
e g | DEemslsmresuts | 1St A
display eauals fo

P | =
= blain

Pressure & stress

Ibfin®2 12345

“elocity
Mass
Length Kilometerhour
Temperature LTSty
Kot
Physical time o -
# HYAC Inchizecond -
*| ¥ Geometrical Characteristic | vardisecond g o
— e Centimeter/second -
i ond
<Back | | Footininute hee | [ Hem |
Custom Uint ..
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m  Click the External box
for Analysis type.

B Click Next>. The
Wizard - Default Fluid
dialog box is displayed. Physical Features | value

Heat conduction in solids
Radiation

Analyzis type Consider clozed cavities @

O Intemal [ Exclude cavities without fow conditions

%xtemal [ Exclude internal space

Time-dependent
Gravity
Rotation

Reference axis: Dependency... @
% [ Cancel ]

[ < Back ]L et [ Help ]

m  Expand the Liquids

Fluicks [Path |~ New...
fOl.der. - Propane Pre-Defined
u Chck Water. - R123 Pre-Defined

Pre-Defined
Pre-Defined
Pre-Defined

m  Click the Add button.
Water is displayed in the

Project Fluids box. S i

B Click Next>. The |
Wizard - Wall [+ Steam o i
Conditions dialog box is p— ]
displayed. Accept the — :
default settings. K;Z?(Fﬁms) lfaun T |

m  Click Next>. The
Wizard - Initial and
Ambient Conditions

. . . Flowy Characteristic |Value |
dlalog bOX 18 dlsplayed‘ Flow type Laminar and Turbulerit
Cavitation ]

[ < Back ] Mext » ][ Cancel ][ Help
5
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m  Double-click inside the

. . Parameter | Walue
Value bOX Of Ve|°C|ty in Parameter Definition User Defined
X direction as illustrated. fg. Thermagdyramic Paramsters
. Preszure 14 6958473 lfin2
m  Enter 2 kn for Velocity. - Tempersture £5.09 °F

m  Click Next>. The Wizard

= Velocity Parameters

el in =ction
- Results and Geometry Yelocity in ¥ direction 05 g
“elocity in Z direction 0kn

Resolution dialog box is
displayed.

[# Turbulence Parameters

Note: Two knots is the operating
speed.

4 Complete the SolidWorks
Flow Simulation Wizard.
B Accept all default

settings. Click the Finish

button.

< Back ]L Mext > ,][ Cancel ][ Help ]

Fesult resalution @

Minimum gap size
[ Manual specifization of the minimum gap size

Minimum gap size refers to the feature dimension
Iinimum gap size:

Minimurn wall thickness
[ Manual specifization af the minimum wall thickness

Minirurn wall thickness refers to the feature dimension

Minirum wall thickness:

[] &dvanced narmow channel refinement Optimize thin wallz rezolution @

< Back F'Eish [ cancel | [ Hep |
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5 View the Simulation.

Press the z key three or four
times to Zoom out to view the
model. The surrounding box
simulates the seawater around
the assembly.

6 Analyze the Drag.

Click the Flow Simulation

analysis tree tab.

Expand the Input Data folder.
Right-click Goals.

Click Insert Global Goals.
The Global Goals
PropertyManager is displayed.
Scroll down and check the Max
box in Force(X).

Click OK[#] from the Global
Goals PropertyManager.

SolidWorks Flow Simulation

SolidWorks Flow Simulation

Insert Global Geals...
In&r‘t Point Goals...
Insert Surface Goals.

Insert Volume Goals)

Parameter iy
Parameter vin [ Av [Max [ Bulk Av]Use | ~
Turbulent Time ) =] [l
Turbulent Length ) F [Fd
Turbulent Intensity ) [Fd
Turbulent Energy B B [Fd
Turbulent Dissipation ) [Fd
Heat Flux B B E [Fd
Heat Transfer Rate ] [Fd
Normal Force ] [Fd
Normal Force {X) ] [Fd
Normal Force {Y) ] [Fd
Normal Force (2) ] [Fd
Force | 6
Force () il HEd
Force (Y} t{k [Fd
() O [Forced
Friction Force ] v =
Friction Force (X) ] [Fd
Friction Force (¥) ] [Fd
Friction Force (2) ] [Fd
Torque (x) ] £l
Torque (1) ] £l
Torque (2) ] £l
Mass Fraction of Water B EE B ®&:"
Volume Fraction of Water [ [ ] [ 7] -
L5, Global Coordnate System

Hame Template A
GG <Parameter> <Number:

[z ||en|
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Run the Analysis.

m  Click Run El from the
Flow Simulation tab in
the CommandManager.
The Run dialog box is
displayed.

m  Select 1 CPU from the
drop-down menu,

®  Click the Run button.

To save classroom time, we
will stop the analysis and
open the Results folder to
review completed results.

Stop the Analysis.

m  Wait until the third
iteration and click Stop
from the Solver box as
illustrated.

m  Click No to the question,

“Do you want to save
the results?”

B Click File, Close from
the Solver Main menu.

Open the Configuration with the Solved Results.

m  Click the ConfigurationManager tab.
®  Double-click the Default (3) configuration as

illustrated.

B Click the Flow Simulation analysis tree

tab.

® Right-click the Results folder.
B Click Load Results. The Load Results dialog

box is displayed.

SolidWorks Simulation

imFLlIDau;... @ Run | Load/Unload & \’3
. = -k Results 9& ol \<%

uate 1 Office Priducts | Flow Simulation

Run
Solve the defined task

Startup
Fun
Mesh T ake previous results
lsone
(%) Mew calculation

CPU and memory uzage

Fiun at: ! Thiz computer [CAD session]  w |

Uze 1 + [ CPU(s]

Results (2
3
[¥]Loagy

fter finizhing the calculation

Batch Results...

| Paramneter Yalue
Status Calculation
Fluid cells 45190
Partial cells 953
Iterations 3
Last iteration finished 07:11:20

“.jFB Defaultl [ LBY_ASSY ]

B[RS < —

@, Default (3)

E| @ Input Data

Lo ]| Computational Domain

Fluid Subdomains

Eﬁ Boundary Conditions

? Goals

: -#% GG X- Component of Force 1
-13 Tracer Studies

LngResult;
Select Results

Plot Manager...

Batch Results Processing...
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m  Double-click 3.fld in folder 3.

10 Create a Section Plot.
® Expand the Results folder.
®  Right-click the Cut Plots folder.
m  Click Insert. The Cut Plots
PropertyManager is displayed.
Front Plane is selected by default.

m  Expand LBV_ASSY from the fly-
out FeatureManager. View the
features. Front Plane is displayed
in the Section Plane box.

m  Click the Contours button in the

Display box.

m  Click the drop-down menu in the
Contours box to select Velocity as

llustrated.

SolidWorks Flow Simulation

SolidWorks Flow Simulation

Look in: 0 3
D= MName
sl J Sresults_tmp

Recent Places | particle_study

! L 13.cpt
HREES
Ly

Desktop

MEECIEL

Default (3)
- @ Input Data

B? Goals

9----% Results
: ;ﬁE Mesh

G—nL

@ Computational Domain
&y Fluid Subdomains
-Ff Boundary Conditions

? GG X - Component of Force 1
Q Tracer Studies

3 Si Insert... 1’

g™ Tepourface:

Display ~
2 Contours

|@| Izolines
|E| Vectors
|@| Mesh

C

b3

+_+|

o o | as | == | @ LBW_A55Y (Default (3 <<D)
@ .. —@ Sensars
& Cuth H []—@ Design Binder
W B Gy = EHAD Annotations
—%
Selection A 5 Top
SGIEIEIE X Right
L i =+ Origin
E@ Front []—% (-J Burnper Side, Plastic
[]—% (-J Burnper Side, Plastic
bi Oin z B () Flow<13-> x (Defaul
[ — =i tMateGroupl

B [veloaty -l[E
Pressure b

# | Temperature
Densi

|%| Velodty (X)
Velodty ()

= Velocity (Z)
oPtmTemperab.lre {Fluid)
Vorticity
Crop add Parameter
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m  Click the Adjust

.. . Cont Al
Minimum and Maximum ——
. = |Vel00ty v“ 1 |
button. View the range. . ‘_:Eﬁﬁs?] - 4
1 View the Section Plot. - & £ AAdijust Minimum and Mazximum
_ E [T @
Click OK | ¢ | from the Cut |_ & 4 -
. ~ I
Plot PropertyManager. View E_# CEN—
the Section plot in the 2] 3 profie
. 2441
Graphics area. i
. . ) 1.898
Note: Click Flow Simulation, 1897
Units from the Main menu 1.358
bar to modify decimal places 1085
in results display. oo
0.542
0.271
0
Welocity [kn]
Cut Plot 1: contours

12 Move the Section Plot in

the Graphics area. =% il

m  Expand the Cut Plots ——P= Bk CutPlots
folder. BN iﬁﬁm

m  Click Cut Plot1. View the 8 5’%. Isosurfaces
Control Arrow in the . E2: Flow Trajectories

Graphics area.

®  Click and drag the control
arrow to the left side of the
computational domain.
View the changing results
of the Section plot.
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®  Click and drag the control
arrow to the right side of
the computational domain.

B Move the Section Plot
back to its original location
in the computational
domain.
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13

14

15

16

View the moving Computational

Domain.

m Right-click Cut Plot1.

m Click Play. View the results in
the Graphics area.

Stop the moving Computational

Domain.

B Right-click Cut Plot1.

B Click Stop. View the results in
the Graphics area.

Hide the Computational Domain.

m Right-click the Computational
Domain folder.

m Click Hide.

Create a Second Cut Plot.

B Right-click the Cut Plots folder.

m  Click Insert. Front Plane is
selected by default.

SolidWorks Simulation

B-% Resulks
. ﬂEE Mesh

=Bk Cut Plots

<>' ?urfal Edit Definition,
=8 é Isosu  Hide

i ‘0;" Flow|  Clear and Hide
¥, Partip  Clone

i j Foint|  Delete...

i Surfa%
H @ ol animban, .

mswm I Fle Edit View Insert Tools Flow Smuation Window Help & lD - |3? - H POV 2 DN [ o0

% Wizard f% B @. @

5] ; 4
SR R
B Clone Project @ S - Res gg - EB - @ @’J -
Assembly | Layout | Sketch | Evaluate | Office Products | Flow Simulation | & 32
=

«f&@k&sfﬁ

BlElele]=

%, Default (3)

BE% Input Data

@ Computational Doma
Fluid Subdomains
Eﬁ Boundary Conditions

2441
2169
1.898
1.627

1.356

B--F Goals
i # GG X - Compone, 1.085
’S‘ Tracer Studies 0814

(= Bﬂ REsu\ts 0542
i Mesh 0271
-3 CutPlat

& Insert...
Hide All
Clear and Hide All
Delete All...
Play All

PE! Goal Plots
@ Report
... @@ Animations H

o @ s m B

@-bo- @ - B-

SolidWorks Premium 2012 x64 Edition

3
||< ~T7 71| Model | Wolion Study - Defaull | WMotion Study 1]

Under Defined

Editing Assembly Custom ~ 2]
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17 Change the Selected Plane.
m  Expand LBV_Assy from the fly-

= @ LBW_ASSY (Default (3 <<D..
2] Sensors

J / []—@ Design Binder
ouF FeatureManager. 8 A o Rl A
® Click Top Plane from the fly-out = Front
Selection A -9

FeatureManager. Top is

CIEEE S Right

displayed in the Selection plane o —% Origin
ffop | BN (-) Bumper Side, Plastic .,
or face bOX. []—% (=) Burnper Side, Plastic .,
b Oin = E-8 () Flow<1s- > % (Defaul.,
18 Continue the Second Cut Plot. Lo | =00 MeteGroup
m  Click the Contours button. FresmTE A

m  Select Pressure from the drop- __E‘Féonmurs
down menu for Parameter. (@) 1soines

m  Click the Adjust Minimum and =

. . [72] vecto
Maximum button. View the —=
range. (B wesh
m Click OK[¥ | from the Cut Plot ~ [©™= f .
: B [resswe ][]
PropertyManager. View the , v :
Section plots in the Graphics E 70 e g apieigu )
area. £, 14B3meaI=] - o
Fx |10 &
|§| 3D profile
Options v |
Crop Region ¥
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SolidWorks Simulation

msmm IFde Edit View Insert Tools Flow Simulation

Window  Help Q{D.a.v@ﬁ@x

Assembly | Layout | Sketch | Evaluate | Office Products | Flow Simulation |

\ Wizard E% Eﬁ % @ [ »« ? & @ lfé( gg; ‘%ﬁ
0 new (@ ceneral | [13 SimFJ?au; Q@ run |Loadnioad | ([ Si:llj‘: @ SimFJ?au;
n Settings Results ] 1 i
Clone Project @ = Eﬂ - 8 - @ % -

r 244
Efault (3) 2.169
B Input Data . 1.808
----- @ Computational Do
[ Fluid Subdomains Lol
----- Ffi Boundary Conditic 1.358
m...? Goals 1.085
F GGX-F:omp( 0.814
----- %3$ Tracer Studies
Results 0542
0.271
a
Yelocity [kn]
-4 » Surface Plots 4 cutPlot1:contours
1t Isosurfaces 1 14.7636
--£5: Flow Trajectories 14,7491
TN Parncle Studies 147346
----- A Point Parameters
----- @) Surface Parameter 147201
----- @ Volume Parameter 1470586
..... k4 XY Plots 14,6811
----- #e Goal Plots 14,6766
..... W] Report
----- B Animations 4 Bez]
14.6477
14,6332
Pressure [lbfiinZ]
#
CutPlot 2: contours
] T 3

B OEmEBR- - 6o- @ B- B

(I S =

SolidWaorks P

2012 164 Edition

Under Defined

Editing A

bly Custom «  [7] ||
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e results.

19 Hide the first Section Plot.
m  Right-click Cut Plot1.
m Click Hide. View th
Note:

Click the FeatureManager tree tab as

illustrated to view the full Graphics area.

SolidWorks Flow Simulation

E}--% Resulks
ﬂ;E Mesh
= & CutPlots
Y-

™l

{} SurFacl

- & Isosurﬁi

Edit Definition. .

t and Hide

@saumlm Edit View Insert Tools Fiow Simuiation Window Help Q\[jv(f}..@v:,@x

\ Wizard

g% 54 m @. @ = % ? & @ l/‘—é! 02; :§
0 rew |[@ General |[I13 SimFJ?au;... @ Run |Losdnioad B | O Sm'il:l‘: P SimFJ?au;...
Clone Project @ SR i G =ts Ea - ligE " @ =
Assembly | Layout | Sketch | Evaluate | Office Products | Flow Simulation | B X

96, 58

147636
147491
147346
14720
14,7056
14,6911
14,6766
14,6621
14,6477
14,6332
Fressure [Ibffiin*2]

CutPlot 2: contours
[ Show FeatureManager Tree Area l

QAWM @ F-oo-@ - Bi-
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Under Defined
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20 Hide the Section Plots.
m  Right-click the Cut Plots folder.
m Click Hide All. View the model in the
Graphics area.
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QR[]
Default (3)
9@ Input Data
@ Computational Domain
Fluid Subdomains
Ffi Boundary Conditions
Pt Goals
: Pt GG X - Component of H
- Q Tracer Studies

Insert...

ide All
Clear and Hide
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Applying Flow Trajectories

Flow trajectories are displayed as flow
streamlines. Flow streamlines are curves
where the flow velocity vector is tangent
to that curve at any point on the curve.

S Wizard m @' @ [
[ Mew |E SGeetr:]eral |[:|.. amﬂ?;; |@ Run
. Clone Project @ e

| S =
Default (3)
@ Input Data 147636

i @ Computational Dor
[§ Fluid Subdomains
Ffi Boundary Conditiol
Pt Goals

....... # GG X- Compol
1% Tracer Studies

147401

. 14.7346
14720

[]----& Isosurfaces
£5¢ Flow Trajectories

: Flow Trajectori
...... . Particle Studies

Applying Flow Trajectories 139



SolidWorks Flow Simulation

Applying Flow Trajectories

1 Create a Flow Trajectory.

m Right-click the Flow Trajectories folder.

®  Click Insert. The Flow Trajectories
PropertyManager is displayed.

® Expand LBV_Assy the fly-out
FeatureManager.

m  Click Right Plane. Right is displayed in
the Reference box.

m  Slide the Offset slider as illustrated to
approximately -21.

®m  Click OK| ¢ | from the Flow Trajectories
PropertyManager. Flow Trajectories 1 is
displayed.

B Zoom-out and rotate the model to view
the plot.

SolidWorks Simulation

= ?a Results
]ﬂi Mesh
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B CutPlat 1
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7
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2 Edit the Flow Trajectory.

Expand the Flow Trajectories
folder.

Right-click Flow Trajectories 1.
Click Edit Definition. The Flow
Trajectories PropertyManager is
displayed.

Pin the Flow Trajectories
PropertyManager.

Enter 100 for the Number of Points
as illustrated.

Click Lines with Arrows from the
drop-down menu in the Appearance
box.

Un-Pin the Flow Trajectories
PropertyManager.

Click OK from the Flow
Trajectories PropertyManager.
View the plot. If needed, click the
FeatureManager tree tab to hide or
click and drag the Pressure bar.

Applying Flow Trajectories

SolidWorks Flow Simulation

=35k Cut Plots
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0 Mew |E GEnEraI |[:|., 5II'I'TI‘|,E\’; |@ Run | Lnadj.iinad B |@ SI;B:.

B3 Clone Project @ Sctinos = i

Assembly | Layout | Sketch |Evahiate | Office Products |F‘IowSm1u|at|on |

WRE-J-oo-@ BB

Default (3)
B Tnput Data 14,7636
~{_]| Computational Dor 147481

[ Fluid Subdomains 14,7346

i Boundary Conditiol 147201

Goals )
L8R GG X- Compol + 147056

g Tracer Studies

% Results

L HE Mesh

-3 CutPlots
%y CutPlotl  §
.3 CutPlot2

»{) Surface Plots

j& Isosurfaces

low Trajectories

3 Flow Trajectori
4. Particle Studies -
= f Point Parameters
@ Surface Pararneters
-{[F] Volume Parameters
..l XY Plots

#, Goal Plots

@ Report

B\ Animations

SolidWorks Premium 2012 64 Edition Under Defined _ Editing Assembly Custom = [Z] &

3 Animate the Flow Trajectory study.
B Right-click the Flow Trajectory 1 folder. o w
m  Click Animate. The Animation 1 tab is -

displayed at the bottom of the Graphics area. & suface J Clear and Hide
@ Wolume Clone
l’i’é x5 PIotsn Delete...

25 Flow Trajectories

& Goal Plo 57
@ ReportJ i
B Animati %
| Export...
u Cl%ck Fflay El View the Play
animation of the model. Play animation without saving to the disc
B Click OKfrom the T H AP PO EMe X 2
Animation toolbar to =
return to the
FeatureManager.
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SolidWorks Flow Simulation

4 Hide the Flow Trajectory.

m  Right-click the Flow Trajectories 1 folder. o zﬁwﬁ%.
®  Click Hide. View the Graphics area. N2 particlg|  Edit Definitien. .

5 Set the Goal Plots.

®  Expand the Results folder. R Flow Trajectories |

®  Right-click the Goal Plots folder as \j; Famch e
illustrated. & surface Parameters

m  Click Insert. The Goal Plot B
PropertyManager is displayed. i conpa

m  Check the GGX-Component of Force1 = % o

box as illustrated.

m  Click OK from the Goal Plot
PropertyManager. The Goals dialog box
is displayed. View your options.

Applying Flow Trajectories

A paintpa
@) Surface|  Clagr and Hide

(=} E5: Flow Trajectories

[¥]a6 % - Component of Force 1

FJ.., | Iterations R |

| Options ¥ |

Microsoft Excel - soals1

'@j File  Edit ¥iew Insert Format Tools Data  Window  Help

ARWET: NEVETIE NEVA A NN TRl e SN
&_Snagl_t E[' | Window - !
;¢ hy O Settings -
GoalMarme = A& Goal Name
A | B | ¢ | D | E
LBV_ASSY.SLDASM [Default (3)]|
Goal Name lunit [Value [Averaged Value
GG X - Component of Fored [Ibf] | 2599267435] 3.015539819

Iterations: 54

Analysis interval: 24

143



SolidWorks Flow Simulation SolidWorks Simulation

6 View the Excel Plot.

m  Click the bottom Force (X) tab. g
m View the plOt. M 4 » M| Summary - Force.[X) Plot Data - %2
Ready by
LBYV_ASSY.SLDASM [Default (3)]

9

Bl
g
g5
I
; \\/\v‘ ——GG X - Component of Force
[
g o
£ 3
3
=

1

10 20 30 40 50 60
-1
lterations
7 Close the Excel Plot and return to ACEEED X 00
SolidWorks Flow Simulation. @ =
m Click Close. j Mew it
1 accounts10-01-200778)

m  Select No when prompted to Save. . e

7 Open

I ,:\: Conyert

8 Save and Close the model.

m Click File, Close from the SolidWorks = o
Main menu. B s
®  Click Yes when prompted to save. You o
are finished with the SolidWorks Flow il Bt
Simulation section of the HOTD ] pepare >
manual. =

/' Publish »
=Y

j\ Qoq_
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SolidWorks Flow Simulation

During this short session on using SolidWorks
Flow Simulation, you have had a brief
exposure to the main concepts of fluid-flow
simulation. SolidWorks Flow Simulation
gives you insight into parts and assemblies
related to fluid flow, heat transfer, and forces
on immersed or surrounded solids.

The only fluid-flow simulation product fully
integrated with SolidWorks, SolidWorks Flow
Simulation is incredibly easy to use; you
simply tell the software what you’re interested
in instead of having to translate analysis
design goals into numerical criteria and
iteration numbers.

Access physical fluid models for
engineering applications. SolidWorks Flow
Simulation can analyze a wide range of real

SolidWorks Flow Simulation

Add-Ins

il

Active Add-ns

StartUp |

=l SolidWorks Premium Add-ins

[C] R CircuitWorks
[ %8 FeatureWarks
€ photoview 360
|;|II| ScanTo3D
@, SolidWorks Design Checker
(S?) SolidWorks Motion
E SolidWorks Routing
r’ SolidWorks Simulation
SolidWorks Toolbox
E’ SolidWorks Toolbox Browser
i salidworks Utities
[F]  Solidworks Workgroup PDM 2011
[[]  Solidworks Workgroup PDM 2012
[T Tolanalyst

=l SolidWorks Add-ins

[  Autotrace

SolidWorks Flow Simulation 2012
SolidWorks Part Reviewer

[]  Solidworks XPS Driver

[ OK ] | Cancel

I

fluids such as air, water, juice, ice cream, honey, plastic melts, toothpaste, and
blood, which makes it ideal for engineers in nearly every industry.

Simulate real-world operating conditions. SolidWorks Flow Simulation
includes several types of boundary conditions to represent real-life situations.

Automate fluid-flow tasks. SolidWorks Flow Simulation utilizes a number of
automation tools to simplify the analysis process and help you to work more

efficiently.

Interpret results with powerful and intuitive visualization tools. Once you

SolidWorks Flow Simulation

have completed your analysis, SolidWorks Flow Simulation offers a variety of
results visualization tools that allow you to gain valuable insight into the
performance of your model.

Collaborate and share analysis results. SolidWorks Flow Simulation makes it
easy to collaborate and share analysis results effectively with everyone involved
in the product development process.
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Notes:

SolidWorks Motion

When you complete this chapter, you will have experienced the power and

capabilities of SolidWorks® Motion, including:

The benefits of using motion analysis.

The ease of use of SolidWorks® Motion to perform analysis on your design.
The steps for performing a motion simulation on your designs.

The integration between SolidWorks Motion and SolidWorks.

An understanding of the performance aspects and time savings before
physical prototyping.

Time: 20 - 25 minutes
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SolidWorks Motion

SolidWorks® Motion is designed for mechanical system simulation and ensures
that a mechanism works before it is built.

SolidWorks Motion will:

® Provide confidence that your assembly performs as expected without parts
colliding while they move.

® Increase the efficiency of your mechanical design process by providing
mechanical system simulation capability within the familiar SolidWorks
environment.

m  Use a single model, without transferring geometry and other data from
application to application.

m  Eliminate the expense caused by design changes late in the manufacturing
process.

®  Speed the design process by reducing costly design change iterations.

Today, perform an analysis on the Gripper assembly.
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Starting a SolidWorks Motion
Session

1 Open the Gripper
Assembly.

m  Click Open from
the Menu bar menu.

®  Double-click the
Gripper Motion 2012
assembly from the
SeaBotix\SolidWorks
Motion folder.

2 Activate SolidWorks
Motion.

m  Click the Options

» SolidWorks... » SolidWorks Motion »

SolidWorks Motion

Search SolidWorks Motion

Organize v New folder

I Favorites
B Deskiop
18 Downloads

%l Recent Places

& Libraries
% Documents

&l Music

&) Pictures
H videos

#& Homearnun

Configurations:

Name

- 0 @
Date modified Type

8/23/2011 11:05 AM  File folde]

Finished
|+ Gripper Mation 2012

10/23/20108:16 PM  SolidWor

3 b

| I, - | 3
Mode: Display States:

v |Assembly (nasmisidasm) v

File name: Gripper Motion 2011

drop-down

arrow from the Menu bar toolbar.
®  Click Add-Ins. The Add-Ins dialog

box is displayed.

B Check the SolidWorks Motion box.
® Click OK from the Add-Ins dialog

box.

SolidWorks Motion

=] -

5] | optiens | |
| Customize...
Add-Ins...

e
Active Add-ns |startup |
El SolidWorks Premium Add-ins
[7] &R Circuitworks ]

[ &8 Featureworks &}
[T Photoview 360 &
[[]f# ScarTazn ]|
[ & Solidworks Design Checker ]|
& solidworks Motion [}
[7] 1 solidworks Routing [}
[ [ solidworks Simulation &}
[[]  Solidworks Toolbox [}
71T salidworks Taclbax Browser &}
[7] f solidworks Utlities &
[[]  Solidworks Workgroup PDM 2011 &}
[[]  SolidWorks Workgroup PDM 2012 [}
[T Tolanalyst [}
El SolidWorks Add-ins

[  Autotrace [}
[[]  Solidworks Flow Simulation 2012 &}
[7]  Solidworks Part Reviewer [}
[]  Solidworks XPS Driver &}

OK Cancel
( ] | ] A

Wilalplpl| Model | Motion Study 1
SolidWorks Premium 2012 x64 Edition
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3 Start a SolidWorks Motion Study.

150

SolidWorks Simulation

Click the Motion Study 1 tab at the bottom of the Graphics area as illustrated.
Click the drop-down arrow from the Motion Study Manager.
Select Motion Analysis. View the available selections from the Motion Study

Manager.

msaumlws Edit View Insert Tools Window Help Gleva%vlpja e P EL T

» = .
[ N 1 & B ) i o
Edit Lss Mate 5 Smart e Show Esenrieiaen New Bill of Exploded »
Component T apess Fasteners S Hidden R Motion | Materials View
- - - Companents - - Study

Aswmbly| Layout ] Sketch ] Evaluate IOﬁce Products [

mE-E X

aasmE 3 o @R

9§ Gripper Motion 2012 (Default »
{63 Sensors
Annctations

.35 Front Plane
\6} Top Plane
..<% Right Plane
.. Js Origin

) (f) Main Housing<1> (Def
-G MS-FINGER<1> (Default<
-8§) MS-HOLDER<1> (Default:—
-T& Push-Pull Plate<1> (Defa
% (-1 Miniature Shoulder Scr
-8 () Push Arm<1> (Default
-G MS-FINGER<2> (Default< +

4|7nr 3

m

Motion Analysis ‘Ib‘h“rj M Eé|@+|@§\ﬁée yg‘|@@@
Animation | ()i B W OE e M e R
Basichuton otion 2012 (Default<C {
| Motion Analysis  aion and Camera Vie:
B Lights, Cameras and Scene
- (f) Main Housing<1> (Defau
% (-} M5-FINGER<1> (Default<
= % (-) MS-HOLDER<1> (Default Qa8
< 1 | s

______ Motion Study 1

Chooses the amount of realism of the MotidwGtudy (more real.  Under Defined  Editing Assembly
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Applying Motion to a Component

A linear motor (actuator) is a device which imparts a
translational motion to a component. A linear motor in
SolidWorks Motion moves the selected component at a
constant speed or variable speed.

Apply a linear motor to the Push-Pull Plate component
in the Gripper assembly. The linear motor will move
the Push-Pull Plate component a specified distance in a
specified time. This action will cause the fingers of the
Gripper assembly to close.

Extrudel of Push-Pull Plate <1 =

Applying Motion to a Component

SolidWorks Motion

R

Motor Type

b

B Raokary Makor
Linear Motor {Actuator)

Component,/Direction 3

H_‘| Face<1 =@Push-Pull Plate-1
% I Push-Pull Plate-1@iaripp

Motion 3

Constant speed »
®[w 2

Click the graph to enlarge.

»

Maore Options.

2
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Applying Linear Motion

4 Apply Linear Motor.
B Zoom in on the Push-Pull
Plate component.
®  Click the Push-Pull Plate
component face of the Gripper
assembly as illustrated.

Note: View the icon symbol and
information feedback.

m  Click the Motor & | icon from
the Motion Manager toolbar.
The Motor PropertyManager
is displayed.

®  Click the Linear Motor
(Actuator) box for Motor

Motor
Moves a component. as if acted upon by a
rotor,

Type. 0" @BINRE® B @ o w|
m Click the Reverse Direction il A Ll b e e Mk e
button.

®  Click the Push-Pull Plate
component face of the Gripper
assembly. The direction arrow e

points inward. @ Rotsy Motor
— S] Linear Mator (Actuatar)
ﬁ Fath Mate Matar
Component,/Direction -]
]
i |

»
@
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5 Display the Function Builder.

m  Select Segments for Motion Type from the
drop-down menu. The Function Builder
dialog box is displayed. Use the Function
Builder to define motor or force profiles from
an imported data set. You can also use the
Function Builder to define a motor or force
profile from a mathematical expression or
from interpolated functions along connected
segments. For motor profiles, you can specify
time, cycle angle, or any result as the
independent variable.

6 Add Rows.
m  Click Click to add row. A new row is
displayed.

SolidWorks Motion

| Component,/Direction

A

A

i Motion A

' Constant Speed E

Distance

Oscillating

Segments 4—
Data Points

Expression

Servao Matar

Load Function from File. ..
Delete Functions. ..

X

Function Builder E|
[(‘\ Segments I Iu Dt Pairts I [f; Expression 1 =1E
1 St hs: ] welcit ] Accelerati ] Jerk. Fit &l Graph:
o 3 o graphs: elocity ceeleration e i raphs
1 o @
Independent variable (): | Time {5) v| kaQ
Start® | EndX | Value | SegmertType
[000mm |
0= 1= [T00mm__[Cubic (Deta 1.0 1o
Click to adkdrow £ .
E @S
s £0s 208
5 &
H =
& 0z 04 06 08 10 E 0.2 04 06 08 10
g 0.5 Time (s} L o5 Time (s}
1.0 1.0
L L0 10
&
S 72
T 05 F 05
£
£ &
5 £
5 02 04 06 08 10 = 0.2 04 06 08 10
T 05 Time () A 05 Time ()
£
1.0 -1
[TIMake Function available For use elsewhere in this document Mame:
o [ cacst J[ b |
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m Fill in the following

numbers and rows as Startx | Endx Value | Seoment Type

. . 0.00mm

illustrated. View the results. —pe o1s BO0nm  |3-4-5-Pama
—Ppp|loi= 02s 0.00mm 3-4-5-Palyno ]

Click to add row Half-Cozing (I'.‘!k‘ ALt -
4-5-6-7-Polynomial (Default)
5-6-7-8-9-Palynomial (Default
Cycloidal (Detaul)
Guadratic (Default)

Linear (Default) S
AR
200.0
g.0
E
£ 6.0 @ looo
= £
I £
E 4.0 =
o g a1 2
2 2.0 & T b '
5 = ime (s
= -100.0
0.1 0.z
Tirne (s} -200.0
£000.0 600000.01
’<&i‘ 4000.0 400000,0
in =
£ 20000 ¢ zo0000.0
£ E
= £
g £ j
k] | 0.z = ot 0.z
% -2000.0 Tirle: {5} AL -200000.0 “ Tima {s)
2 4000 -400000.0
-5000.0 -600000.0
[ 1 Make Function available for use elsewhere in this document Marne:
_('> OF H Cancel ] l Help

B Click OK from the Function Builder dialog box.

m  Click OK from the Motor PropertyManager. LinearMotor] is displayed in
the Motion Study FeatureManager.
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7 Edit Key Point Time for Motion Study.

m  Right-click the Key Properties icon as illustrated.
Click Edit Key Point Time.
Enter .2 for time.

Click Save from the Edit Time dialog box.
Click the Zoom to Fit icon in the Motion Study. View the results.

vation anchysis v B8 1B B> B [® vi=--l @ [F @3NREe 'l B ug
| 0 see 2 sec ‘4 sec |B ec B sec |1l] sec 12 sec
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il Ej?t'fg"p;iﬁﬁime
[ [s] Lights, Cameras and Scene
&, LinearMatorl
) %8 (F) Main Housing <1 (Defaults
) 8 () MS-FINGER <L> (Default<<
) %8 () M5 HOLDER <1 > (Defaul< <
%y -} Push-Pull Plate <13 (Default T
o N8 ¢y pinakre shoplder Screwet
Edit Time
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(F) Main Housing <13 (Default <
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() Push-Pull Plate <1 > (Def ault-
() Miniature Shoulder Screw<1
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Applying Forces

156

Forces define loads and compliances on parts. Forces may resist motion, such as
springs or dampers, or they may induce motion.

The 3 Finger Jaw components experience an applied force. To simulate the
loading conditions, you will perform the following tasks:

m  Select the middle contact surface from one of the 3 fingers.
Insert an applied action-only force of 62 N to the selected finger.
Repeat the process on the other two fingers.

Create and run a simulation.

Compute the reaction force at the finger hinge.

Create a trace path for the tip of one finger.

Extrudel of MS-FINGER <3

Applying Forces
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Applying Force to the Gripper
Fingers

1 Select a Contact Face.
B Rotate the Gripper assembly
with the middle mouse button
to view the inside faces of a
finger as illustrated.
B Zoom in to selected the first
contact face.

Note: Seclect any of the 3 Gripper
fingers.

SolidWorks Motion

Extrudel of MS-FINGER <12

m  Click the contact
finger face as
illustrated.

2 Apply the Force.

m  Click the Force
icon from the Motion
Manager toolbar. The

Type

h— + E] Force
{gl Torque

»

Direction

—_— —’ g] Action anly

‘%l Action & reaction

@D I Fate <1 >@ME-FINC

2

Force/Torque G |
.
PropertyManager is N
dl Splayed, ) Selected component:
m  Click the Force box Force Function A
for Force Type. aae -
Fi1  szu E =

®  Click the Action only
box for Direction.

m  Click the Reverse
Direction button. The

H

3
Click. the graph ko enlarge.

direction arrow points
into the finger.
m  Enter 62 N for Constant Value.

m  Click OK from the Force/Torque
PropertyManager. Forcel is displayed in the
Motion Study FeatureManager.

Applying Forces

|M0ti0nnnfly_sis v IP B -
v B E

el @ Gripper Mation 2011 {Default<Disp
| @ Origntation and Camera Yiews
[;vz Lights, Cameras and Scene
[ — i g LinearMotar1
R, Ford
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3 Apply a Contact Force to the two other Fingers.
B Repeat Step 1 & 2 for the other two Gripper fingers. At the end of this step,
you should view three Forces and a LinearMotor in the Motion Study
FeatureManager as illustrated.

Motion Analysis | G B> B B 1] vi=-@ @ |F @SR BB el
|7 VW B 0 sec ] . i |l].l]5l]‘sec : |l].ll]l]‘sec . |l].15l]‘sec .
| = % Gripper Motion 2011 (Default<Disp
@ Orientation and Camera Views
4l 2] Lights, Cameras and Seene
& LinearMoatort
R, Forcet
R, Forcez
W, Forced
= % (F) Main Housing <1 > (Default<
G () MS-FINGER <1 > (Default<<|
& § () MS-HOLDER <1 = (Default <<
@

i i ﬂ.Zﬂﬂ‘sec

4 Run the Motion Simulation.

| Y

m  Click the Calculate icon. Calculate - ]

. Calculates the Mation Study.
m Ifneeded click Yes to the message

in the dialog box. View the [T :
assembly moving while the analysis [Motion analysis | B 1B B> B ]
is being performed. il % W B

& B @ Gripper Mation 2011 {Default <Disp
@ Origntation and Camera Yiews
= @ Lights, Cameras and Scene

5 Calculate the Reaction Force at the
Finger Hinge.

m  Click the Results and Plots icon from

Results and Plots
Calculates results and creates graphs,

the Motion Study toolbar. The Results @ FoF @ENR 3@ B E

PropertyManager is displayed. [ Results 7|
m  Select Forces from the Result drop-down v %

menu. Result A
B Seclect Reaction Force from the Result F— —

drop-down menu as a sub-category. Reaction Force  — il
m  Select Magnitude from the Result drop- T A —

down menu as the Result component. Nl Concertri
m  Expand the Mates folder from the Motion

Study FeatureManager. ]
® Click Concentric 2 from the Mates folder. olot Recults -
m  Click OK[¥]in the Results O Crese nen

PropertyManager.

Flot result versus:

Time A
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Note:

®  Click No to the displayed message. View the plot.
m  Click along the time axis and view the changes in the Gripper.

Do not close Plotl at this time.
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6 Edit the LinearMotor1 Feature. p— .
m  Right-click LinearMotor1 in the Motion o B IiH;:; g % %
Study FeatureManager = @ Gripper Moti;-ZDII {Default<Disp

m Click Edit Feature. The Motor @ orentation and Camera Viens
PropertyManager is display. : —ng i

m  Click the Edit button. The Function R, Forcet | [ Bt Feature
Builder dialog box is displayed. B NI
®m  Modify the EndX (.05) time cell as {akion A
illustrated. Note the update in the plots. Rl —
m  Click OK from the Function Builder _ e
dialog box. | More Options a |
7 Return to the SolidWorks Motion
Graphics area. =

= Click OK[#]in the Motor
PropertyManager.

Function Builder E|
“D Segments l “d Data Poirts } Lf.;. Expression I lﬂ Lf‘r
r Show graphs:! s [] velocit: [] Acceleration [v] 2erkc Fit All Graphs
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B I
& =
W'Z
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o
G
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=l £
5 E;
% w nz b ol 9w
i
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2 Time (s)
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[[Itske function availsble far use elsewhers in this document Mamet |
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8 Re-run the Motion Simulation.

Motion Analysis - |
m  Click the Calculate icon. View the

results of the new plot in the Graphics » - Gripper Moti 212 Mefault<l

® Orient1 Calculate
area. Lights, | Calculates the Motion Stud
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9 Create a Trace Path.

m  Click on the Results and Plots icon
from the Motion toolbar. The Result
PropertyManager is displayed.

B Select Displacement/Velocity/
Acceleration from the drop-down menu
in the Result box.

m Select Trace Path from the drop-down
menu as a sub-category.

®  Click a point at the end of a finger as
illustrated in the Graphics area. Note the
icon feedback symbol.

m  Click OK from the Results
PropertyManager.

Note: A Trace Path graphically displays the path
that any point on any moving part follows.
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10 Zoom in to view the results.
Use the middle mouse wheel to zoom in on the Trace Path.
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11 Re-run the Motion Simulation.
m  Click Play from Start. View the results Play from Start
in the Graphics area.
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12 Disab}e Playback of view Keys. Tomaars <@ > o
m Right-click Orientation and %% % pse
Camera Views from the Motion ~ 9 Gripper Motion 2012 (Default< EH I
Study FeatureManager. o g Lights, C % | Disable Playback of View Keys
m Click Disable Playback of View =2 L _@Ti DisEEIe View Key Creation
Keys_ f Hide/Show Tree Items...
m  Click Play from Start. View the =

results in the Graphics area.
13 Rebuild and Save the Assembly.

m Click Save from the Menu
bar toolbar.

®  Click OK to the Rebuild message.

14 Close all models.

m  Click Window, Close All from
the Menu bar menu. You are
finished with the SolidWorks
Motion section of the HOTD
manual.
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SolidWorks Motion Conclusion

During this short session on SolidWorks Motion, you have seen how physics-
based motion simulation can be used to improve the quality and performance of
your design. SolidWorks Motion simulates the mechanical operations of
motorized assemblies and the physical forces they generate, by determining
factors such as power consumption and interference between moving parts.
SolidWorks Motion helps you ascertain if your designs will fail, when parts will
break, and whether or not they will cause safety hazards.

Leverage the power of SolidWorks. SolidWorks Motion works inside the
SolidWorks window and uses existing assembly information to build motion
simulation studies.

Transfer loads seamlessly into SolidWorks Simulation to perform stress
analysis.

With the seamless transfer of loads from SolidWorks Motion to SolidWorks
Simulation, you can visualize stress and displacements on a component as a single
time instance or for the entire simulation cycle.

Simulate real-world operating conditions. By combining physics-based motion
with assembly information from SolidWorks, SolidWorks Motion can be used in a
broad span of industry applications.

Associate physics-based models to engineering conditions. SolidWorks
Motion offers several types of joint and force options to represent real-life
operating conditions.

Interpret results with powerful and intuitive visualization tools. Once you
have completed the motion simulation run, SolidWorks Motion offers a variety of
results visualization tools that allow you to gain valuable insight into the
performance of your design.

Collaborate and share analysis results. SolidWorks Motion makes it easy to
collaborate and share analysis results effectively with everyone involved in the
product development process.
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